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Icons 
 

Icon Meaning 

 
Caution 

 
Example 

 
Note 

 
Recommendation 

 
Syntax 

 

 

Typographic Conventions 
 

Type Style Description 

Example text Words or characters that appear on the screen. These include field 
names, screen titles, pushbuttons as well as menu names, paths and 
options. 

Cross-references to other documentation. 
Example text Emphasized words or phrases in body text, titles of graphics and tables.

EXAMPLE TEXT Names of elements in the system. These include report names, 
program names, transaction codes, table names, and individual key 
words of a programming language, when surrounded by body text, for 
example, SELECT and INCLUDE. 

Example text Screen output. This includes file and directory names and their paths, 
messages, source code, names of variables and parameters as well as 
names of installation, upgrade and database tools. 

EXAMPLE TEXT Keys on the keyboard, for example, function keys (such as F2) or the 
ENTER key. 

Example text Exact user entry. These are words or characters that you enter in the 
system exactly as they appear in the documentation. 

<Example text> Variable user entry. Pointed brackets indicate that you replace these 
words and characters with appropriate entries. 
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 Web Application Design: BEx Web Application Designer 
Use 
Web application design allows you to use generic OLAP navigation for your BW data in Web applications 
as well as in business intelligence cockpits for simple or highly individual scenarios.  

Integration 
The following graphic shows Web application design as a central functional area of the Business Explorer: 

, 

Business Explorer

•Query design on
the desktop or in
the Web publisher
•Multidimensional
(OLAP) analyses
(Web-based or
MS Excel)
•Geographical
analyses
•Ad-hoc reporting
•Alert
•Publishing iViews
•Seamless
integration of Web
and MS Excel-
based analyses

Portal Integration,
Collaboration &
Distribution

Query, Reporting
and Analysis

Web Application 
Design 

Formatted 
Reporting Mobile Intelligence

Technical Components/ 
BI ToolsKey Functions/

Functional Area

•Layouts exact
to one pixel
•Wizard-based
layout definition
•Static, for-
matted reports
•Form-based
reports
•Predefined
Crystal Reports
in Business
Content
•Publishing on
the Web
•Practical
printing options

•Online and
offline scenarios
•WAP-device and
PDA support
•Automatic device
recognition
•Publishing using
the Web
Application
Designer
•Device-specific
output
•Alerts, charts
•Integration into
the mobile portal

•Web Application
Design
•Interactive analy-
tical Content on the
Web
•Information cockpits
and dashboards
•Basis for creating
analytical
applications
•Creation of iViews
for the Portal
•Wizard-based vi-
sualization
•APIs for additional,
highly individual
Web design

•Single point-of-
access
•Roll-based data
retrieval

•Personalization,
collaboration,
profile generation

•Integration of
unstructured data

 

Funktionsumfang 
The following graphic illustrates the basic concept of Web Application Design with the Web Application 
Designer as the central tool: 
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BW Server
(using mySAP Web
App Server Technology)

HTML
Templates

Data
Base BW Charting Engine

Any Web
Design Tool

BEx Analyzer

OLAP Processor

Any Web
Browser

http

• save HTML Templates in
Web Content Management

• generate URL automatically

BEx Web Application
Designer

BW Web
Service

BEx Query
Designer

create
Queries /

Views

 
Usingthe BEx Web Application Designer [Seite 14], the desktop application for creating Web applications, 
you can create HTML pages that have BW-specific contents such as tables, charts or maps. These 
objects, which retrieve BW data from a data provider and place it in a Web application as HTML, are 
known as Web items. For more information on the Web items available, see Web Items [Seite 36]. 

You can save the Web applications as a URL and access them from an intranet or on mobile devices. In 
addition, you can save Web applications as iViews and integrate them into an enterprise portal. 

The Web application wizard [Seite 21] is an assistant that is integrated into the Web Application Designer. 
You can use this to help you create Web applications using a step-by-step procedure and to simplify 
design activities. The Web application wizard helps you to work with Web application design confidently 
and create your first Web applications. 

Business Explorer Web application design also allows you to create highly individual scenarios with user-
defined interface elements by using standard markup languages and Web design APIs. You can adjust 
and enhance Web templates [Seite 225](the HTML pages that determine the structure of Web 
applications) individually. For further information, see: 

Object Tags [Seite 227] 

Command URLs [Seite 231] 

Using Forms [Seite 262] 

Data Provider [Seite 268] 

Query Views [Seite 270] 

Using JavaScript Functions [Seite 318] 

In addition, using a Web design application programming interface (Web design API), you can change the 
display of tables or navigation blocks in Web applications. See Web Design API for Tables [Seite 338] 

Web application design comprises a broad spectrum of Web-based business intelligence scenarios, which 
you can adjust to meet your individual needs using standard Web technologies. 
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 BEx Web Application Designer 
Definition 
The BEx Web Application Designer is a desktop application for creating Web applications with BW-
specific contents. Using the BEx Web Application Designer, you create an HTML page that contains 
contents such as various tables, graphics or maps. This HTML page (shown below as a Web application) 
provides the basis for not only Web applications with complex interaction, but also for Web cockpits and 
iViews. 

Use 
For a detailed guide explaining how to create Web applications, see Creating Web Applications with the 
BEx Web Application Designer [Seite 17] or, if you are creating a Web application for the first time, see 
Creating Web Applications with the Web Application Wizard [Seite 21]. You can find background 
information under From Web Template to Web Application [Seite 26]. 

Structure 

 
As well as menu bars and application toolbars, the BEx Web Application Designer consists of three basic 
screen areas: 
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• The Web Items window 

• The Template window 

• The Properties window 

The Web Items Window 
The Web Items window offers a pool of Web items [Seite 36] that you can use to create your Web 
application. 

 
A Web item is the visualization type (for example, tables, maps, graphics) used to display 
data from a data provider [Seite 268]. 

The window is made up of two areas: 

• In the top part of the window, divided onto two tabstrips, are the selection option categories for Web 
items. 

− Selection from master Web items 

− Selection from Web items saved in the library. See also Working with the Library for Web Items 
[Seite 33]. 

 
You can create documents for your library, or display or edit existing documents. To do this, 
choose the Library tab page from the Web Items window. Choose context menu  → Open 
Library. Select the library that is opened and, using the context menu, choose Documents. 
You can find additional information under Documents [Extern] and Creating Documents 
[Extern]. 

You can create documents for each individual Web item in your library and display or edit 
existing documents. To do this, open the library as described above, select a Web item and, 
using the context menu, choose Documents.  

 

• Below the document selection, you see the help area with descriptive text for the Web item that you 
selected in the above area.  

The Template Window 
The Template window contains the Web templates that you edited in the design process and that form the 
basis for your Web applications. 

 
The HTML page published on the Web is called a Web application. A Web template [Seite 
225] is the HTML page that you use to determine the structure of the Web application. 

At the bottom of the Template window there are three tab pages that you can use to change the view of 
the template or the current HTML editor. 

• Layout 

You determine the layout of the Web application in the layout view. See Designing the Layout of 
Web Templates [Seite 30] for the available options. 

• HTML 

The HTML view displays the HTML that corresponds to the layout view  

Web Application Design: BEx Web Application Designer 30B
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In the HTML view, the syntax is colored. 

Syntax element Color 

Comment gray 

HTML blue 

String constants black 

BW-specific contents such as BW object tags, 
SAP BW URLs, SAP BW texts 

red 

 
In the HTML view, you can edit the HTML of a Web template directly. Alternatively, you can 
also edit the HTML with an external HTML editor. You can find additional information about 
editing HTML under Creating Web Applications with the BEx Web Application Designer [Seite 
17].  

• Overview 

In the overview view, all of the Web items are listed with information about the master Web item, 
the data provider and the query or view.  

 

 
You can create documents for Web templates or display or edit existing documents. To do 
this, choose Web Template → Documents. You can find additional information under 
Documents [Extern] and Creating Documents [Extern]. 

The Properties Window 
In the Properties window, you define the properties of Web templates and Web items. It is divided into 
three areas: 

• In the header of the window in the dropdown box, you see the selection for which you want to define 
properties – for the Web template or for specific Web items. 

• In the middle area, you specify the properties for Web templates or for specific Web items – 
depending on the dropdown box settings. 

• The lower screen area displays context-sensitive help. 
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 Creating Web Applications with the BEx Web Application 
Designer 
Use 
You can use the BEx Web Application Designer to create a BEx Web application (an HTML page with 
BW-specific content) quickly and easily.  

 
You can find background information on the following steps under From Web Template To 
Web Application [Seite 26]. 

We recommend that you create your first Web application with the BEx Web Application wizard in order to 
familiarize yourself with the Web Application Designer. See Creating Web Applications with the Web 
Application Wizard [Seite 21]. 

Procedure 
1. Create a Web template 

To create a new Web Template [Seite 225], choose  or Web Template → New. (When you 
start the Web Application Designer, a new Web template is created). 

2. Insert a Web item [Seite 36] 

a. Drag a Web item from the Standard tabstrip of the Web Items window and drop it into the Web 
template. The Web item appears in the Web template. 

 
When you select a Web item from the Web Item window, you get an explanatory text in the 
area underneath the Web item. 

b. Give the Web item a name by overwriting the default text under Name on the General tab strip in 
the Properties window. 

3. Set the data binding. 

a. In the Properties window, on the General tab page, in the DataProvider area, describe the data 
provider [Seite 268]. Overwrite the existing text under Name, or select a new data provider using 
the pushbutton and overwriting the proposed text. 

b. Select a query with  or a view with  respectively to assign a data provider to the Web item. 

 
To create a new query, call the Query Designer by choosing Tools → Query Designer  

 
To create a view on the basis of a query or another view, choose Tools → View Definition → 
Based on a Query or Based on Another View. In the BEx Open dialog box, select an existing 
query or an existing view. The standard template appears in a separate browser window. 
Define your view there, enter the Description and Technical Name and choose Save View. 
You can now use this view as a data provider. 

4. Make settings for the Web items. 
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a. In order to make special settings for the Web item, choose the tabstrip Web Item. 

 
For the chart and map Web items, you can also call up the dialog for changing attributes 
using the symbols  or  on the toolbar. 

b. Specify the properties by 

− Selecting the relevant checkbox 

− Manually entering a value (for example, with Heading) 

− Manually changing the default value  

− Double-clicking the default value and choosing another value from the dropdown box that 
automatically appears 

− Choosing values from a list 

− Creating values in a list in tabular form 

 
Click on each property for a description of the individual properties. The descriptions are 
shown in the area underneath the properties.  

5. Add further Web items. 

Repeat steps 2 – 4 to integrate further Web items. 

 
Note the position of the cursor in your template when adding further Web items. The cursor 
position determines where the new Web item is added. See also Designing the Layout of Web 
Templates. [Seite 30]. 

 
Make sure that you execute the data binding and Web-item-specific settings for the correct 
Web item. To make changes to a Web item, select the item in the layout view. In the header 
of the Properties window, the system displays the Web item for which you can change the 
settings. As an alternative to selecting the individual Web items, you can use the dropdown 
box to toggle between the properties of individual Web items.  

6. Design the layout of the Web template 

In the Web Application Designer, you can create your Web template in the same way as in 
familiar HTML editors. See also Designing the Layout of Web Templates. [Seite 30]. 

7. Change the Web template properties. 

To change the Web template properties, select the Web template in the header of the Properties 
window from the dropdown box. See Determining Web Template Properties [Seite 28], for a 
description of the settings you can make. 

8. Store and execute the Web template 

a. To save your Web template, choose  or Web Template → Save.  

b. To view your Web application in the Browser, choose  or Web Template → Publish in Browser. 
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You have to save the Web template before publishing it on the Web. You are therefore asked 
to save the template when you execute it, if you have not already done so. See also From 
Web Template to Web Application [Seite 26]. 

 
To assign a Web template to a role, choose Publish → In Role... 

To place the URL of a Web template on a clipboard, choose Publish → Copy URL to 
Clipboard. To do this, you must have saved the template once already. 

Result 
The browser is started and the Web application you created is opened. 

 
If you want to print your Web application, you can enter a print stylesheet for the respective 
Web template. You can see the selection of print stylesheets only in the HTML view. For 
further information, see Print Stylesheets [Seite 224]. 

Processing Web Templates Further 
You have the following options for editing the HTML source of a Web template: 

1. You can edit the Web template directly in the HTML view of the Web Application Designer. To do 
this, in the Web Application Designer Template window, choose the HTML tab. 

− Edit the HTML. 

− Choose Undo in the lower-right area of the Template window in order to withdraw the changes 
you have made. 

or 

− To check the edited HTML, in the lower right area of the Template window, choose Validate. 

 
The changes made to the Web template are not transferred to the Web template at this stage. 

The system starts the Web template validation automatically when you: 

a. Choose the Layout or Overview tab. 

b. Change the properties in the Properties window on the Web Item tab. 

c. Save the Web template 

The Web Application Designer dialog box appears. This is where you are asked to transfer 
the HTML changes or correct any errors. 

− Choose Yes if you want to transfer the changes to the Web template permanently.  

 
The changes are transferred into the Web template.  

or 

− Choose No to reject the changes. 

or 
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− Choose Cancel to continue editing the HTML. 

2. You can also edit the Web template with an external HTML editor. 

− To process a Web template further using an external HTML editor, choose Web Template → 
Export to File... Your Web template, that is the HTML file, is stored on a file system of your choice. 
You can call it up from there with your HTML editor. 

 
If you have selected an HTML editor in the Web Application Designer using Tools → Settings, 
this is started automatically.  

− To call up a Web template that you have edited in the HTML editor (that is, the edited HTML file) 
in the Web Application Designer again and edit it there, store the file on your file system again. In 
the Web Application Designer, choose Web Template → Import from File... and specify the names 
and location of the saved file.  

− To download a Web template directly from the server, that is, without opening the Web Application 
Designer, choose Web Templates → Download File from Server. The Web template (the HTML 
file) is stored on your file system. 

− To upload a Web template that you edited in an HTML editor directly to the server, that is, without 
opening it in the Web Application Designer, store the file on your file system again. In the Web 
Application Designer, choose Web Template → Upload File to Server and specify the name and 
location of the saved file. 
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 Creating Web Applications with the Web Application 
Wizard 
Use 
You can use the Web application wizard to create a Web template quickly and easily. You can publish this 
template as a Web application in the Internet browser. The Web template is an HTML document with BW 
specific placeholders that determines the structure of a Web application.   

 
You can use the Web application wizard to create Web templates but not change them. If you 
want to change your Web template, you use the Web Application Designer. See Creating 
Web Applications with the BEx Web Application Designer [Seite 17].  

Prerequisites 
You have called up the BEx Web Application Designer. 

Procedure 
1. Choose  or Tools → Wizard, to call up the Web Application Designer. 

2. Select a Web item from the list and choose Next. 

The Web item determines how the source data is displayed. Using different Web items, you can 
visualize your data in different ways. For example, you can display your data in a table, in a chart 
or in a map.   The dropdown box, checkboxes, and radio button group Web items are used to filter 
characteristic values. You can find additional information about the Web items available under 
Web Items [Seite 36]. 

3. Select a query or a query view. 

In the DataProvider field, either select a DataProvider using input help or use  for a new 
DataProvider. The DataProvider provides data for one or more Web items.  

You can select either a query or a query view as a DataProvider for the Web item. Choose either 
 (Select Query) or  (Choose View). This brings you to the Open Query / View dialog box.  

From here, select the required query or query view from your history, favorites, or roles. Choose 
Next.  

You can also manually alter the name of the Web item here. The name identifies the Web item 
within the template. 

4. Set the attributes for the Web item. You can edit the attributes by: 

− Selecting the checkbox 

− Manually entering a value (for example, with Heading) 

− Manually changing the default value  

− Double-clicking the default value and choosing another value from the dropdown box that 
automatically appears 

− Choosing values from a list 

− Creating values in a list in tabular form 

Choose Next. 
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5. Arrange the Web items that you created in the list. 

The sequence of Web items in the list is the same as the sequence of Web items in the Web 
application.  

Use the two arrow buttons on the right-hand side to change the order of the Web items. Here you 
can also 

Delete Web items Select the Web item you want to delete and 
choose Delete. 

Add a new Web item Choose Add Item. 

Edit Web items Select the Web item you want to edit and 
choose Back. 

6. Before saving the Web template, you can make the following settings: 

− Use the pushbutton next to the Stylesheet field to choose the stylesheet that you want to use for 
your Web application. The Choose Stylesheet dialog box appears. Select a stylesheet from the 
list. If you would rather use a stylesheet that is not on the list, one that is on your Web server, for 
example, mark the checkbox and enter the URL. Choose OK. 

− If you select Display Variables, a variables screen appears in the Web application, from which you 
can select the required values. If you do not select Display Variables, the Web application is 
displayed without a variable screen. 

− If you select Status-free Navigation, the system closes the connection to the server. This means 
you do not use any of the server’s storage capacity. If you then navigate in the Web application, 
the connection to the server is reopened and remains open for the duration of the navigation. If 
you do not select Status-free Navigation, the system maintains the connection to the server. 

− Choose Settings to do the following: 

a. In the General tab page, you can change the stylesheet that is used to format the Web application 
or set the default stylesheet.  

Choose the pushbutton with the three dots (Change Settings).  The Choose Stylesheet dialog 
box appears. Proceed as outlined in step 6 above.  

b. In the Directories tab page, you can change the following path specifications 

• Path for the Web browser 

• Path for the HTML editor  

You can find additional information about making settings under Making Settings [Seite 23]. 

− Choose Save once you have made all the required settings for your Web template. 

7. You can now publish your Web template. 

Here you can see the URL for your completed Web template. You can now publish the Web 
template directly in the Web, or you can integrate it as an iView in your Enterprise Portal.  

You have the following options for using the Web template again: 

− Choose  to display the Web template in the Web browser.  

− Choose  to save the Web template as an iView in a role. 

− Choose  to save the Web template as an iView file locally, so it can be used in the iView studio. 

Then choose Exit to close the BEx Web application wizard. The Web template appears in the BEx 
Web Application Designer. You can now continue to edit the template as required. 
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 Making Settings 
Use 
In the Web Application Designer or the Web application wizard, you can make and save general settings. 
You can select a default stylesheet used to display your Web application and determine the path for the 
Web browser and the HTML editor. You reach the dialog for making general settings in the Web 
Application Designer through Tools → Settings.... In the Web application wizard you make general 
settings in the Save Web Template window using the Settings pushbutton. If you want to save your 
general settings, mark the relevant checkbox in the Settings dialog box. 

 
You can determine a different stylesheet for each Web template separately from the general 
settings. See Determining Web Template Properties [Seite 28]. If you do not make separate 
settings, the system uses the general settings.   

Procedure 
Selecting a Stylesheet 
1. From the Web Application Designer menu bar choose Tools → Settings..., or in the Web application 

wizard in the Save Web Template window, choose the pushbutton Settings. 

2. On the General tab page, choose the pushbutton with the three dots (Change Settings).  

3. Select a stylesheet from the list You see an HTML document in the preview window on the right which 
applies to the selected stylesheet. 

 
Only those stylesheets stored on the BW server are displayed in the selection list. If you want 
to use a stylesheet that is not in the list, for example one that is stored on your Web server, 
select the checkbox beneath the selection list and enter the URL. 

3. Choose OK. 

Determining the Path for the Web Browser and the HTML Editor 
1. From the Web Application Designer menu bar choose Tools → Settings..., or in the Web application 

wizard in the Save Web Template window, choose the pushbutton Settings.  

2. On the Directories tab page, use the pushbutton with the three dots next to the Change Settings entry 
field, to specify the required path.  

− Path for the Web browser 

You reach the Open dialog box, in which you specify the path. 

− Path for the HTML editor  

You reach the Open dialog box, in which you specify the path. 

3. Choose OK. 
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 Storage of Stylesheets and Icons 
Use 
You want to use stylesheets in your Web templates that exchange icons or supplement the Web template 
with other MIME objects such as images, icons or logos. 

Prerequisites 
You have adjusted the stylesheet [Seite 218] or icons to your settings. 

Procedure 
You find stylesheets and other MIME objects in the MIME Repository on the Web Application Server. To 
reach the MIME Repository, in transaction SE80 (ABAP Development Workbench) choose MIME 
Repository. 

Storage of Own Stylesheets 

You can find the stylesheets delivered with BW under SAP→  Public→  BW → BEx → Stylesheets and 
SAP → Public → BW → BCT → Stylesheets. You can also select these stylesheets in the Web 
Application Designer [Seite 14]. To change your stylesheets proceed as follows: 

1. Copy a stylesheet as a template to your computer. To do this, select the stylesheet, and with the right 
mouse button choose Export → As a Copy. 

2. Edit the stylesheet in an editor. 

3. Store the changed stylesheet under SAP → Public → BW → Customer → Stylesheets by selecting 
the Stylesheets folder and, using the right mouse button, choosing Import → MIME Object. Choose a 
name for the stylesheet. 

For each theme (that is, color specifications) In the MIME Repository, there is a stylesheet without a suffix 
and 4 stylesheets with the suffix _ie4 (for Internet Explorer 4), _ie5 (for Internet Explorer 5), _n47 (for 
Netscape Navigator 4.7) and _n60 (for Netscape Navigator 6.0). The stylesheets are optimized for each 
browser and are linked to the relevant browser when you start a Web application. That is, for example, if 
there is a stylesheet with the ending _n47, this is used when you start a Web application in Netscape 
Navigator 4.7. If there is no stylesheet available with the corresponding suffix, the stylesheet without the 
suffice is embedded. 

 
This is only relevant for changed stylesheets if you are using several types of browser. You 
can optimize the stylesheet for each browser. If you are only using one type of browser, 
optimize the stylesheet without the suffix for this browser. To do this, use the stylesheet with 
the browser-specific suffix as a template. 

Storing Changed Icons 
If you want to change icons that are used by default in the Web application, proceed as follows: 

1. Delete the relevant icon in SAP → Public → BW → BEx → Icons by selecting the icon and choosing 
Delete from the context menu. 

2. Save your new icon under the same name as the original icon by selecting the Icons folder and with 
the right mouse button, choosing Import → MIME Object. 
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Storing Your Own MIME Objects (for example, images and icons) 
To include your own images and icons in your Web application, your have to store them in the MIME 
Repository. Proceed as follows: 

• In general, you can store your MIME objects anywhere under SAP → Public → BW. 

− You insert MIME objects by selecting a folder and choosing with the right mouse button Import → 
MIME Object. 

− You create new folders by selecting a folder and choosing with the right mouse button Create → 
Folder. 

• So that your images are displayed in the Web Application Designer, we recommend that you store 
them under SAP → Public → BW → Customer → Images. You can include images that you save in 
this folder in the Web Application Designer without having to manually edit the HTML.  

Including Icons in the Web Template 

• If you have stored your images under SAP → Public → BW → Customer → Images, you do not have 
to do anything else after you have included them in your template. 

• If your image is in another folder under SAP → Public → BW you have to maintain the path manually 
in the HTML. 

 
If the image Picture1.gif is in SAP → Public → BW → Customer → MyPictures you have to 
access the image under Mime/Customer/MyPictues/Picture1.gif. 

• If you want to use the image as a background screen, you have to access it through the stylesheet by 
specifying the background image in a stylesheet class. You enter the relative path for storing the 
stylesheet. 

 
You want to give a specific area a background. You have stored the picture for this under 
SAP → Public → BW → Customer → MyPictures. You stylesheet is saved under SAP → 
Public → BW → Customer → Stylesheets. You add the specification background-image_url 
(..\MyPictures\Picture.gif) to the affected class in the stylesheet. 
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 From Web Template to Web Application 
The purpose of the design process is to create an HTML page with BW-specific content, called the Web 
application.  

 
The Web page executed in the browser is described as a Web application. 

Creating a Web Template 
The starting point is the Web template. The Web template [Seite 225] is an HTML document that is used 
to define the structure of a Web application and that contains placeholders for Web items, Data Providers 
and BW URLs [Seite 231]. 

 
A Web template is referred to as a Web application only when the data is actually displayed in 
the Web browser. 

A look at the HTML view shows that the basis of the template is an HTML page and an object tag has 
been created for the template.   

In the course of the design process, you change this Web template by embedding placeholders for Web 
items and Data Providers. You can make these changes in the HTML view. 

Integrating Web Items and Changing the Settings and Layout 
The Web items [Seite 36] on the standard tabs are used as templates. By dragging it into your Web 
template, it becomes a concrete version of a Web item, called an object. The Web item has a name and 
certain standard properties that you can change as required. 

You see the changes in the HTML view. An object tag was integrated as placeholder in the HTML for the 
Web item and the data provider. Change the name and select a data provider. In the HTML view, you can 
see that your settings have been written to the object tag.  

Your layout is also copied to the HTML in the usual manner for HTML editors. 

Describing Data Binding and Selecting a Query/View 
The data provider [Seite 268] provides the data for your Web item. You can assign a data provider to 
multiple Web items. 

 
The data provider is a dynamic object that delivers current data for one or more Web items at 
runtime. You define the start view of the data provider by selecting a query or stored query 
view.  

The data provider concept makes it possible to exchange the data source for a Web item easily. By 
means of navigation, that is changing the drilldown, the Web item always displays the current drilldown 
data. If a particular data provider is assigned to more than one Web item, the changes affect all the Web 
items involved. 

 

Storing and Publishing the Web Template 
Execute the Web template in the browser. When it is executed, the Web template becomes a Web 
application, that is, the template is saved on the Web Application Server and a URL is generated for this 
Web application.  
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The object tags are replaced with the information as defined by the Web item and data provider settings at 
runtime (triggered by the URL call). The Web template on the Web Application Server is accessed. This 
means that you must save your Web template before you execute it.  

Overwriting Web Templates 
If you have authorization for deleting Web templates, you can also overwrite existing Web templates that 
are saved in your favorites or roles. 

To do this, create a new Web template. To overwrite the existing Web template with the new Web 
template, from the Web Application Designer menu bar, choose Web Template → Save As  In the Save 
Web Template dialog box, select the Web template that you want to overwrite from your favorites or roles. 
Choose Save. In the Do you want to overwrite <Name of selected Web Template>? dialog box, choose 
OK. 

 
You cannot overwrite Web templates that are open in the Web Application Designer.   
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 Determining Web Template Properties 
Use 
You can specify the properties for your Web application in each Web template. 

Procedure 
Select the Web template from the dropdown box in the header of the Properties window. 

Tabstrip: General 
• Under Description, you can give the template a description of your choice. 

• Under Stylesheet, the stylesheet that is to display the Web application is shown. Choose the button 
with the three dots (Select Stylesheet) to select another for your Web application. 

− The list of stylesheets is given on the left-hand side of the Select Stylesheet dialog box. Select a 
stylesheet to see it in the preview window on the right-hand side. 

− To select a stylesheet for your Web application, select the required stylesheet and choose OK. 

 
Only those stylesheets stored on the BW server are displayed in the selection list. If you want 
to use a stylesheet that is not in the list, for example one that is stored on your Web server, 
select the checkbox beneath the selection list and enter the URL. Choose OK. 

Tabstrip: Web Items 
• Under General, you can give the Web application the following properties: 

− Status-Free Navigation 

By selecting Status-Free Navigation, the status on the server is removed after every navigation 
step in the Web application. This is only recommended for Web applications in which you rarely 
navigate. 

− Use Personalized Template, if Available 

− Do Not Display System Messages 

− Do Not Display Warning Messages 

− Always Display Variable Screen 

If Always Display Variable Screen is not selected, the variable screen is only displayed when the 
mandatory variables are not filled. By selecting the Always Display Variable Screen, the variable 
screen is displayed at all times. 

− Reset Variable Values to Default Values 

− Display Same Variables Only Once 

This ensures that the same variables for different queries are displayed only once. 

− Open Dialogs in New Windows 

− Read Mode for Data 

− Output Optimization (Device-Dependent) 
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By selecting Output Optimization (Device-Dependent), you arrive at an automatic, device-specific 
optimization of item settings for the runtime (for example, chart size for PDAs). 

• In the Entries in the Context Menu column, all possible context menu entries are listed. You can 
decide whether each context menu entry is 

− Not displayed (No Display) 

− Always displayed in the basic context menu (Always Display) 

− Or displayed in the enhanced menu (Enhanced Menu) 

. 

 
See also Modifying the Context Menu [Seite 251]. The letters X (for Always Display) and E 
(for Enhanced Menu) describe the values for the corresponding parameters for modifying the 
context menu.  

Storing Settings in the Library 
• As well as saving the settings you determine for Web items, you can also save the properties of a 

template in a library. Choose Save in Library in the lower area of the Web Item tabstrip. For details of 
how to save your properties and for creating new libraries, see Working with the Library for Web Items 
[Seite 33]. 

• The saved Web template properties are treated in the same way as the Web items you saved in the 
library, meaning that you can find your saved Web template properties in the Web Items window on 
the Library tabstrip. Once you have saved your Web template properties, you have created a model 
for further Web templates. 

Applying Settings to the Current Web Template 
• To copy properties to other Web templates, proceed as follows: 

a. In the Web Items window, on the Library tabstrip, with the right mouse button choose the Web 
template property that you want to copy. 

b. Choose Transfer Properties for Current Template. 

The properties for the Web template are transferred. You can see this in the changed settings for 
the Web template in the Properties window. 

• To reassign the standard settings to the current Web template, choose Web Template → Reset 
Properties 

In the Properties window, the standard settings are now reset. 
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 Designing the Layout of Web Templates 
Use 
You can change the layout of your Web template - the HTML page with BW-specific contents - as you are 
familiar from HTML editors.  

Arranging Web Items on the Page  
• You can change the size of the placeholders. You can see what effect resizing a Web item in a Web 

application has by looking at the values, which are shown in the HTML view by the parameters Height 
and Width for the corresponding item. 

• You can align the Web items horizontally. 

− Choose  to left-justify the Web item. 

− Choose  to center the Web item. 

− Choose  to right-justify the Web item. 

• To regroup the Web items, drag a Web item to the required position with Drag&Drop. 

• To place several Web items one next to the other you have to set the width of the Web template to its 
optimal value. 

 
You have arranged a Web item on your Web template and want to arrange a second one next 
to it. If the Web template is wide enough for the second Web item, it is placed to the right of 
the first one. If it is not wide enough, the second Web item is placed below the first one since 
the browser makes a line feed as for standard HTML. 

 
To align the individual Web items in your Web template in the best possible way, use an 
HTML table. 

Arranging Web Items using an HTML Table 
To arrange Web items next to and below one another you can use an HTML table. You can apply this grid 
as you need to. 

1. Choose or Insert → Table  → Insert Table. 

• In the Insert Table dialog box enter the Number of Rows and Number of Columns.  

• In the Table Tag Attribute and Cell Tag Attribute fields you can make settings that are written to the 
corresponding tags in HTML. The table is displayed in the layout view as defined by these tags. 

• You can give the table a title under Title. 

• You can show and hide the frame during the layout process by choosing Layout →  Display Frame. 

• To show the HTML tags in the layout view choose Layout  → Display HTML Tags.  

• You can change the table with Insert → Table → 

− Insert Rows 
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− Insert Columns 

− Insert Cells 

− Delete Rows 

− Delete Columns 

− Delete Cells 

− Merge Cells 

− Split Cells 

 
You can change the size of the complete table but not of individual cells. 

2. Drag different Web items to the individual table cells, depending on whether you want to arrange your 
Web item horizontally or vertically.  

Enhancing Web Templates with Texts 
As well as inserting and arranging Web items, you can also enhance the Web template with texts and 
format them. 

1. Place the cursor on a position in the Web template and enter a text of your choice.  

2. You can format it by selecting the text passage and selecting one of the following options: 

− Change Font 

− Change Font Size 

− Bold Character ( ) 

− Italic Character ( ) 

− Underlined Character( ) 

− Character Settings ( ) 

− Numbering ( ) 

− Bullets ( ) 

− Reduce Indentation ( ) 

− Enlarge Indentation ( ) 

− Left-justified ( ) 

− Centered ( ) 

− Right-justified ( ) 

Enhancing Web Templates with Images 
As well as inserting and arranging Web items and texts, you can attach image, such as company logos for 
example, to your Web templates. These images are store in the MIME Repository on the BW server. The 
system supports the formats GIF, JPG and BMP. 
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1. Position the cursor where you want to insert an image in the Web template. 

2. Choose Insert → Image and select the image file that you want to insert. Choose OK.  

If you want to use an image that is not in the list, for example, one that is stored on your Web 
server, mark the checkbox beneath the selection list and enter the URL of the image. For more 
information about inserting images in Web templates, see Stylesheet and Icon Store [Seite 24]. 
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 Working with the Library for Web Items 
Use 
If you integrate a Web item in your Web template from the templates under Standard and you have 
defined your settings, you might want to use this Web item again in this form in other Web templates 
without having to define all the settings over again. The BEx Web Application Designer enables you to use 
your own version of a Web item as the Web template for other items. You store this Web item as a 
template and insert it in a library that you can organize yourself. You can then access your Web items in 
the Web Item window using the Library tabstrip.  

Prerequisites 
You have integrated a Web item in your Web template and defined your settings on the Web Item tabstrip 
in the Properties window.   

Storing Web Items in the Library 

 
You save the properties that you created on the Web Item tab page in the library. These Web 
items have template characters and can be altered. Data binding is not stored in relation to 
this Web item. 

1. Choose Save in Library in the lower part of the Web Item tabstrip to store your Web item as a 
template. 

2. Select a library in the Add Web Item to Library dialog box. 

• To create a new library choose . 

a. In the Create New Library dialog box, define whether you want to store your library in your 
favorites or in a role. 

b. Select the folder in which you want to store your library. 

c. Define a meaningful Description that will appear later on in your library. 

d. In the Technical Name field, enter a unique name. 

e. Choose Save. 

• To select an existing library choose . 

a. In the BEx Open dialog box, select the place where you stored the library – History, Roles, 
Workbooks. 

b. Select a library and choose OK. 

3. Define a meaningful Description that will appear later in your library as text for your personal master 
Web item. 

4. In the Technical Name field, enter a unique name. 

5. Choose Save. 

Your Web item is now saved in the library. 
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Using Web Items from the Library 
You can find the libraries you created containing your personal Web items on the Library tabstrip in the 
Web Items window. Your libraries and the Web items assigned to the libraries are displayed here in a tree-
like structure.  

• To place your Web items in Web templates, drag them using Drag&Drop to your Web template in the 
same way as you do with standard items.  

• To change the settings for your saved Web item, select the relevant Web item and with the right 
mouse button choose Change Web Item. The settings for changing the item are offered in the Change 
Web Item dialog box.  

• To delete a Web item from the library, select the Web item and with the right mouse button choose 
Delete Web item. 

Managing Libraries 
If you do not yet have any libraries, proceed as follows: Click on Context Menu and choose one of the 
options. 

• Open Library to add a library. 

• Create New Library to create a new library (on the database). 

To manage your existing libraries, select the appropriate library with the right mouse button and choose 
one of the following options: 

• Open Library to add a library to your collection of libraries in the Web Item window. 

• Close Library to remove a library from your collection of libraries in the Web Item window.  

• Create New Library to create a new library (on the database). 

• Delete Library to delete a library (from the database).  

• Change Description to change the description of the library. 

• Documents to create documents for your library, or to create or edit existing documents. You can find 
additional information under Documents [Extern] and Creating Documents [Extern] . 

• Publish Library in Role to add your library to a role. 

Overwriting Libraries 
You can overwrite libraries that you have created and saved.  

1. In the Web Items window of the Web Application Designer, choose the Library tab page. 

2. Using the context menu, choose  Create New Library. You reach the Create New Library dialog 
box.  

3. In you favorites or roles, select the library that you want to overwrite and choose Save.  

 
You can overwrite those item libraries that contain Web items that are not currently in use in 
Web templates or that you are not open in your Web Application Designer.   

4. The Overwrite Object dialog box appears. 

5. Choose Yes. 
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 Setting Up the BEx Web Application Designer 
Use 
The Web Application Designer has a set appearance the first time you start it. See BEx Web Application 
Designer [Seite 14]. As an MDI application, however, you can adjust your working environment to your 
requirements. The object on which you are working, namely the Web template, is handled differently from 
the tools and help windows with which you are working. 

Showing and Hiding Screen Areas 
You can hide the Web Items and Properties windows by clicking on the x in the title bar. 

To show the window again choose View  → Web Items or View → Settings. 

 
You close the template by closing Template window.  

To show and hide the tool bar or status bar, choose View  → Toolbar or View  → Status bar. 

Moving Screen Areas 
You can move the toolbar and the Web Items and Settings windows anywhere.  Depending on where you 
move the object to, it is anchored or it appears freely as a toolbox.  

Template Window 
An individual template window can be: 

• Open 

• Closed 

 
You can close a template window but not hide it. 

• Minimized 

• Maximized 

You can open and manage different windows in parallel with Web templates. You can also arrange the 
windows differently. 

• To arrange the different windows to overlap choose Window  →  Cascading. 

• To arrange the different windows next to each other choose Window  →  Horizontal. 

• To arrange the different windows below each other choose Window  →  Vertical. 
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 Web Items 
Definition 
Web items are objects that obtain data from data providers [Seite 268] and make the data available as 
HTML. Web items have attributes such as header, width, height, and create navigation links. You use 
parameters or specific commands to change these attributes. 

If the data, the navigational status, or the attributes change, the HTML for the Web item is regenerated. A 
Web item must always be assigned to a data provider. 

Structure 
The following Web items are used in Web applications: 

•   Table [Seite 43] 

•   Chart [Seite 47] 

•   Dropdown Box [Seite 143] 

•   Radio Button Group [Seite 146] 

•   Checkbox [Seite 149] 

•   Generic Navigation Block [Seite 151] 

•   Hierarchical Context Menu [Seite 154] 

•   Filter [Seite 156] 

•   Label [Seite 159] 

•   Text Element [Seite 161] 

•   List of Exceptions [Seite 164] 

•   List of Conditions [Seite 165] 

•   Alert Monitor [Seite 166] 

•   Role Menu [Seite 169] 

•   Ticker [Seite 172] 

•   Map [Seite 173] 

•   Single Document [Seite 205] 

•   List of Documents [Seite 207] 

•   Ad-hoc Query Designer [Seite 210] 

•  ABC Classification [Seite 217] 

•  What If Prediction [Seite 215] 

Integration 
In the BEx Web Application Designer or the BEx Web Application wizard, on the Standard tab, you can 
use the Web items listed above as Master Web Items [Extern] You choose a master Web item from the 
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list, assign a data provider to the Web item and edit the attributes. You have now created your own Web 
item that your can add to your Web template or save in the library to be used again. 
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 General attributes 

Use 
General attributes are attributes that are valid for all Web items in Web applications. 

Features 
The following general attributes are available: 

Attributes Description 

Logical name of a Web item (ITEM or NAME) As well as the Web item key (ITEMID) that is 
assigned when the Web item is created in the 
Web Application Designer, you also have to 
assign a logical name when using the Web 
item in Web application. This enables you to 
use the same Web item several times in a Web 
application. If commands are sent to this Web 
item, you always have to specify the name of 
the Web item as the parameter ITEM. 

 
You cannot change this attribute 
with a command URL. 

Web item key (ITEM_ID) (option 1) 
 

You create a Web item for a Web application 
based on a Web item setting that you have 
made in the Web Application Designer. 

 
You cannot change this attribute 
with a command URL. 

Class name for the Web item class 
(ITEM_CLASS) (option 2) 

Name of the ABAP object class that generates 
the output. This corresponds to the use of non-
reusable Web items (standard Web items) in 
the Web Application Designer. Web items are 
created with the default values for the attribute. 

The class name for the table is, for example, 
CL_RSR_WWW_ITEM_GRID 

Logical name of the Data Provider for the 
Web item (DATA_PROVIDER) 

You have to assign every Web item to (exactly) 
one data source. The Web item gets the data 
and metadata from this Data source that is 
needed to generate the output as well as 
commands. 

Height (HEIGHT) You can only specify the height in pixels. 

 
This attribute is not used in tables. 
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The parameters ITEMID and WBID (ITEM_WBID) used in BW 2.x are still supported. We 
recommend, however, that you no longer use these. 

In the BEx Web Application Designer, in the Properties area, you can set the following attributes in the 
Web Item tabpage, under General: 

Attributes Description 

Caption (CAPTION) You can enter a caption. If you do not enter a 
caption, then an appropriate value is 
suggested. 

Generate caption (GENERATE_CAPTION) 
‘X’ = Yes, ‘  ’ = No 

By activating this attribute, an additional row 
containing the Web item is generated in the 
table. The text you have entered under Caption 
is displayed in this table. 

 
The SAPBEXTableCaption style is 
used for the caption. 

Width in pixels (WIDTH) You can only specify the width in pixels. You 
can use the suggested width or determine a 
new width using Change Attribute... 

 
Note that the Web browser  
automatically increases the widths 
of the table if the one you have 
chosen is too small. 
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Border type 
(BORDER_STYLE) 
'BORDER' = With border 

‚NO_BORDER’ = Without border 

‚FORM’ = Form 

Here, you can choose the following display 
types for the Web item: 

• With border 

Set as default value for table, generic 
navigation block, Alert Monitor, filter, 
text elements, menu, list of conditions, 
and list of exceptions. 

 
The border is only displayed if 
GENERATE_CAPTION=X. 

• Without border 

Set as default value for maps, charts, 
and individual documents. 

• For form 

The content of the Web item is 
normally displayed with a blue 
background. Set as default value for 
document list, hierarchical context 
menu, label, dropdown box, radio 
button group, and checkboxes. 

 
The standard value settings represent the 
recommended display type for the Web item. 

Closed (CLOSED) 
‘X’ = Yes, ‘  ’ = No 

You can close the Web item (CLOSED=X): The 
Web item is not displayed. Only the caption 
remains (if there is one) and the open/close 
symbol for this Web item. By clicking on the 
open/close symbol, you can make the Web 
item visible or invisible. 

 
To be able to see the caption, you 
have to activate the attributes 
Generate Caption and Objects with 
Navigation Links. 

Hide object (HIDDEN) 
‘X’ = Yes, ‘  ’ = No 

You can hide the Web item (HIDDEN=X): 
Although the Web item is embedded in the 
Web template, it is not visible. The Web item 
and the caption with the open/close symbol are 
not shown. 
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Objects with navigation links 
(GENERATE_LINKS) 
‘X’ = Yes, ‘  ’ = No 

This attribute creates the open/close symbol, 
with which you can open or close the Web 
item. Behind this symbol is a link that calls up 
the Web application with the corresponding 
parameters. 

 
If you do not want the user of the 
Web application to be able to 
navigate within it or if you want the 
user to be able to print the display, 
then deactivate this function. 

Web item controls different data providers 
(TARGET_DATA_PROVIDER_I) (optional) 
For many Web items, this attribute appears 
under the respective special attributes. These 
Web items obtain their data from a view. 

If a Web item is to control several data 
providers, for example, a navigation block, it 
can be expressed by this parameter. If it is not 
specified, the Web item always controls its own 
data provider. The values specified under this 
parameter are the logical names of the data 
providers, for example, references using wild 
cards. You do not have to specify the data 
provider belonging to the Web item. If it is 
missing, the Web item does not control its own 
data provider. 

The Web item output generation is always 
based on the item’s own data provider and 
does not include the others. The commands 
are forwarded to the target data provider. 
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 Resetting and Reinitializing Web Items 
Use 
You use this command to reinitialize an existing Web item. The Web item is recreated according to the 
parameters and takes the data provider [Seite 268] and the logical name of its predecessor. This allows 
you, for example, to create a graphic easily from a table without having to create both objects in the Web 
template. 

 
You can use this command for creating almost every kind of Web item. However, the Map 
Web item is an exception. It cannot be created consistently using this command. 

Functions 
CMD RESET_ITEM 

Parameter Description 

All parameters from the previous item Technical name of the InfoCube 

 

 
Converting the item “Item1” to a table without alternate rows: 
<SAP_BW_URL ITEM='Item1' CMD='RESET_ITEM' 
ITEM_CLASS='CL_RSR_WWW_ITEM_GRID' ALT_STYLES=''> 

Converting the item “Item1” to a pre-defined chart item: 
<SAP_BW_URL ITEM='Item1' CMD='RESET_ITEM' ITEM_ID='myChart'> 

When combined with a select box (an HTML form), you can display several charts in one 
place by leafing through the select box. 
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 Tables 
Definition 
A Web item that obtains data from a query view to create a table for a Web application. There are 
navigation links that go along with the table. 

Use 
The Web item  Table displays the value of a query view in the Web application in the form of a table. 
The same list geometry that is used in the BEx Analyzer is supported. Characteristics and structures can 
be displayed in both the rows and the columns. 

Structure 
As well as its general attributes [Seite 38], the Web item Table has the following attributes: 

Attributes Description 

Alternating styles for table rows 
(ALT_STYLES) 
‘X’ = Yes, ‘  ’ = No 

In the rows, the formats SAPBEXstdData and 
SAPBEXstdDataOdd are used alternately to 
display numerical values. These formats are 
adjusted in the CSS file that is assigned to the 
template. 

 
Totals cells are removed from this 
display. 

Only hierarchy navigation 
(ONLY_HIERARCHY_NAVIGATION) 
‘X’ = Yes, ‘  ’ = No 

Only allow hierarchy navigation 
The context menu is hidden in this mode, and 
you can only expand and collapse from the list. 

Suppress repeated texts 
(SUPPRESS_REPETITION_TEXTS) 
‘X’ = Yes, ‘  ’ = No 

Suppressing repeated texts 
If you set this attribute toe ‘ ‘, the cells in the 
table are not merged and the texts and keys 
are repeated. 

If you do not specify a value for this attribute, 
the texts are suppressed. 

Number of data rows displayed at one time 
(BLOCK_SIZE) 

Specifying this parameter allows you to 
determined the number of data rows that are 
displayed after which an area for scrolling is 
inserted. 

 
If the value is set to 0, the 
complete table is displayed, 
regardless of the number of data 
rows. 

The parameter is set to 100 by 
default. 
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Number of data columns displayed at one 
time (BLOCK_SIZE_COLUMNS) 

Specifying this parameter allows you to 
determined the number of data columns that 
are displayed after which an area for scrolling 
is inserted. 

 
If the value is set to 0, the 
complete table is displayed, 
regardless of the number of data 
columns. 

The parameter is set to 0 by 
default. 

Table: Scrolling area top 
(SHOW_PAGING_AREA_TOP) 
‘X’ = Yes, ‘  ’ = No 

Display the scrolling area at the start of the 
table 
The parameter is set to ‘ ’ by default. 

Table: Scrolling area bottom 
(SHOW_PAGING_AREA_BOTTOM) 
‘X’ = Yes, ‘  ’ = No 

Display the scrolling area at the end of the 
table 
The parameter is set to ‘X’ by default. 

Display column headers 
(SHOW_COLUMN_HEADER) 
‘X’ = Yes, ‘  ’ = No 

Display the labels above the data 
The parameter is set to ‘X’ by default. 

Display column headers 
SHOW_ROW_HEADER) 
‘X’ = Yes, ‘  ’ = No 

Display the labels to the left of the data 
The parameter is set to ‘X’ by default. 

Display data cells (SHOW_DATA_CELLS) 
‘X’ = Yes, ‘  ’ = No 

The data cells are shown by default. That is, 
the parameter is set to ‘X’ by default. 

Affected DataProvider 
(TARGET_DATA_PROVIDER) 

List of data providers to which all table 
commands are sent. 

Display data from value row 
(DATA_ROW_FROM) 

Data row after which data is displayed 
The parameter is set to 1 by default. 

Display data to value row (0=to the end) 
(DATA_ROW_TO) 

Data row to which data is displayed 
The parameter is set to 0 by default. If the 
value is 0, the system tries to display all of the 
rows. If there are too many, a scrolling area is 
inserted. If the value is not 0, data is displayed 
up to the specified row and there is no scrolling 
area. 

Display data from value column 
(DATA_COLUMN_FROM) 

Data column after which the data is 
displayed 
The parameter is set to 1 by default. 
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Display data to value column (0=to the end) 
(DATA_COLUMN_TO) 

Data column to which data is displayed 
The parameter is set to 0 by default. If the 
value is 0, the system tries to display all of the 
columns. If there are too many, a scrolling area 
is inserted. If the value is not 0, data is 
displayed up to the specified column and there 
is no scrolling area. 

Attributes that cannot be set in the Web Application Designer: 

MODIFY_CLASS ABAP class that changes the table contents 
By using the Web design API for tables, you 
can adjust the contents of the table cells 
individually. 

See also: 

Web Design API for Tables [Seite 338] 

 
Display the table with a maximum of 5 visible data columns and 10 visible data rows. 
Start at row 30 and show a scrolling area above and below the values 

<object> 

 <param name=’OWNER’ value=’SAP_BW’> 
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 <param name=’CMD’ value=’GET_ITEM’> 
 <param name='ITEM' value='Table'> 
 <param name='ITEM_CLASS' value='CL_RSR_WWW_ITEM_GRID'> 
 <param name='DATA_PROVIDER' value='View1 > 
 <param name='DATA_ROW_FROM' value='30'> 
 <param name='SHOW_PAGING_AREA_TOP' value='X'> 
 <param name='SHOW_PAGING_AREA_BOTTOM' value='X'> 
 <param name='BLOCK_SIZE' value='10'> 
 <param name='BLOCK_SIZE_COLUMNS' value='5'> 

 ITEM :Table 

</object> 

Display only the 3 data rows without headers 
<object> 

 <param name=’OWNER’ value=’SAP_BW’> 
 <param name=’CMD’ value=’GET_ITEM’> 
 <param name='ITEM' value='Table'> 
 <param name='ITEM_ID' value='MYTABLE'> 
 <param name='DATA_PROVIDER' value='View1 > 
 <param name='DATA_ROW_FROM' value='3'> 
 <param name='DATA_ROW_TO' value='3'> 
 <param name='SHOW_COLUMN_HEADER' value=' '> 

 ITEM :Table 

</object> 
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 Charts 
Definition 
A Web item that obtains data from a query view to create a graphic for a Web application. 

Use 
Using the  Chart Web item, you can display data graphically in your Web application. 

Structure 
As well as its General Attributes [Seite 38], the Chart Web item has the following attributes: 

Attributes Description 

Edit Graphic See Editing Charts [Seite 49]. 

Suppress Totals 
(SUPPRESS_SUMS) 
‘X’ = Yes, ‘  ’ = No 

The totals rows/columns of the source data 
provider are not displayed in the chart. This 
means that you do not have to change the data 
provider to suppress totals which may affect 
charts adversely. 

Swap Display Axes 
(SWITCHMATRIX) 
‘X’ = Yes, ‘  ’ = No 

With this attribute you can swap the chart axes 
in the display, without changing the 
navigational state of the query view itself. 

 
You get the same effect if you 
swap the two free characteristics 
with one another in the initial query 
view. 

Hide Expanded Hierarchy Nodes 
(SUPPRESS_OPENHIERARCHIENODES) 
‘X’ = Yes, ‘  ’ = No 

You can remove open nodes when you create 
graphics in active presentation hierarchies. 
This ensures that the total of the values 
displayed is the overall result. 

Affected Data Providers 
(TARGET_DATA_PROVIDER) 

List of data providers to which all commands of 
the chart are sent. 

Automatic display of units and currencies 
(AUTOMATIC_LABELS) 
‘X’ = Yes, ‘  ’ = No 

If the units and currencies in the query are the 
same as other settings, and you select the 
attribute, just these units, currencies, and 
settings are displayed automatically on the 
chart.    

However, you can set the display of units and 
currencies yourself. See Editing Charts [Seite 
49] and Adding and Removing Axis Titles and 
Units [Seite 125]. 

Diagram title (language-dependent) 
(TITLE) 

Entry of language-dependent text for diagram 
title. See Language-Dependent Texts [Seite 
265]. 
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Section Axis (X): Title (Language-
Dependent) 
(TITLE_CATAGORIES) 

Language-dependent text for section axis (X). 
See Language-Dependent Texts [Seite 265]. 

Size Axis (Y): Title (Language-Dependent) 
(TITLE_VALUES) 

Language-dependent text for size axis (Y). See 
Language-Dependent Texts [Seite 265]. 

Secondary Section Axis (X): Title 
(Language-Dependent) 
(TITLE_SEC_CATOGORIES) 

Language-dependent text for secondary 
section axis (X). See Language-Dependent 
Texts [Seite 265]. 

Secondary Size Axis (Y): Title (Language-
Dependent) 
(TITLE_SEC_VALUES) 

Language-dependent text for secondary size 
axis (Y). See Language-Dependent Texts 
[Seite 265]. 

Note the following for the Heading attribute under General (generic attribute): 

Title You can enter a header for the chart. This 
header is not a part of the chart. 

 
Under Edit graphic there is also the 
option of specifying a header, 
though this is then a part of the 
chart. 

The header is only displayed if the 
attribute Generate header is 
activated at the same time. 
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 Editing Charts 
Use 
Charts display rows of numbers visually and make it easier for users to interpret business data. 

Drawing AreaTitle of Chart Background

Title of Axis

Grid Lines

Moscow
London
Berlin

Washington

Paris

Legend

Legend Symbol

Sales Revenue Development for Branches

Sa
le

s

Mio USD

Unit

January
2000

February
2000

March
2000

April
2000

May
2000

June
2000

Data Rows

Value Axis (Y)

Category Axis (X)

Data Point Legend Text

 

Prerequisites 
You can edit a chart in the Web Application Designer or in the Web Application Wizard. 

Editing in the Web Application Designer 
You created a new Web item of the type Chart or selected an existing Web item of the type Chart. In the 
Properties window on the Web Items tabstrip in the Special category, you called up Edit Graphic using the 
pushbutton with the three dots (see also Creating Web Applications with the BEx Web Application 
Designer [Seite 17]). 

Editing in the Web Application Wizard 
You created a new Web item of the type Chart and then in the step Editing Attributes in the Special 
category, you called up Edit Graphic using the pushbutton with the three dots. 

Process 
1. Before you begin publishing a chart you should define which chart type [Seite 61] you want to display. 

You can find out how the data provider should be built based on the class of the chart type.  

2. Select an existing query or formulate a new query with which the suitable view on the data can be 
created. This is the suitable data provider. 

3. Start the publishing process and create a new Web item of type Chart. 

4. It is normally advisable to configure the properties of the Chart [Seite 47] Web item as follows: 
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− Expanded hierarchy nodes should be hidden. 

− Totals should be suppressed. 

− If you want to swap the columns and rows of the data provider in the chart, you should assign the 
chart the property Axes for display. The columns and rows are then swapped automatically when 
the chart is generated. You need not change the view on which the chart is based. 

5. When you edit the chart, the Web Application Designer or Web Application Wizard first shows the 
default setting, that is, a bar chart.  

− First configure the preview window so that the number of data series and data points displayed 
corresponds to your data provider (see Configuring the Preview Window [Seite 51]). 

− Assign the chart the required chart type and format the chart as you like. 

− You can select all the functions of a chart in the context menu with the right mouse key.  Different 
functions are available in the context menu depending on the element you marked in the chart. 

6. Check your formatting by publishing the chart immediately after making a change. In this way you can 
see if your chart is correctly formatted in the Web version. 
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 Configuring Preview Windows 
Use 
When you edit a chart you can see the current format of the chart in a preview window. The preview 
window shows five data series with six data points each, irrespective of how the data provider is set up.  

You can adjust the size of the preview window. To do this, drag the right-hand corner of the bottom line 
down and to the right. At the same time, the system calculates the size and width of the graphic in pixels. 
The minimum size is 10x10 pixels.  

Change the preview window settings so that the number of data series and data points corresponds to the 
data provider. For chart types of class 1, the uppermost data series in the legend corresponds to the first 
table row, the next data series corresponds to the second table row, and so on. 

 
The preview does not correspond to the actual results after publishing. The data series and 
data points are only sample data used to show you what the effects of formatting are. You see 
the actual data only after it has been published. 

Procedure 
1. In the window in which you are editing the chart, enter the number of data series contained in the data 

provider in the Number of data series field. 

2. In the Number of Data Points field, enter the number of data points in a data series. 

3. Choose Apply. 

The chart in the preview window is changed according to your entries. 

See also: Data Series and Data Points [Seite 96] 
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 Undoing Changes 
Use 
When you edit a chart, all the changes you make to the chart are recorded. If you are not satisfied with the 
results of the changes, you can undo the changes step by step. 

You can reset the chart to the standard setting (bar diagram). All the changes you made to the chart are 
lost. 

Procedure 
Undoing Changes 
1. Click with the right mouse key on any area of the chart. 

2. To undo the last command, choose Undo in the context menu. 

 
The name of the menu options shows you which command is being undone. For example, if 
you last changed the chart type, the menu option is Undo Chart Type. If there is no command 
that can be undone, the menu option is Undo Not available.  

Resetting the Chart to the Standard Setting 

 
In this step all the changes you made to the chart are lost. 

Select the Reset function in the window in which you are editing the chart. 
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 Formatting the Chart Background 
Use 
You can change the background of the entire chart. You can choose another filling and change the border 
as you like. 

Procedure 
1. Click with the right mouse key on the outermost area of the chart. 

2. In the context menu choose Format Chart. 

The Format Chart Area dialog box appears. 

3. Select the formatting for the filling and border. See Changing the Filling and Borders of Surfaces 
[Seite 55]. 

4. Choose OK. 

See also: 
Formatting Chart Plot Areas [Seite 54] 
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 Formatting Chart Plot Areas 
Use 
You can format the plot area of the chart as you like. You can change the filling and borders of the surface 
between the X and Y axes. You can also format the border surrounding the entire plot area, including the 
axes and labels. 

Procedure 
1. Click with the right mouse key on the plot area, for example on a free area within the X and Y axes. 

2. In the context menu choose Format Plot Area. 

3. The Format Plot dialog box appears. 

4. Make the changes described below and choose OK. 

Changing the Filling and Borders of the Area between the X and Y Axes 

 
In a pie or ring diagram, this area is a rectangle enclosing the circle. 

1. Choose tabstrip Pattern. 

2. Select the formatting for the filling and border. See. Changing the Filling and Borders of Surfaces 
[Seite 55]. 

Changing the Border of the Entire Plot Area 
1. Choose tabstrip Line. 

2. If you want to copy the default formatting, choose Automatic. 

3. If you want to set up your own formatting, choose Custom. Select the required type and color for the 
lines. 

See also: 

• Changing Quadrants [Seite 118] 

• Formatting the Chart Background [Seite 53] 
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 Changing the Filling and Border of Surfaces 
Use 
You can change the filling and border of the surface of elements having the form of a surface. If you select 
the corresponding element and call the dialog box for formatting the element, tabstrip Pattern will offer you 
several formatting options. 

Prerequisites 
The element to be formatted is itself a surface (for example the plot area or the columns in a two-
dimensional column chart) or it consists of surfaces (for example the columns in a three-dimensional 
column chart). 

Procedure 
1. Click with the right mouse key on the element you want to format. 

2. In the context menu, select the function for formatting the element, such as Format Plot Area for the 
plot area. 

A dialog box appears. 

3. Choose tabstrip Pattern. 

4. Make the changes described below and choose OK. 

Changing the Filling 
You can change the filling with the fields in the Fill area. 

Automatic 
If you want to copy the default formatting, choose Automatic. 

Color 
1. To change the color of the filling, select Color. 

2. Select the required color or None if the surface should not be colored. 

Pattern 
1. If you want to give the surface a pattern, select Pattern. 

2. Select one of the patterns and the colors for the foreground and background of the pattern. 

Texture 
1. If the background of the surface is to be textured, select Texture. 

2. Choose the texture you want to use. 

Gradient 
1. If you want to fill the surface with a gradient, choose Gradient. 

2. Select the direction for the gradient, for example starting at the lower left corner and going up 
diagonally. 

3. Also select the colors between which the gradient should be created. 
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Image 
1. If you want to store an image in bmp or jpeg format as background, select Image. 

2. Choose a color for the background of the image.  

3. Under Image Style, define how the image should be inserted. For example you can define that the 
image should keep its original size or be scaled proportionally to the size of the surface.  

4. With Browse Image now select the image file. 

Transparent 
1. To display the entire surface transparently, select Transparent. 

You can also see any surfaces lying underneath. This option is normally marked for a normal 
distribution so that the normal distribution does not hide the data series. 

2. With Pattern you can define the pattern to be used to display the surface. 

Changing Borders 
You can change the borders of a surface with the fields in the Border area. 

• If you want to copy the default formatting, choose Automatic. 

• If you want to set up your own formatting, choose Custom. Under Style select the required type of line 
or None if you do not want a border. Also select the color and width of the border. 
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 Changing the Size of Chart Elements 
Use 
You can change the size of the entire chart by specifying the width and height in pixels or by pulling the 
chart to the desired size with the mouse.  

You can also change the size of the plot area within the chart and the size of the legend. 

Procedure 
Defining the Width and Height of the Entire Chart 
1. Enter the desired values in fields Width and Height of the window in which you are editing the chart. 

The entries should be in pixels. 

2. Choose Apply. 

The size of the entire chart is changed according to your specifications. 

Changing the Size of the Entire Chart with the Mouse 
1. Point to the border of the preview window with the mouse. 

The cursor becomes a double arrow. 

2. Click on the border and pull the preview window to the required size. 

3. The size of the entire chart is changed when you let go of the mouse key. 

Changing the Size of the Plot Area or the Legend with the Mouse 
1. Click on the element whose size you want to change (plot area or legend). 

The element is enclosed in a move handle. 

2. Point to one of the move handles with the mouse. 

The cursor becomes a double arrow. 

 
If the cursor does not become a double arrow, you might not have selected the right element, 
for example the chart area instead of the plot area. In this case click again on the element 
whose size you want to change. 

3. Click on the move handle and keep the mouse key pressed. 

The cursor becomes a cross. 

4. Pull the element to the desired size. 

5. The size of the element is changed when you let go of the mouse key. 

 
Avoid stretching the plot area over the whole area of the chart. The outermost border of the 
plot area disappears from the visible area in this case and cannot be clicked on again. You 
cannot change the size of the plot area. If you made the plot area too large by accident, you 
can undo it with the menu option Undo in the context menu. You can reset the plot area to its 
original size with Reset, but you will lose all the changes you made to the chart.  
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 Changing the Position of Chart Elements 
Use 
You can change the position of the following elements directly in the chart: 

• Plot area 

• Data label 

• Axis title 

• Axis unit 

• Value range title 

• Normal distribution title 

You can change the position of the chart title if you permitted this when you added the title. See Adding 
and Removing Chart Titles [Seite 124]. You can change the position of the legend directly in the chart if 
you permitted this when you added the legend. See Adding and Removing Legends [Seite 133]. 

Procedure 
Changing the Position of a Data Label 
1. Click on the data label whose position is to be changed. 

2. Click again on the data label, keeping the mouse key pressed. 

3. Pull the data label to the required position. 

4. Let go of the mouse key. 

Changing the Position of Other Elements 
1. Click on the element whose position is to be changed. Keep the mouse key pressed. 

2. Pull the element to the new position. 

3. Let go of the mouse key. 

 
You can also change the position of the legends by clicking on the outermost border of the 
legend with the right mouse key and choosing Format Legend in the context menu. You can 
then select the desired position on the Legend tabstrip. 
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 Removing Chart Elements 
Use 
You can remove the following elements directly in the chart: 

• Chart title 

• Axis title 

• Axis unit 

• Axis including its title and corresponding unit 

• Complete value range 

• Gridlines 

• Complete legend 

• Data label for a data series 

• Normal distribution 

Procedure 
1. Click on the element you want to remove. 

2. Press <Del>. 

 
You can also remove legends, value ranges and normal distributions by clicking on the 
element with the right mouse key and choosing Delete in the context menu. 
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 Chart Types 
Definition 
The chart type defines how your data will be edited graphically.  

 
The chart types for stock, milestone and multicolorbars are not supported at the moment. 

The chart types can be divided into four classes when they are edited. With chart types of the same class, 
the rows and columns of the underlying table (that is of the data provider) are edited immediately. 

The class to which each chart type belongs is given below. Before you begin publishing a chart, you 
should define which chart type you want to display. You can find out how the data provider should be built 
based on the class of the chart type. You can then select an existing query or formulate a new query with 
which the suitable view on the data can be created. This is the suitable data provider. 

Column Charts 
Comparisons between individual elements are shown in a column. Categories are arranged horizontally 
and values are arranged vertically. 

To show changes within a certain time interval, you can use either column charts or XY scatter charts.  

The relationship between indivdidual elements and the entire chart is shown in stacked columns. 

Column charts are chart types of class 1 [Seite 64]. 

Bar Charts 
Comparisons between individual elements are shown in a bar chart. Categories are arranged vertically 
and values are arranged horizontally. The emphasis is on the comparison of values and not on displaying 
a change during a period of time.  

The relationship between indivdidual elements and the entire chart is shown in stacked bars. 

Bar charts are chart types of class 1 [Seite 64]. 

Line Charts 
Data trends are shown in a line chart. The data is entered at regular intervals. Categories such as months 
are normally entered on the X axis and values such as income in dollars on the Y axis. 

Line charts are chart types of class 1 [Seite 64]. 

Profile Charts 
In a profile chart the lines are arranged vertically and not horizontally as in a line chart. Otherwise the 
profile chart corresponds to the line chart.  

Profile charts are chart types of class 1 [Seite 64]. 

Pie Charts 
In a pie chart, the proportional part of elements of a data series are displayed in a whole. This chart type 
has only a single data series and is used primarily to highlight a particularly important element. 

You can use the subtypes to define if the pie segments should be displayed next to each other or 
separately. 

Pie charts are chart types of class 1 [Seite 64]. 
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XY Scatter Charts 
In an XY scatter chart, either the relationship between numeric values is displayed in several data series 
or two groups of numbers are entered as a row of XY coordinates. This chart type displays irregular 
intervals (clusters) and is normally used for scientific data. 

Both axes of an XY scatter chart are value axes. In other chart types, the X axis is used to show 
categories. 

XY scatter charts are chart types of class 2 [Seite 73]. 

Area Charts 
The area between the axes and the data series are filled in an area chart. Otherwise the area chart 
corresponds to the line chart. 

An area chart also represents the sum of the entered values and can thus illustrate the relationship of 
parts to the entire amount. 

Area charts are chart types of class 1 [Seite 64]. 

Doughnuts 
As in a pie chart, the relationship between parts of a whole are displayed in a doughnut. In contrast to the 
pie chart, the doughnut can represent more than one data series, where each ring corresponds to a data 
series. 

You can use the subtypes to define if the rings should be displayed next to each other or separately. 

Doughnuts are chart types of class 1 [Seite 64]. 

Radar Charts 
In a radar chart, each category has its own value axis emanating from the middle. The values of a data 
series are linked with lines.  

Radar charts can be used to compare data series: the data series with the highest values occupies the 
most space. 

Radar charts are chart types of class 1 [Seite 64]. 

Portfolios 
A portfolio displays the position of an object (enterprise, product, etc.) in a four-field matrix. The position of 
the object is defined with two dimensions. 

Portfolios are used mainly in enterprise and product comparisons. For example, a portfolio can be sorted 
like the products of an enterprise by their dimensions economics and strategic significance. 

Portfolios are chart types of class 3 [Seite 75]. 

Surface Charts 
Data sets are entered in the form of a surface in a surface chart. A surface chart differs from a line chart in 
that the points of a data series are displayed one after the other for each category. 

As in a topographical map, the colors and patterns represent areas with the same value range. 

Surface charts are chart types of class 1 [Seite 64]. 

Cylinders, Cones and Pyramids 
Cones, cylinders and pyramids only differ from bar and line charts in their form. Each of these chart types 
has subtypes that display the values horizontally or vertically. 

Cones, cylinders and pyramids are chart types of class 1 [Seite 64]. 
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Step Charts 
In a step chart, values are entered in the form of steps and not points on a curve. Each value corresponds 
to a horizontal line. The vertical lines link the individual values. For example, the step-by-step 
development of fix costs can be represented with a step chart. 

The X axis is defined as the value axis in step charts. In other chart types, the X axis is used to show 
categories. 

Step charts are chart types of class 2 [Seite 73]. 

Histograms 
The frequency of a characteristic is displayed in a histogram, for example the distribution of the income 
within an enterprise. The frequency is divided into classes, where each class corresponds to a column in 
the histogram.  

Categories and value ranges are entered on the X axis and the corresponding values on the Y axis in a 
histogram. The normal distribution is also shown in the histogram depending on the subtype.  

Histograms are chart types of class 2 [Seite 73]. 

Tachometers 
In a tachometer, one or more key figures are displayed in the form of a pointer. The tachometer is divided 
into several value ranges and the user immediately sees the value range in which the pointer is currently 
positioned.  

Tachometers are chart types of class 1 [Seite 64]. 

Quadrants 
In a quadrant, two objects are positioned in a four-field matrix. One object is displayed as a cross, the 
second object is displayed as a point and positioned relative to the cross. 

Quadrants are chart types of class 3 [Seite 75]. 
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 Editing Chart Types of Class 1 
Chart Types 
Class 1 includes the following chart types: 

• Bar and column charts 

• Area charts 

• Line charts 

• Cylinders, cones and pyramids 

• Pie charts and doughnuts 

• Radar charts 

• Surface charts 

• Profile charts 

• Tachometers 

Structure of the Data Provider for a Pie Chart 
In a pie chart, the underlying table has only one row. The values in the row result from the pie segments of 
the chart. 

 
If the table contains more than one row, the additional rows are ignored when the table is 
converted into a chart. 

Structure of the Data Provider for a Tachometer 
In a tachometer, the underlying table has only one data column. Each value in the data column is 
displayed in the chart as a pointer. The tachometer will be readable if the data column does not contain 
too many values.  

 
If the table contains more than one data column, the additional columns are ignored when the 
table is converted into a chart. 

Structure of the Data Provider for the Other Chart Types 
You build the underlying table of the other chart types of class 1 as follows: 

• The data columns correspond to the categories. 

• The rows contain the values for each category. Each row is converted into a data series in the chart. 

Example for Bar and Column Charts 
The following graphic shows a data provider that is used as the basis for the chart types described below. 
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Values
(Data
series)

Category

Sales Organization No. Order Items

Frankfurt 118

Berlin 87

Birmingham 158

Paris 191

New York 181

San Francisco 55

Toronto 191

 

Bar Chart 
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Column Chart 
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3D Column Chart 
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Example for Area Chart 
The following graphic shows a data provider that is used as the basis for an area chart. 

Values
(Data
series)

Category

Organization Unit No. Employees

Board D 510

Board UK 274

Board US 423

Board CAN 13

 
Below you see an area chart that is based on the data provider.  
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No. Employees

Board D Board UK Board US Board CAN
 

Example of a Pie Chart 
The following graphic shows a data provider that is used as the basis for a pie chart. 

Values
(Data
series)

Category

Organization Unit
Percentage Distribution
of Employees

Board D 41.8 %

Board UK 22.5 %

Board US 34.7 %

Board CAN 1.1 %

 
Below you see a pie chart that is based on the data provider.  
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1.1 %

Percentage Distribution of Employees

Board D

Board UK
Board US

Board CAN

41.8 %

22.5 %

34.7 %

 

Example of a Line and Profile Chart 
The following graphic shows a data provider that is used as the basis for a line and profile chart. 

Values
(Data
series)

Category

CalYear/Month No. Order Items

01.2001 69

02.2001 65

03.2001 81

04.2001 67

05.2001 83

06.2001 80

07.2001 80

08.2001 22

09.2001 102

10.2001 114

11.2001 120

12.2001 98
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Line Chart 
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Profile Chart 
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Example of a Radar Chart 
The following graphic shows a data provider that is used as the basis for a radar chart. 
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CalYear/Month\Sales Organization Frankfurt Munich

JAN 2001 $ 353,505.57 $ 2,043,054.25

FEB 2001 $ 353,505.57 $ 681,884.52

MAR 2001 $ 1,445,213.95 $ 595,241.00
APR 2001 $ 74,513.43 $ 595,241.00

MAY 2001 $ 590,042.39 $ 577,912.29

JUN 2001 $272,927.09 $ 713,942.62

JUL 2001 $ 368,234.97 $ 1,262,396.12

AUG 2001 $ 242,601.86 $ 238,269.69

SEP 2001 $ 1,292,721.35 $ 1,262,396.12

OCT 2001 $ 454,661.88 $ 1,054,451.67

NOV 2001 $ 230,904.99 $ 1,232,937.32

DEC 2001 $ 76,246.30 $ 1,143,477.88

Category

Values
(Data
series)

 
Below you see a radar chart that is based on the data provider.  

Frankfurt Munich

JAN 2001

FEB 2001

MAR 2001

APR 2001

MAY 2001

JUN 2001

JUL 2001

AUG 2001

SEP 2001

OCT 2001

NOV 2001

DEC 2001

 

Example for Surfaces 
The following graphic shows a data provider that is used as the basis for a surface. 
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Category

Values
(Data
series)

CalYear/Month\
Ordering Party

Becker
AG

Booktree
Inc.

Bush
Disribution

Calorado
Inc.

01.2001 210 ST 520 ST 640 ST 510 ST

02.2001 210 ST 1020 ST 640 ST

03.2001 610 ST 220 ST 1240 ST 1010 ST

04.2001 610 ST 620 ST 1040 ST 1010 ST

05.2001 1120 ST 620 ST 830 ST 1010 ST

06.2001 1230 ST 520 ST 1130 ST 510 ST

07.2001 1230 ST 520 ST 730 ST 510 ST

09.2001 1520 ST 20 ST 1130 ST 510 ST

10.2001 1520 ST 20 ST 830 ST 510 ST

11.2001 1520 ST 20 ST 1730 ST 510 ST

12.2001 1020 ST 20 ST 1350 ST 510 ST

 
Below you see a surface chart that is based on the data provider.  
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Example of a Tachometer 
The following graphic shows a data provider with one data column that only contains one value. This value 
results in the pointer. 
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Pointer

Sales Organization Fulfillment Rate %

New York 95%

 
Below you see a tachometer that is based on the data provider.  

Fulfillment Rate %  
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 Editing Chart Types of Class 2 
Chart Types 
Class 2 includes the XY scatter, step and histogram chart types. 

Structure of the Data Provider 
You build the underlying table of a chart type of class 2 as follows: 

• The first data column contains the values to be entered on the X axis. 

• The remaining data columns are assigned the Y values. These data columns are converted into data 
series. The number of data series in the chart is thus computed from the total number of data columns 
minus 1. 

The X value of a data point is always defined by the first data column. The Y value of a data point is 
defined in one of the remaining data columns, depending on the data series to which the data point 
belongs. 

Example for XY Scatter Chart 
The following graphic shows a data provider that is used as the basis for an XY scatter chart. 

X values

DUNS US 1987 Sic Cod Penetration % Potential Sales Sales

ODB87SIC1 9.75 % $ 62,264,964.20 $ 68,995,325.63

A 7.23 % $ 1,174,812.94 $ 1,266,360.63

B 6.82 % $ 47,301.42 $ 50,762.50

C 8.49 % $ 5,342,923.87 $ 5,838,424.38

D 8.14 % $ 6,462,629.13 $ 7,035,273.13

E 8.53 % $ 2,645,798.36 $ 2,892,398.13

F 8.22 % $ 4,597,710.86 $ 5,009,276.25

G 9.84 % $ 15,111,527.82 $ 16,760,058.13

H 8.65 % $ 2,842,611.88 $ 3,111,659.38

I 12.22 % $ 23,243,258.36 $ 26,478,784.38

J 10.39 % $ 494,921.35 $ 552.328,75

Y values

 
Below you see an XY scatter chart that is based on the data provider.  
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 Editing Chart Types of Class 3 
Chart Types 
The portfolio and quadrant chart types have class 3. 

Structure of the Data Provider for a Portfolio 
You build the underlying table for a portfolio as follows: 

• The first data column contains the values to be entered on the X axis. 

• The second data column contains the values to be entered on the Y axis. 

• The third data column is relevant for the bubble size. 

• You can add further pairs of data columns to the table. The first data column of a pair always contains 
the Y values and the second data column the bubble size. 

The X value of a data point is always defined from the first data column. The Y value of a data point is 
defined from the second, fourth, etc. data column, depending on the data column to which the data point 
belongs. The X and Y values together give you the center of the bubble. 

Structure of the Data Provider for a Quadrant 
A quadrant simply relates two data points to each other. The first data point is displayed as a cross. The 
second data point is displayed as a point and arranged with respect to the cross. Since only two data 
points are required, the underlying table should only have two rows. 

• The first data column contains the values to be entered on the X axis. 

• The second data column contains the values to be entered on the Y axis. 

 
If the table contains more than two rows, the additional rows are ignored when the table is 
converted into a chart. 

Portfolio Example 
The following graphic shows a data provider that is used as the basis for a portfolio. 
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X values

DUNS US 1987 Sic Cod Penetration % Potential Sales Sales

ODB87SIC1 9.75 % $ 62.264.964,20 $ 68.995.325,63

A 7.23 % $ 1,174,812.94 $ 1,266,360.63

B 6.82 % $ 47,301.42 $ 50,762.50

C 8.49 % $ 5,342,923.87 $ 5,838,424.38

D 8.14 % $ 6,462,629.13 $ 7,035,273.13

E 8.53 % $ 2,645,798.36 $ 2,892,398.13

F 8.22 % $ 4,597,710.86 $ 5,009,276.25

G 9.84 % $ 15,111,527.82 $ 16,760,058.13

H 8.65 % $ 2,842,611.88 $ 3,111,659.38

I 12.22 % $ 23,243,258.36 $ 26,478,784.38

J 10.39 % $ 494,921.35 $ 552,328.75

Y values Bubble size

 
Below you see a portfolio that is based on the data provider.  
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 Changing the Chart Type 
Use 
A chart is normally displayed as a bar chart. You can change the chart type [Seite 61] for the entire chart.  

You can also combine multiple chart types in the same chart by changing the chart type of a single data 
series. For example you can display the planned turnover of several subsidiaries and show the average 
current turnover as a line. 

Procedure 
Changing the Chart Type of an Entire Chart 
1. Click on the chart with the right mouse key. 

2. In the context menu choose Chart Type. 

This brings you to the Chart Options dialog box. 

 
The field Assign to all data rows is selected and inactive. This shows you that the chart type is 
changed for the entire chart and not only for a single data series. 

3. First select the type and then the required subtype. 

4. Choose OK. 

Changing the Chart Type of a Single Data Series 
1. Click with the right mouse key on the data series whose chart type you want to change. 

2. In the context menu choose Chart Type. 

This brings you to the Chart Options dialog box. 

3. First select the chart type and then the required subtype. 

 
If you mark the field Assign to all data rows, the chart type is changed for the entire chart, 
even if you only marked a single data series. 

4. Choose OK. 
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 Axes and Gridlines 
Definition 
Most of the chart types have two axes: a value axis and a category axis. With most chart types, the values 
of a data series are plotted along the value axis and the categories along the category axis. Normally the 
value axis corresponds to the Y axis and the category axis to the X axis. 

Three-dimensional chart types such as cone and pyramid charts also have a third (Z) axis. 

Gridlines are vertical and horizontal lines that divide up the plotting area. They improve the readability of 
the individual chart values. 

Use 
The properties that you can define for axes are listed below. The properties that you can define depend on 
the chart type you selected. 

• Showing and Hiding Axes [Seite 79] 

• Changing the Position of the Tick Marks [Seite 80] 

• Changing the Scale [Seite 81] 

• Changing the Point of Intersection of Axes [Seite 82] 

• Reversing the Order of Categories and Values [Seite 84] 

• Formatting Axes and Axis Labels [Seite 85] 

You can only use the following functions for value axes: 

• Changing the Start and End Points of a Value Axis [Seite 86] 

• Changing the Value Axis Intervals [Seite 87] 

• Adding a Value Range [Seite 89] 

• Formatting a Value Range [Seite 90] 

• Formatting the Value Range Title [Seite 91] 

• Changing the Title and Values of a Value Range [Seite 92] 

You can change the minor tick mark and tick mark label intervals  [Seite 88] for category axes.  

You can choose from the following functions for gridlines: 

• Showing and Hiding Gridlines [Seite 94] 

• Editing Gridlines [Seite 95] 
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 Showing and Hiding Axes 
Use 
You can decide whether to display axes in a chart and which axes should be displayed. 

 
Pie charts and doughnuts do not have axes. 

Procedure 
1. Click with the right mouse key on any area of the chart. 

2. In the context menu, choose Chart Options. 

This brings you to the dialog box with the same name. 

3. Choose tabstrip Axes. 

4. Select the axes you want to show. Deselect the axes you want to hide. 

Primary axis describes the normal axis in the coordinate system and Secondary axis describes 
the opposite axis. 

5. Choose OK. 
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 Changing the Position of the Tick Marks 
Use 
You can show or hide tick marks for the axes. You can also define if the tick marks should be displayed 
outside, inside or on both sides of the axes. You can define these settings separately for the major and 
minor tick marks. Minor tick marks are a subdivision of the major tick marks. 

You can make all the settings separately for each axis. 

Prerequisites 
The axis to be changed is displayed. See Showing and Hiding Axes [Seite 79]. 

Procedure 
1. Click with the right mouse key on the axis you want to change. 

2. In the context menu choose Format Axis. 

This brings you to the dialog box with the same name. 

3. Choose tabstrip Line. 

4. Define the Major tick mark type and Minor tick mark type. 

• None: Do not show any tick marks 

• Outside: Show tick marks outside the axis 

• Inside: Show tick marks inside the axis 

• Cross: Show tick marks both outside and inside the axis 

5. Choose OK. 
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 Changing the Scale 
Use 
You can choose one of the following scales when you use value axes: 

• Linear 

• Logarithmic 

 
You can only change the scale for value axes, but not for category axes. It does not matter if 
the X axis or the Y axis is the value axis. 

The time scale type is not relevant in Web Publishing. 

Prerequisites 
The axis to be changed is a value axis. 

Procedure 
1. Click with the right mouse key on the value axis you want to change. 

2. In the context menu choose Format Axis. 

This brings you to the dialog box with the same name. 

3. Choose tabstrip Scale. 

4. In the Type field choose the required type of scale. 

5. Choose OK. 
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 Changing the Point of Intersection of Axes 
Use 
You can change the point where the axes cross in a chart. You can also define if the point of intersection 
should always lie between categories or on a category. 

Procedure 
Changing the Point of Intersection for the Category Axis 
1. Click with the right mouse key on the category axis (normally the X axis). 

2. In the context menu choose Format Axis. 

This brings you to the dialog box with the same name. 

3. Choose tabstrip Scale. 

4. Enter the desired setting. Your setting moves the position of the value axis (normally the Y axis) in the 
chart: 

• If you want the point of intersection to lie on a certain category, select Custom in the Value axis 
crosses at list and enter the number of the category. 

• If you want to move the value axis to the right border of the chart, select Maximum in the Value axis 
crosses at list. 

• If you want to move the value axis to the right border of the chart, select Maximum in the Value axis 
crosses at list. 

• To compute the point of intersection automatically, select Automatic in the Value axis crosses at list. 

5. Choose OK. 

Positioning a Point of Intersection on a Category or between Categories 
The point of intersection for value axes and category axes lies between the categories by default. 
However, you can also define that the point of intersection should lie exactly on a category. 

1. Click with the right mouse key on the category axis (normally the X axis). 

2. In the context menu choose Format Axis. 

This brings you to the dialog box with the same name. 

3. Choose tabstrip Scale. 

4. Choose the setting you want to use. 

• If you want the point of intersection of the value axis and the category axis to lie between the 
categories, select the Value axis crosses between categories field. With this setting, the major tick 
marks of the category axis are displayed between the categories. 

• If you want the point of intersection to lie exactly on a category, deselect this field. With this setting, 
the major tick marks of the category axis are displayed directly below the categories. 

5. Choose OK. 

Changing the Point of Intersection for the Value Axis 
1. Click with the right mouse key on the value axis (normally the Y axis). 

2. In the context menu choose Format Axis. 
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This brings you to the dialog box with the same name. 

3. Choose tabstrip Scale. 

4. Enter the desired setting. Your setting moves the position of the category axis (normally the X axis) in 
the chart: 

• If you want the point of intersection with the category axis to lie at a certain value, select Custom in 
the Category axis crosses at list and enter the desired value. 

• If you want to move the category axis to the upper border of the chart, select Maximum in the 
Category axis crosses at list. 

• To move the category axis back to the lower border of the chart, select Minimum in the Category axis 
crosses at list. 

• To calculate the point of intersection automatically, select Category axis crosses at. 

5. Choose OK. 

 

 

 

Web Application Design: BEx Web Application Designer 30B
 83 



SAP Online Help  13.05.2002 

 Reversing the Order of Categories and Values 
Use 
You can reverse the order of the categories and the values in most of the chart types. This is not possible 
for radar charts. 

Procedure 
1. Click with the right mouse key on the axis you want to change. 

2. In the context menu choose Format Axis. 

This brings you to the dialog box with the same name. 

3. Choose tabstrip Scale. 

4. Select the appropriate field for the axis. 

• To reverse the order of the categories on the category axis, select field Categories in reverse order. 

• To reverse the order of the values on the value axis, select field Values in reverse order. 

5. Choose OK. 
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 Formatting Axes and Axis Labels 
Use 
You can format the line of each axis individually. 

You can also change the formatting of the axis labeling for each axis. You can also change the font 
properties and alignment of the axis labeling. You can define the format of the numbers that are displayed 
in the axis label. For example, you can select a percentile display or display the values with their currency. 
You can also display numbers with decimal places. 

Procedure 
1. Click with the right mouse key on the axis whose line or axis label you want to change. 

2. In the context menu choose Format Axis. 

This brings you to the dialog box with the same name. 

3. Make the changes described below and choose OK. 

Changing Lines 
1. Choose tabstrip Line. 

2. Select the required formatting for the type of line, the color and the axis width. 

Changing Font Properties 
1. Choose tabstrip Font. 

2. Select the required font properties for the axis label: font name, style (bold, italic, etc.), the size in 
points and the color. 

Changing the Number Format 
1. Choose tabstrip Number. 

2. In field Category choose the required category, e.g. Date for date formats. 

3. In field Number formats choose the required format within the category. 

4. If you are not yet satisfied with the format, you can change it directly in field Number format. 

Changing the Alignment 
1. Choose tabstrip Alignment. 

2. Select the required arrangement of the axis label, e.g. from left to right, from top to bottom or rotated 
by 90 degrees. 
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 Changing the Start and End Points of a Value Axis 
Use 
You can determine the start and end points of a value axis automatically or define them manually.  

Prerequisites 
The axis to be formatted is a value axis and not a category axis. 

Procedure 
1. Click with the right mouse key on the value axis (normally the Y axis). 

2. In the context menu choose Format Axis. 

This brings you to the dialog box with the same name. 

3. Choose tabstrip Scale. 

4. Make the changes described below and choose OK. 

Defining the Start and End Points Automatically 
1. To define the start point automatically, select field Minimum in column Auto. 

2. To define the end point automatically, select field Maximum in column Auto. 

Changing the Start and End Points Manually 
1. Deselect field Minimum or Maximum in column Auto. 

2. Enter the required value in field Minimum or Maximum. 
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 Changing the Value Axis Interval 
Use 
You can change the interval for the value axes, that is define the interval for the tick marks. You can 
change these values separately for the major and minor tick marks. 

Prerequisites 
The axis to be formatted is a value axis with a linear or logarithmic scale. See Changing the Scale [Seite 
81]. 

Procedure 
1. Click with the right mouse key on the value axis (normally the Y axis). 

2. In the context menu choose Format Axis. 

This brings you to the dialog box with the same name. 

3. Choose tabstrip Scale. 

4. Make the changes described below and choose OK. 

Changing the Interval Manually 
1. Deselect field Major unit for the major tick marks or Minor unit for the minor tick marks. 

2. Enter the interval you want in fields Major unit or Minor unit. 

 
You can only see the change if the major tick marks or minor tick marks are displayed. See 
Changing the Position of the Tick Marks [Seite 80]. 

Defining the Interval Automatically 
Select field Major unit for the major tick marks or Minor unit for the minor tick marks. 
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 Changing Minor Tick Mark and Minor Tick Mark Label 
Intervals 
Use 
Every category on the category axis is labeled and is separated from the other categories with tick marks 
(major tick marks). 

You can define the intervals in which the category axes should be labeled. Normally every category is 
labeled, but you can for example label only every second or third category. 

You can also define that more than one category should be displayed between the tick marks so that the 
category axis has fewer tick marks. Normally exactly one category is displayed between two tick marks 
(major tick marks) on the category axis.  

Procedure 
1. Click with the right mouse key on the category axis (normally the X axis). 

2. In the context menu choose Format Axis. 

This brings you to the dialog box with the same name. 

3. Choose tabstrip Scale. 

4. To change the distance between the labels, enter the appropriate value in field Number of categories 
between tick mark labels. Enter 1 to label each category, enter 2 to label every second category, and 
so on. 

5. To change the distance between the tick marks, enter how many categories there should be between 
two tick marks in field Number of categories between tick marks. 

6. Choose OK. 
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 Adding a Value Range 
Use 
You can define a value range that should be highlighted in the chart. You can define a minimum, optimum 
and maximum value within the value range. These values are displayed in the chart with a line and can be 
assigned a title. 

Prerequisites 
The axis to which the value range belongs is a value axis and is displayed in the chart. See Showing and 
Hiding Axes [Seite 79]. 

Procedure 
1. Click with the right mouse key on the value axis (normally the Y axis). 

2. In the context menu choose Add Value Range. 

You go to the Format Value Range dialog box. 

3. Repeat the following steps for all the values (minimum, optimum, maximum) you want to mark in the 
chart: 

4. Enter a title for the relevant value. 

5. Define where the value should lie: 

• If you want the position of the value to be defined automatically, select Automatic. 

• If you want to predefine a value, select the Value field and enter the minimum, optimum or maximum 
value. 

• If you do not want to mark a value in the chart, select the Invisible field for the corresponding value. 

6. Choose OK. 
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 Formatting Value Ranges 
Use 
Every value range can have a minimum, optimum and maximum value. You can format the lines that 
represent these values. You can also define a filling for the entire value range. 

Prerequisites 
You already added a value range. See Adding a Value Range [Seite 89]. 

Procedure 
Click with the right mouse key on the upper or lower border of the value range you want to format. 

1. In the context menu choose Format Value Range. 

This brings you to the dialog box with the same name. 

2. Make the changes described below and choose OK. 

Changing the Filling and Border 
1. Choose tabstrip Pattern. 

2. Select the formatting for the filling and for the upper and lower borders of the value range. See 
Changing the Filling and Borders of Surfaces [Seite 55].  

The upper border normally corresponds to the maximum value of the value range and the lower 
border corresponds to the minimum value. 

Changing Lines 
1. Choose tabstrip Line. 

2. Select the required formatting for the type of line and the color of the line within a value range. 

 
This setting only refers to the line within a value range. This is normally the line for the 
optimum value. The upper and lower lines of the value range can be formatted with the 
Pattern tabstrip. 
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 Formatting the Value Range Title 
Use 
Every value range can have a minimum, optimum and maximum value. You can format the titles for these 
values individually. 

Prerequisites 
You already added a value range and defined titles for the values. See Adding Value Ranges [Seite 89]. 

Procedure 
1. Click with the right mouse key on the title of the value you want to format. 

2. In the context menu choose Format Value Range Title. 

This brings you to the dialog box with the same name. 

3. Make the changes described below and choose OK. 

 
You can change the titles of all the values of the current value range with tabstrip Value 
Range. However, all formatting selected in the other tabstrips only refer to the title you 
selected before calling the dialog box. 

Changing the Filling and Border 
1. Choose tabstrip Pattern. 

2. Choose the required formatting for the filling and for the border of the box surrounding the title. See 
Changing the Filling and Border of Surfaces [Seite 55]. 

Changing Font Properties 
1. Choose tabstrip Font. 

2. Select the required font properties for the title: font name, style (bold, italic, etc.), the size in points and 
the color. 

Changing the Alignment 
1. Choose tabstrip Alignment. 

2. Select the required arrangement of the title, e.g. from left to right, from top to bottom or rotated by 90 
degrees. 
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 Changing the Title and Values of a Value Range 
Use 
You can change a value range after defining it. The minimum, optimum and maximum values can be 
changed as well as the relevant titles for these values. 

Prerequisites 
You already added a value range. See Adding a Value Range [Seite 89]. 

Procedure 
Changing the Values of the Value Range from a Dialog Box 
1. Click with the right mouse key on the upper or lower border of the value range you want to change. 

2. In the context menu choose Format Value Range. 

This brings you to the dialog box with the same name. 

3. Choose tabstrip Value Range. 

4. Enter the new value. 

5. Choose OK. 

Changing Values of the Value Range Directly in the Chart 
If you entered the values yourself when you added the value range, you can change the values directly in 
the chart. If you defined the values automatically, you can only change them from the Format Value 
Range dialog box.  

To change the values directly in the chart: 

1. Click on the upper or lower border of the value range. 

The value range is selected. 

2. Point to the line representing the value to be changed. 

The cursor becomes a double arrow. 

3. Click on the line and keep the mouse key pressed. 

4. Pull the line to the required value and let go of the mouse key. 

Changing Titles of Values 
1. Click on one of the titles in the value range with the right mouse key. 

2. In the context menu choose Format Value Range Title. 

3. This brings you to the dialog box with the same name. 

4. Choose tabstrip Value Range. 

5. Enter the new title. 

 
You can change the titles of all the values of the current value range with tabstrip Value 
Range. However, all formatting selected in the other tabstrips only refer to the title you 
selected before calling the dialog box. 
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6. Choose OK. 
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 Showing and Hiding Grid Lines 
Use 
You can make it easier to read values by displaying major and minor gridlines for both the X and Y axes. 
You can also define the axes (main axis, secondary axis) for which the grid lines should be displayed. 

Prerequisites 
The chart is neither a pie chart nor a doughnut. 

Procedure 
1. Click with the right mouse key on any area of the chart. 

2. In the context menu, choose Chart Options. 

This brings you to the dialog box with the same name. 

3. Choose tabstrip Gridlines. 

4. Select the Major gridlines and Minor gridlines you want to display. 

5. Deselect the gridlines you want to hide. 

6. Choose OK. 
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 Editing Gridlines 
Use 
You can format the type of line, color and width of the gridlines individually. You can define these 
properties separately for each type of gridline, for example you can format the major gridlines of the X axis 
differently from those of the Y axis. 

For the gridlines you can also change the scaling of all the properties that you can change for the axes. 
Which properties these are depends on whether you are editing gridlines of the category axis or of the 
value axis. 

Procedure 
1. Click with the right mouse key on the gridlines you want to format, for example the major gridlines of 

the X axis. 

2. In the context menu choose Format Gridlines. 

This brings you to the dialog box with the same name. 

3. Make the changes described below and choose OK. 

Changing Lines 
1. Choose tabstrip Line. 

2. Select the required formatting for the type of line, the color and the gridline width. 

Changing Other Properties 
1. Choose tabstrip Scale. 

2. Make the required changes. 

 
Gridlines always has the same scaling properties as the corresponding axis. All the changes 
you make in tabstrip Scale therefore directly affect the corresponding axis. For example, if you 
change the interval of the minor gridlines for the value axis, the interval of the value axis is 
also changed appropriately.  

 

 

 

Web Application Design: BEx Web Application Designer 30B
 95 



SAP Online Help  13.05.2002 

 Data Series and Data Points 
Definition 
A data series consists of related data points. Each data series is uniquely identified by its own color or 
pattern. In a pie chart, only one data series is displayed. In other chart types you can display more than 
one data series. 

A data point is a single element of a data series. For example, a data point is displayed by a slice of a pie, 
a point or a bar. 

Use 
You have a number of formatting options for data series and data points. Note that the preview window 
only shows sample data. You only see the actual data once it has been published. 

You should change the preview window settings so that the number of data series and data points 
correspond to the data provider. You can then change the formatting of individual data series. For chart 
types of class 1, the uppermost data series in the legend corresponds to the first table row, the next data 
series corresponds to the second table row, etc. 

You can edit data series as follows: 

• Plotting a Data Series to a Secondary Axis [Seite 98] 

• Formatting Data Series [Seite 99] 

• Smoothing Lines [Seite 101] 

• Adding, Changing and Removing Trendlines [Seite 102] 

• Formatting Trendline Equations [Seite 104] 

• Adding and Removing Error Bars [Seite 105] 

• Editing Error Bars [Seite 107] 

The following functions are only available for pie charts and ring charts: 

• Rotating Pie and Ring Charts [Seite 113] 

• Deactivating the Color Change for a Pie or Ring Chart  [Seite 114] 

• Changing the Ring Width [Seite 115] 

The following functions are only available for histograms: 

• Adding and Removing Normal Distributions [Seite 108] 

• Editing a Normal Distribution [Seite 109] 

• Formatting the Title of a Normal Distribution [Seite 110] 

The following functions are only available for tachometers: 

• Formatting the Tachometer Needle Label [Seite 111] 

• Changing the Value Range of a Tachometer [Seite 112] 

The following functions refer to 3D charts: 

• Changing the Depth of 3D Charts [Seite 116] 

• Formatting Walls and Floors [Seite 117] 
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In a portfolio or quadrant chart you can change the position of the quadrants [Seite 118]. If required, you 
can add drop lines [Seite 119] to a surface, profile or line chart. 

You can edit the data points of a data series as follows: 

• Formatting Data Points [Seite 120] 

• Changing the Distance between Groups of Data Points [Seite 121] 

• Changing the Overlapping of Data Points [Seite 122] 
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 Plotting a Data Series to a Secondary Axis 
Use 
If the value ranges of data series vary considerably or if mixed data types are used, you can plot one or 
more data series to a secondary axis (Y axis). For example, you can plot the number of houses sold on 
the left Y axis (main axis) and the average price on the right Y axis (secondary axis). 

Procedure 
1. Click with the right mouse key on the data series for which you want to plot a secondary axis. 

2. In the context menu choose Format Data Series. 

This brings you to the dialog box with the same name. 

3. Choose tabstrip Axes. 

4. Select option Secondary axis. 

5. Choose OK. 
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 Formatting Data Series 
Use 
You can format each data series in a chart individually. Data series are displayed as lines, as surfaces or, 
in the case of a tachometer, as tachometer needles, depending on the chart type. The options available 
depend on how the data series is displayed.  

Procedure 
1. Click with the right mouse key on the data series you want to format. 

2. In the context menu choose Format Data Series. 

 
You can also select the data series to be formatted in context menu Format Data Series and 
in the submenu. 

This brings you to the dialog box with the same name. Depending on the chart type, tabstrip 
Pattern, Line or Pointer is displayed. 

3. Make the changes described below and choose OK. 

Changing Surfaces 
1. If the data series is to be displayed as a surface (e.g. for bar or pie charts),choose tabstrip Pattern. 

2. Select the formatting for the filling and for the border of the surfaces. See Changing the Filling and 
Borders of Surfaces [Seite 55]. 

Changing Lines 
1. If you want to display the data series as a line (e.g. for line charts or radar charts), choose tabstrip 

Line. 

2. Select the required formatting for the type of line, the color and the line width. 

3. With Marker you can also define the symbol with which the individual data points should be displayed 
and how the symbol should be formatted. 

• If you want to copy the default formatting, choose Automatic. 

• If you do not want to mark the data points, choose None. 

• If you want to set up your own formatting, choose Custom. In the Style list, choose the symbol to be 
used to display the data points. If required, change the colors of the symbol and define the size of the 
symbol in field Size. 

Changing the Tachometer Needle 
1. For a tachometer, choose tabstrip Pointer. 

2. Under Line select the required formatting for the tachometer needle. You can define the type of line, 
color and breadth of the tachometer needle. You can also give the tachometer needle an arrowhead 
and define its size. 

3. With Marker you can also define the symbol to be displayed on the tachometer needle and how the 
symbol should be formatted. 

• If you want to copy the default formatting, choose Automatic. 

• If you do not want to display a symbol, choose None. 
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• If you want to set up your own formatting, choose Custom. In the Style list, choose the symbol to be 
displayed on the tachometer needle. If required, change the colors of the symbol and define the size 
of the symbol in field Size. 

4. If you want to label the tachometer needle, select the Label field under Pointer Label and enter the 
text. 
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 Smoothing Lines 
Use 
For data series that have the form of a line (for example in line or profile charts), an interpolated curve is 
drawn between related data points. You can smooth the curve if necessary. This does not change the 
underlying data. 

Prerequisites 
The chart to be formatted is a line chart, radar chart, profile chart or point chart. 

Procedure 
1. Click with the right mouse key on the data series you want to format. 

2. In the context menu choose Format Data Series. 

This brings you to the dialog box with the same name. 

3. Choose tabstrip Line. 

4. Select Smooth. 

5. Choose OK. 
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 Adding, Changing and Removing Trendlines 
Use 
You can visualize the trend of a data series using a trendline for a number of chart types. You can also 
extend the trendline past the data series in the chart in order to forecast future values and derive past 
values. There are the following types of trendlines: 

• Linear: A linear trendline is an optimized straight line that is suitable for linear datasets. A dataset is 
linear if the pattern of data points resembles a line. A linear trendline normally displays a constant 
increase or decrease in values. 

• Logarithmic: A logarithmic trendline is an optimized curve that is ideal if the rate of changes to the 
data first increases or decreases sharply and then stays nearly the same. A logarithmic trendline can 
use negative and/or positive values. 

• Potential: A potential trendline is a curve. It should be used for datasets that compare measurements 
that increase with a certain rate (for example, the acceleration of a racing car in 1 second intervals). 
You cannot add a potential trendline if your data contains null or negative values. 

• Exponential: An exponential trendline is a curve that is suitable for data values that increase or 
decrease with an increasing tendency. You cannot add an exponential trendline if your data contains 
null or negative values. 

• Floating average: The floating average smoothes out data fluctuations and therefore can show a trend 
or pattern more clearly. The floating average consists of a series of averages that are computed from 
elements of the data series. A floating average uses a certain number of data points, computes there 
mean value and then uses this mean value as a point in the curve. 

You can change all the properties of a trendline that you can define when you add the trendline. You can 
delete a trendline that you do not need. 

Prerequisites 
The chart is a two-dimensional bar, surface, line, portfolio, profile, point or column diagram or a histogram. 

Procedure 
Adding Trendlines 
1. Click with the right mouse key on the data series for which you want to compute the trend. 

2. In the context menu choose Add Trendline. 

The Format Trendline dialog box appears. 

3. On the Trendline tabstrip, choose the type of trend you require.  

4. The type of trendline and the name of the data series is displayed as legend text in the legend. If you 
want to use a different legend text, deselect field Trendline name Automatic and enter the required 
text. 

5. Not for floating average: The trendline can also display past and future developments. Enter how far in 
the future (field Forward) and past (field Backward) the trendline should be displayed. 

6. Not for floating average: If you want to display the equation on which the trendline is based in the 
chart, select field Display equation on chart. 

7. Only for floating average: Enter the number of data points to be used to compute the average value in 
field Periods. The average values are then used as points of the trendline. 

8. If you want to change the line type and color of the line, choose the required options on tabstrip Line. 
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9. Choose OK. 

Changing Trendlines 
1. Click with the right mouse key on the trendline you want to change. 

2. In the context menu choose Format Trendline. 

3. Change the properties and choose OK. 

Removing Trendlines 
1. Click on the trendline you want to remove. 

2. Press <Del>. 

 
You can also remove trendlines by clicking on the trendline with the right mouse key and 
choosing Delete in the context menu.  
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 Formatting Trendline Equations 
Use 
When you add a trendline, you can decide if the equation on which the trendline is based should be 
displayed in the chart. If you display the equation, you can change the formatting of the equation. 

Prerequisites 
You added a trendline and defined that the equation should be displayed in the chart. 

Procedure 
1. Click with the right mouse key on the equation you want to format. 

2. In the context menu choose Format Trendline Label. 

This brings you to the dialog box with the same name. 

3. Make the changes described below and choose OK. 

Changing the Filling and Border 
1. Choose tabstrip Pattern. 

2. Choose the required formatting for the filling and for the border of the box surrounding the equation. 
See Changing the Filling and Border of Surfaces [Seite 55]. 

Changing Font Properties 
1. Choose tabstrip Font. 

2. Select the required font properties for the equation: font name, style (bold, italic, etc.), the size in 
points and the color. 

Changing the Number Format 
1. Choose tabstrip Number. 

2. In field Category choose the required category, e.g. Number for number formats. 

3. In field Number formats choose the required format within the category. 

4. If you are not yet satisfied with the format, you can change it directly in field Number format. 

Changing the Alignment 
1. Choose tabstrip Alignment. 

2. Select the required arrangement of the axis label, e.g. from left to right, from top to bottom or rotated 
by 90 degrees. 
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 Adding and Removing Error Bars 
Use 
Error bars graphically show possible errors or unclear data points. This is particularly relevant for charts 
that show the results of scientific investigations. The selected chart type determines whether or not you 
can add error bars and defines the axis that the error bar refers to. 

You can delete error bars that you do not need. 

Prerequisites 
You can add error bars for either the Y axis or the X axis for bar charts, surface charts, line charts, profile 
charts and vertical bar charts as well as for histograms and tachometers.  This depends on which of the 
two axes is the value axis. 

You can add error bars for both the X axis and the Y axis for portfolio, point, quadrant and step charts. 

Procedure 
Adding Error Bars 
1. Click with the right mouse key on the data series for which you want to add error bars. 

2. In the context menu choose Format Data Series. 

This brings you to the Chart Options dialog box. 

3. Choose tabstrip X Error Bars or Y Error Bars, depending on the chart type and the axis for which you 
want to add the error bars. 

4. Under Display choose whether and in which direction the error bars for the X axis or Y axis should be 
displayed: 

• Plus and minus error bars 

• Only plus error bars 

• Only minus error bars 

• No error bars 

5. Under Error amount choose the method to be used to locate the error. 

• If you want to use a constant error amount, select Fixed value and enter the value. 

• If you want to use a percentile value for the individual data points, select Percentage and enter the 
value. 

• If you want to use a certain number of standard deviations from the mean of the values displayed 
graphically, select Standard deviation and enter the number. 

• If you want to use the standard error, select Standard error. 

• If you want to define the error yourself, select Custom. Enter the deviation up and down in the fields + 
and – . 

6. Choose OK. 

Removing Error Bars 
1. Click with the right mouse key on the error bars of the data series you want to delete. 

2. Press <Del>. 
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 Editing Error Bars 
Use 
You can format the error bars of a data series individually. You can also change all the properties you 
defined when you added error bars. 

Prerequisites 
You already added error bars to a data series. 

Procedure 
1. Click with the right mouse key on the error bars of the data series that you want to format or change. 

2. In the context menu choose Format Error Bars. 

This brings you to the Chart Options dialog box. 

3. Make the changes described below and choose OK. 

Formatting Error Bars 
1. Choose tabstrip Line. 

2. Under Line choose the required formatting for the type and color of the line. 

3. Under Marker define whether the error bars should be displayed delimited with lines or without lines. 

Changing Error Bars 
1. Choose tabstrip X Error Bars or Y Error Bars, depending on the chart type and the axis for which you 

want to change the error bars. 

2. Change the properties as required. You have the same options as for adding error bars, see Adding 
and Removing Error Bars [Seite 105]. 
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 Adding and Removing Normal Distributions 
Use 
If you assign chart type Histogram, you can select a subtype that automatically displays the normal 
distribution for each data series. You can also add normal distributions afterwards. 

You can delete a normal distribution that you do not need. 

Prerequisites 
The chart is a histogram. 

Procedure 
Adding a Normal Distribution 
1. Click with the right mouse key on the data series for which you want to display the normal distribution. 

2. In the context menu choose Add Normal Distribution. 

The normal distribution is displayed in the chart. You can also change the properties of the normal 
distribution if needed. See Editing the Normal Distribution [Seite 109]. 

Removing the Normal Distribution 
1. Click on the normal distribution you want to remove. 

2. Press <Del>. 

 
You can also remove a normal distribution by clicking on it with the right mouse key and 
choosing Delete in the context menu.  
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 Editing a Normal Distribution 
Use 
You can edit every normal distribution that is displayed for a data series in a histogram. You can define 
the mean value and standard deviation. You can also define a title for the normal distribution and format 
the curve. 

Prerequisites 
The chart is a histogram. Either you selected a subtype that automatically also displays normal 
distributions or you added normal distributions afterwards. 

Procedure 
1. Click with the right mouse key on the normal distribution you want to edit. 

2. In the context menu choose Format Normal Distribution. 

This brings you to the dialog box with the same name. 

3. Make the changes described below and choose OK. 

Changing the Mean Value 
1. Choose tabstrip Normal Distribution. 

2. Enter the new mean value. 

Changing the Standard Deviation 
1. Choose tabstrip Normal Distribution. 

2. Enter the new standard deviation. 

Displaying Titles in Charts 
1. Choose tabstrip Normal Distribution. 

2. Select field Display name on chart if you also want to display the title displayed in field Distribution 
name in the chart. 

Changing Titles 
1. Choose tabstrip Normal Distribution. 

2. Deselect field Automatic. 

3. Change the title in field Distribution name. 

Formatting Curves 
1. Choose tabstrip Pattern. 

2. Select the formatting for the filling and border of the curve. See Changing the Filling and Borders of 
Surfaces [Seite 55]. 
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 Formatting the Title of a Normal Distribution 
Use 
If the title of a normal distribution is displayed in the chart, you can format the font properties and title 
alignment individually. 

Prerequisites 
You assigned chart type histogram and selected a subtype that also displays the normal distribution. You 
also defined that the title of the normal distribution should be displayed in the chart. 

Procedure 
1. Click with the right mouse key on the title of the normal distribution you want to format. 

2. In the context menu choose Format Normal Distribution Label. 

This brings you to the Chart Options dialog box. 

3. Make the changes described below and choose OK. 

Changing Font Properties 
1. Choose tabstrip Font. 

2. Select the required font properties for the title: font name, style (bold, italic, etc.), the size in points and 
the color. 

Changing the Alignment 
1. Choose tabstrip Alignment. 

2. Select the required arrangement of the title, e.g. from left to right, from top to bottom or rotated by 90 
degrees. 
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 Formatting the Tachometer Needle Label 
Use 
If you defined that a tachometer should have a tachometer needle label, you can format the label 
individually. 

Prerequisites 
You assigned the tachometer needle a label with the Format Data Series [Seite 99] function. 

Procedure 
1. Click with the right mouse key on the label you want to format. 

2. In the context menu choose Format Pointer Labels. 

This brings you to the dialog box with the same name. 

3. Make the changes described below and choose OK. 

Changing Font Properties 
1. Choose tabstrip Font. 

2. Select the required font properties for the text: font name, style (bold, italic, etc.), the size in points and 
the color. 

Changing the Alignment 
1. Choose tabstrip Alignment. 

2. Select the required arrangement of the text, e.g. from left to right, from top to bottom or rotated by 90 
degrees. 
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 Changing the Value Range of a Tachometer 
Use 
A tachometer is normally divided into several value ranges that are displayed in different colors. You can 
change the start and end of a value range as well as its color. 

Procedure 
1. Click with the right mouse key on the value range you want to change. 

2. In the context menu choose Format Value Range. 

This brings you to the Chart Options dialog box. 

3. Enter the start and end for the value range in fields From and To.  

4. Select a color for the value range. 

5. Choose OK. 
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 Rotating Pie and Ring Charts 
Use 
You can change the angle of the first segment of a pie or ring chart, thus rotating the entire pie or ring 
charts. 

Prerequisites 
The chart is a pie or ring chart.  

Procedure 
1. Click with the right mouse key on the pie or on one of the rings of the ring chart. 

2. In the context menu choose Format Data Series. 

This brings you to the dialog box with the same name. 

3. Choose tabstrip Options. 

4. In field Angle of first slice, enter the number of degrees by which you want to rotate the pie or rings 
clockwise. 

5. Choose OK. 
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 Deactivating the Color Change for a Pie or Ring  
Use 
In pie charts and ring charts, each data point is normally displayed in a different color. However, you can 
define that all data points of a data series should have the same color. In this case, all the segments of a 
ring chart are displayed in the same color. All the segments of a slice of the ring chart have the same color 
in a pie chart. 

Prerequisites 
The chart is a pie chart or ring chart.  

Procedure 
1. Click with the right mouse key on the pie chart or on a slice of the ring chart. 

2. In the context menu choose Format Data Series. 

This brings you to the dialog box with the same name. 

3. Choose tabstrip Options. 

4. Deselect field Vary colors by point. 

5. Choose OK. 

You can also change the color of the pie chart or doughnut slices. See Formatting Data Series [Seite 99]. 
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 Changing the Ring Width 
Use 
In a ring chart, the data series are arranged in rings around an inner circle. The inner circle does not 
represent a data series. You can define how large the inner circle should be and thus how wide each ring 
should be. The larger the inner circle, the narrower the rings will be displayed. 

Prerequisites 
The chart is a ring chart.  

Procedure 
1. Click on one of the rings with the right mouse key. 

2. In the context menu choose Format Data Series. 

This brings you to the dialog box with the same name. 

3. Choose tabstrip Options. 

4. In the Doughnut hole size field, enter the percentage the inner circle should occupy in relationship to 
the entire chart. You can enter a value between 10 and 90 percent. 

5. Choose OK. 
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 Changing the Depth of 3D Charts 
Use 
You can change the diagram depth of 3D charts with the following options: 

• You can change the depth of the data points, for example the depth of the cone or cylinder.  

• You can change the distance from the data points to the back wall. 

Prerequisites 
The chart is a 3D column, 3D bar, cone, pyramid or cylinder chart. 

Procedure 
1. Click on the row of data with the right mouse key. 

2. In the context menu choose Format Data Series. 

This brings you to the Chart Options dialog box. 

3. Choose tabstrip Options. 

4. To change the depth of the data points, enter the required value in field Chart depth. The larger the 
value, the greater the depth. 

5. To change the gap between the back wall and the data points, enter a value between 0 and 500 in 
field Gap depth. The larger the value, the greater the gap. 

 

 

 

 

Web Application Design: BEx Web Application Designer 30B
 116 



SAP Online Help  13.05.2002 

 Formatting Walls and Floors 
Use 
In a 3D chart, two walls are displayed as the background for the data series and the data series are 
placed on a floor. You can choose any filling and border as well as walls and floor you like. 

Prerequisites 
The chart is a 3D chart, for example a pyramid, cylinder or cone diagram. 

Procedure 
1. Click with the right mouse key on one of the walls or on the floor, depending on which surface you 

want to format. 

 
If you cannot select the floor, you should temporarily hide the axis in front of it. See Showing 
and Hiding Axes [Seite 79]. It is then easier to select the floor. Once you have formatted the 
floor, you can show the axis again. 

2. In the context menu choose Format Walls or Format Floor. 

This brings you to the Chart Options dialog box. 

3. Select the formatting for the filling and border. See Changing the Filling and Borders of Surfaces 
[Seite 55]. 

4. Choose OK. 
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 Changing Quadrants 
Use 

You can change the color of the quadrants and define where the transition between the quadrants should 
be. You can also deactivate display of the quadrants. 

Prerequisites 
The chart is a portfolio or a quadrant. 

Procedure 

2. In the context menu choose Format Plot Area. 

The Format Plot dialog box appears. 

3. Click on the legend with the right mouse key. 

4. Select tabstrip Quadrants. 

6. To change the colors, select under Colors the colors for the Top-Left, Top-Right, Bottom-Left and 
Bottom-Right quadrants. 

In a chart of type portfolio or quadrant, the plot area represents four areas (quadrants): normally a red and 
a green quadrant as well as two yellow quadrants. Normally red symbolizes a negative quadrant, green a 
positive quadrant and yellow a neutral quadrant. The data points are arranged in these quadrants. As a 
result, one can immediately see how the turnover of a subsidiary should be evaluated. 

1. Click with the right mouse key on the plot area, for example on a free area within the X and Y axes. 

5. To change the transition between the quadrants, enter the new values in fields X-Axis and Y-Axis. 

7. If you do not want to display any quadrants, deselect the Visible field. 

8. Choose OK. 
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 Showing and Hiding Drop Lines 
Use 
In surface and line charts you can display drop lines that go from the data point to the X axis. This shows 
you the position of the individual data points, especially in surface charts. 

If you do not want to display drop lines, you can hide them. 

Prerequisites 
The chart is an area, profile or line chart. 

Procedure 
1. Click on the data series with the right mouse key. 

2. In the context menu choose Format Data Series. 

This brings you to the dialog box with the same name. 

3. Choose tabstrip Options. 

4. If you want to display drop lines, select field Drop lines. If you do not want to display drop lines, 
deselect this field. 

5. Choose OK. 
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 Formatting Data Points 
Use 
You can format each data point in a chart individually. The options available depend on the chart type. 

Procedure 
1. Click on the data series to which the data point to be formatted belongs. 

The entire data series is selected. 

2. Click on the data point to be formatted. 

Only the data point is selected. 

3. Click on the data point with the right mouse key. 

4. In the context menu choose Format Data Point. 

This brings you to the dialog box with the same name. Depending on the chart type, tabstrip 
Pattern, or Line is displayed. 

5. Make the changes described below and choose OK. 

Changing Surfaces 
1. If you want to display the data point in the form of a surface (e.g. for bar or pie charts), choose tabstrip 

Pattern. 

2. Select the formatting for the filling and for the border of the surfaces. See Changing the Filling and 
Borders of Surfaces [Seite 55]. 

Changing Lines 
1. If the data point lies on a line (e.g. for line charts or radar charts), select tabstrip Line. 

2. Select the required formatting for the part of the line that belongs to the selected data point. You can 
define the type of line, color and width of the line. 

 
The formatting of the rest of the line is not changed by this setting. 

3. With Marker you can also define the symbol to be used to display the data point and how the symbol 
should be formatted. 

• If you want to copy the default formatting, choose Automatic. 

• If you do not want to mark the data point, choose None. 

• If you want to set up your own formatting, choose Custom. In the Style list, choose the symbol to be 
used to display the data point. If required, change the colors of the symbol and define the size of the 
symbol in field Size. 
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 Changing the Distance between Groups of Data Points 
Use 
The data points are arranged in groups for chart types representing data series for example as columns, 
bars or cylinders. You can change the distance between the groups if required. 

Prerequisites 
The chart is a column, bar, cone, profile, pyramid or cylinder chart. 

Procedure 
1. Click on the data series with the right mouse key. 

2. In the context menu choose Format Data Series. 

This brings you to the Chart Options dialog box. 

3. Choose tabstrip Options. 

4. Enter a distance between 0 and 500 in field Distance. The larger the value, the larger the distance 
between the groups. 

5. Choose OK. 
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 Changing the Overlapping of Data Points 
Use 
You can change how data points overlap for chart types that display data series as columns or bars. 
Normally data points of a group are arranged next to each other without overlapping. 

Prerequisites 
The chart is a column or bar chart. 

Procedure 
1. Click on the row of data with the right mouse key. 

2. In the context menu choose Format Data Series. 

This brings you to the Chart Options dialog box. 

3. Choose tabstrip Options. 

4. Enter a value between -100 and 100 in field Overlap. The larger the value, the greater the 
overlapping. The smaller the value, the larger the gap between the data points. 

5. Choose OK. 
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 Titles, Data Labels and Legends 
Definition 
A title for the entire chart as well as for each individual axis in the chart can be displayed in a chart. 

A data label gives supplementary information for example about a data series or a data point. 

The legend explains the colors, patterns and symbols used in a chart. 

Use 
You can add chart titles, axis titles and data labels and change their formatting. You can also remove all 
the elements you added: 

• Adding and Removing Chart Titles [Seite 124] 

• Adding and Removing Axis Titles and Units [Seite 125] 

• Formatting Chart Titles, Axis Titles and Units [Seite 126] 

• Adding Data Labels [Seite 127] 

• Formatting Data Labels [Seite 129] 

• Removing Data Labels [Seite 131] 

• Changing Texts of Titles, Units and Data Labels [Seite 132] 

You can add and format legends. You can also remove legends if required: 

• Adding and Removing Legends [Seite 133] 

• Formatting Legend Texts and Symbols [Seite 134] 

• Formatting the Legend Background [Seite 135] 

You can change the position of the chart title and legend directly in the chart if you permitted this when 
you added the corresponding element. You can change the position of axis titles, units and data labels 
directly in the chart. See Changing the Position of Chart Elements [Seite 59]. 
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 Adding and Removing Chart Titles 
Use 
You can give the entire chart a title in order to give a brief explanation of the contents of the chart. 

You can delete the chart title if it is not required. 

Procedure 
Adding a Chart Title 
1. Click with the right mouse key on any area of the chart. 

2. In the context menu, choose Chart Options. 

This brings you to the Chart Options dialog box. 

3. Choose tabstrip Title. 

4. Enter the chart title in field Chart title. 

5. If you want to be able to change the chart title directly in the chart, select field Editable. 

6. If you want to be able to change the position of the chart title, select field Moveable. 

7. Choose OK. 

You can change the formatting of the chart title that has been added, see Formatting the Chart Title, Axis 
Title and Units [Seite 126]. 

Deleting the Chart Title 
1. Click on the chart title. 

2. Press <Del>. 
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 Adding and Removing Axis Titles and Units 
Use 
You can give the X and Y axes a title. You can also enter the units to be displayed on the axes, for 
example mill. US $. 

If you do not need an axis title or unit, you can delete these elements. 

Prerequisites 
The axis to be given an axis title or whose unit you want to enter is displayed, see Showing and Hiding 
Axes [Seite 79]. 

Procedure 
Adding an Axis Title or Unit 
1. Click with the right mouse button on any area of the chart. 

2. In the context menu, choose Chart Options. 

This brings you to the dialog box of the same name. 

3. Choose tabpage Title. 

4. If you want to add a title or unit to the main axes, enter them in the corresponding fields under 
Category (X) axis and Value (Y) axis. 

5. If you also want to assign a title or unit for the secondary axes, enter these values in the 
corresponding fields under Secondary category (X) axis and Secondary value (Y) axis. 

6. Choose OK. 

You can change the formatting as required once you have added the axis title and units, see Formatting 
Chart Titles, Axis Titles and Units [Seite 126]. 

In special cases, you can also display units and currencies automatically. To do this, you have to highlight 
the special attribute Automatic Display of Units and Currencies (AUTOMATIC_LABELS) for the Web item 
chart in the Web Application Designer. See also Chart [Seite 47]. 

Removing the Axis Title or Unit 
1. Click on the axis title or unit to be deleted. 

2. Press the <Del> key. 
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 Formatting Chart Titles, Axis Titles and Units 
Use 
You can format the chart title and each axis title individually. If you added the axis units, you can also 
change their formatting. 

You can change the filling and border of the box surrounding a title or unit. You can also change the font 
properties and alignment. 

Prerequisites 
You already added a chart title, axis title or axis unit, see Adding and Removing Chart Titles [Seite 124] 
and Adding and Removing Axis Titles and Units [Seite 125]. 

Procedure 
1. Click with the right mouse key on the element you want to format. 

2. In the context menu choose Format Chart Title, Format Axis Label or Format Axis Title Unit. 

The dialog box Format Chart Title or Format Axis Label appears. 

3. Make the changes described below and choose OK. 

Changing the Filling and Border 
1. Choose tabstrip Pattern. 

2. Select the required formatting for the filling and for the border of the box surrounding the text. See 
Changing the Filling and Border of Surfaces [Seite 55]. 

Changing Font Properties 
1. Choose tabstrip Font. 

2. Select the required font properties for the text: font name, style (bold, italic, etc.), the size in points and 
the color. 

Changing the Alignment 
1. Choose tabstrip Alignment. 

2. Select the required arrangement of the text, e.g. from left to right, from top to bottom or rotated by 90 
degrees. 
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 Adding Data Labels 
Use 
You can display data labels in a chart as required and use them, for example, to display the absolute 
value for all data points. You can add data labels for all data series, for a single data series or for a single 
data point. 

Procedure 
Adding Data Labels to all Data Series 
1. Click with the right mouse button on any area of the chart. 

2. In the context menu, choose Chart Options. 

This brings you to the dialog box of the same name. 

3. Choose the Data Labels tab page. 

4. Choose the required option from those described below. 

5. Choose OK. 

Adding Data Labels to One Data Series 
1. Click with the right mouse button on the data series for which you want to add a data label. 

2. In the context menu choose Format Data Series. 

This brings you to the dialog box of the same name. 

3. Choose the Data Labels tab page. 

4. Choose the required option from those described below. 

5. Choose OK. 

Adding Data Labels to a Data Point 
1. Click on the data series to which the data point belongs. 

The entire data series is selected. 

2. Click on the data point to which you want to add a data label. 

Only that data point is selected. 

3. Click on the data point with the right mouse button. 

4. In the context menu choose Format Data Point. 

This brings you to the dialog box of the same name. 

5. Choose the Data Labels tab page. 

6. Choose the required option from those described below. 

7. Choose OK. 

Options for Data Labels 
The options you can use in the Data Labels tabstrip depend on the type of chart you selected. You have 
the following options: 

None: Do not display a data label 
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Show Value: Display absolute value 

Show Percentage: Show the percentile value (only for pie charts and ring charts) 

Show Label: Display the text 

Show Label and Value: Display the text and the absolute value 

Show Label and Percentage: Display the text and the percentile value (only for pie charts and ring chart) 

Show Bubble Size: Display the size of the bubble (only for portfolio charts) 

Show Label and Bubble Size: Display the text and the size of the bubbles (only for portfolio charts) 

 
The options Show Bubble Size and Show Label and Bubble Size are not supported in SAP 
BW 3.0. 
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 Formatting Data Labels 
Use 
You can format the data labels of a data series individually. 

Prerequisites 
You already added data labels, see Adding Data Labels [Seite 127]. 

Procedure 
1. Click with the right mouse key on one of the data labels belonging to the data series. 

2. In the context menu choose Format Data Labels. 

This brings you to the Chart Options dialog box. 

3. Make the changes described below and choose OK. 

Changing the Filling and Border 
1. Choose tabstrip Pattern. 

2. Choose the required formatting for the filling and for the border of the box surrounding the data labels. 
See Changing the Filling and Border of Surfaces [Seite 55]. 

Changing Font Properties 
1. Choose tabstrip Font. 

2. Select the required font properties for the data labels: font name, style (bold, italic, etc.), the size in 
points and the color. 

Changing the Alignment 
1. Choose tabstrip Alignment. 

2. In the lists Horizontal and Vertical, select how the text should be arranged within the box surrounding 
the text. 

3. In the list Position, select where the data label should be displayed with regard to the data point. 

• Outside end: At the outmost end of the data point, e.g. directly above a column 

• Inside end: At the innermost end of the data point, e.g. directly below the upper edge of a  column 

• Center: Centered within a data point 

• Inside base: At the base of a data point, e.g. directly at the beginning of a column 

4. Under Orientation select the required arrangement of the title, e.g. from left to right, from top to bottom 
or rotated by 90 degrees. 

Changing the Number Format 
1. Choose tabstrip Number. 

2. In field Category choose the required category, e.g. Date for date formats. 

3. In field Number formats choose the required format within the category. 

4. If you are not yet satisfied with the format, you can change it directly in field Number format. 
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 Removing Data Labels 
Use 
You can delete data labels that you do not need. You can delete data labels of all the data series or of a 
single data series. 

Procedure 
Removing Data Labels for All Data Series 
1. Click with the right mouse key on any area of the chart. 

2. In the context menu, choose Chart Options. 

This brings you to the Chart Options dialog box. 

3. Choose tabstrip Data Labels. 

4. Choose the option None. 

5. Choose OK. 

Removing the Data Label of a Single Data Series 
1. Click with the right mouse key on the data series whose data label you want to delete. 

2. In the context menu choose Format Data Series. 

This brings you to the Chart Options dialog box. 

3. Choose tabstrip Data Labels. 

4. Choose the option None. 

5. Choose OK. 

 
You can also delete the data label for a single data series by clicking on the data label and 
pressing <Del>. 
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 Changing Texts of Titles, Units and Data Labels 
Use 
You can change the text of the following elements directly in the chart: 

• Axis title 

• Axis unit 

• Title of value ranges 

• Data titles 

You can change the chart title directly in the chart if you permitted this when you added the title. See 
Adding and Removing Chart Titles [Seite 124]. You cannot change the title of a normal distribution directly 
in the chart. You can only change it in the properties of the normal distribution. See Editing the Normal 
Distribution [Seite 109]. 

Procedure 
1. Click on the text to be changed. 

2. Click on the selected area. 

The cursor is displayed as a vertical line. 

 
You might have to click more than once on the selected area for data labels. 

3. Change the text. 

4. Click on any area of the chart to leave text editing mode and close your changes. 

 
You can also change the chart title, axis titles and axis units by clicking on the element with 
the right mouse key and choosing Chart Options in the context menu. 
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 Adding and Removing Legends 
Use 
You can add a legend and define the position in the chart where it should be displayed. In a portfolio chart 
you can also decide if the legend should show two reference bubbles. These are used for comparison 
purposes to be able to better estimate the size of the bubbles displayed in the chart. 

You can delete a legend that you do not need. 

Procedure 
Adding Legends 
1. Click with the right mouse key on any area of the chart. 

2. In the context menu, choose Chart Options. 

This brings you to the dialog box with the same name. 

3. Select tabstrip Legend. 

4. Select the position where the legend should be displayed. 

5. If the position of the legend may be changed directly in the chart, select field Moveable. 

6. If the legend should only be displayed as a symbol, select field Show on demand. 

In this case you can click on the legend symbol in the chart to display the legend. If you click on 
the legend again, it is displayed again as a symbol. 

 
You can use the options Moveable and Show on demand when you edit the chart. But in the 
Web these options cannot be used, i.e. these options are ignored when you publish the 
graphic. 

7. To display reference bubbles in a portfolio, select field Visible in the Reference Bubbles area. Also 
define the diameter of the larger reference bubble. 

8. Choose OK. 

Removing Legends 
1. Click on the legend. 

2. Press <Del>. 

 
You can also remove legends by clicking on the outermost border of the legend with the right 
mouse key and choosing Delete in the context menu.  
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 Formatting Legend Texts and Symbols 
Use 
You can change the font properties of all the legend texts or of a single legend text. The font properties 
include the font type, style (bold, italic, etc.), size in points and color. 

You can also format the border and the filling of the legend symbols as you like. Changing the symbol 
affects the corresponding data series. 

Prerequisites 
You already added a legend. See Adding and Removing Legends [Seite 133]. 

Procedure 
Formatting All Legend Texts 
1. Click on the outermost border of the legends with the right mouse key. 

2. In the context menu choose Format Legend. 

This brings you to the dialog box with the same name. 

3. Select tabstrip Font and enter your font properties. 

4. Choose OK. 

Formatting Individual Legend Texts 
1. Click with the right mouse key on the legend text you want to format. 

2. In the context menu choose Format Legend Index. 

This brings you to the dialog box with the same name. 

3. Choose the required font properties. 

4. Choose OK. 

Formatting Legend Symbols 
1. Click with the right mouse key on the legend symbol you want to format. 

2. In the context menu choose Format Legend Key. 

This brings you to the dialog box with the same name. 

3. Select the formatting for the filling and for the border of the legend symbol. See Changing the Filling 
and Borders of Surfaces [Seite 55]. 

 
The formatting of the corresponding data series also changed. 

4. Choose OK. 

 

 

 

 

Web Application Design: BEx Web Application Designer 30B
 134 



SAP Online Help  13.05.2002 

 Formatting the Legend Background 
Use 
You can format the background of the entire legend. You can choose another filling and change the 
border surrounding the legend. 

Procedure 
1. Click on the outermost border of the legends with the right mouse key. 

2. In the context menu choose Format Legend. 

This brings you to the dialog box with the same name. 

3. Choose tabstrip Pattern. 

4. Select the formatting for the filling and border. See Changing the Filling and Borders of Surfaces 
[Seite 55]. 

5. Choose OK. 
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 Data Tables 
Definition 
A data table contains the values on which the data points in the chart are based. 

Use 
If you also want to show the table values in the chart, you can display the data table (see Showing and 
Hiding Data Tables [Seite 137]). This option only makes sense for chart types that have a category axis. 

You can format the data table as you like (see Formatting Data Tables [Seite 139]). 
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 Showing and Hiding Data Tables 
Use 
You can define whether or not you want to integrate the underlying data table in the chart for some chart 
types. 

Prerequisites 
You can only display a data table for bar charts, surface charts, line charts, vertical bar charts and 
tachometers. 

Procedure 
Showing the Data Table 
1. Click with the right mouse key on any area of the chart. 

2. In the context menu, choose Chart Options. 

This brings you to the Chart Options dialog box. 

3. Choose tabstrip Data Table. 

4. Select the field Show data table. 

5. If you also want to display the legend keys in the data table, also select the field Show legend keys. 

6. Choose OK. 

The data table is displayed below the graphic. 

Hiding Legend Keys in the Data Table 
1. Click with the right mouse key on any area of the chart. 

2. In the context menu, choose Chart Options. 

This brings you to the Chart Options dialog box. 

3. Choose tabstrip Data Table. 

4. Deselect the field Show legend keys. 

5. Choose OK. 

Hiding the Data Table 
1. Click with the right mouse key on any area of the chart. 

2. In the context menu, choose Chart Options. 

This brings you to the Chart Options dialog box. 

3. Choose tabstrip Data Table. 

4. Deselect the field Show data table. 

5. Choose OK. 
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 Formatting Data Tables 
Use 
You can format the lines of the data table and change the font properties of the table texts. You can also 
change the number format for the displayed numbers. 

Prerequisites 
The data table is displayed in the chart, see Showing and Hiding Data Tables [Seite 137]. 

Procedure 
1. Click on the data table with the right mouse key. 

2. In the context menu choose Format Data Table. 

This brings you to the Chart Options dialog box. 

3. Make the changes described below and choose OK. 

Changing Lines 
1. Choose tabstrip Line. 

2. If you want to copy the default formatting, choose Automatic. 

3. If you want to set up your own formatting, choose Custom. Select the required type and color for the 
lines. 

Changing Font Properties 
1. Choose tabstrip Font. 

2. Select the required font properties for the table texts: font name, style (bold, italic, etc.), the size in 
points and the color. 

Changing the Number Format 
1. Choose tabstrip Number. 

2. In field Category choose the required category, e.g. Date for date formats. 

3. In field Number formats choose the required format within the category. 

4. If you are not yet satisfied with the format, you can change it directly in field Number format. 
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 Changing the Page Layout 
Before you printout the draft phase of a chart, you can change the page layout. You can adjust the paper 
format, page borders and chart scaling for the printout. 

Changes to the page layout only affect the draft phase of the printout and not how the chart is published in 
the Web. 

Procedure 
1. Click with the right mouse key on any area of the chart. 

2. In the context menu choose Print Preview. 

3. Click again with the right mouse key on any area of the chart. 

4. In the context menu choose Page Setup. 

The Setup page dialog box appears. 

5. Make the changes described below and choose OK. 

Changing the Paper Format, Orientation and Arrangement 
1. Choose tabstrip Page. 

2. Under Paper size, choose the required paper format. 

3. Under Orientation define if the chart should be printed Vertical or Horizontal. 

4. You can change the position of the chart with Center. Normally the chart is output centered horizontal 
and vertical.  

− To make the chart left-justified, deselect Horizontally. 

− To position the chart at the upper edge of the page, deselect Vertically. 

Changing the Print Quality 
1. Choose tabstrip Page. 

2. With Print quality you can define the quality in which the chart should be printed. The larger the 
number of dpi (dots per inch), the higher the quality and longer the printing. 

Changing the Print Numbering 
You can decide if you want to output page numbers and define the number with which numbering should 
begin.  

1. Choose tabstrip Page. 

2. You can change the page numbering with the First page number field. 

− If you do not want to number the pages, delete the field. 

− If you want to begin page numbering with a certain number, enter this number. 

− If you want to start page numbering with 1 and to continue numbering automatically, enter Auto. 

Changing the Page Borders 
1. Choose tabstrip Page Borders. 

2. Under Border choose the left, right, top and bottom page borders. 
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3. Under Margins define the distance between the Header and Footer and the top and bottom page 
borders. If you do not want to use a header or footer, enter 0 in the corresponding field. 

Changing the Scaling 
1. Choose tabstrip Options. 

2. To make the pages for the printout larger or smaller, select field Scale and enter the desired scaling in 
percent of the original size. The page is enlarged for a value greater than 100 and is reduced in size 
for a value under 100. 

3. The chart is printed on one or more pages depending on its size.  If required, you can also define the 
number of pages on which the chart should be printed. Select field Fit to and enter the desired number 
of pages. The chart is scaled accordingly and distributed on the given number of pages. If you entered 
a number greater than 1, you can also decide if the chart should be divided horizontally or vertically. 
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 Printing Charts 
Use 
You can print a chart from the normal preview window during the draft phase. If you want to check what 
the chart looks like before printing it, you can first display the print preview. In contrast to the normal 
preview, the page borders are also displayed in the print preview. 

Procedure 
Calling the Print Preview 
1. Click with the right mouse key on any area of the chart. 

2. In the context menu choose Print Preview. 

The preview in the Chart window is replaced with the print preview. The current page borders are 
displayed with thin lines. If required, you can change the page layout [Seite 140] and print the 
chart. 

 
You can change the page borders directly from the print preview. Place the mouse on one of 
the border lines and pull the line to the new position. The page border is adjusted when you 
let go of the mouse key. 

Closing the Print Preview 
1. Click with the right mouse key on any area of the print preview. 

2. In the context menu choose Close Print Preview. 

Printing Charts 
You can print the chart from either the normal preview window or from the print preview. 

1. Click with the right mouse key on any area of the chart. 

2. In the context menu choose Print. 

3. To change the page layout click on Page Setup. You can also change the paper format, page borders 
and chart scaling for the printout, see: Changing the Page Layout [Seite 140]. 

4. To start the printing, click on OK. 

 

 

 

 

Web Application Design: BEx Web Application Designer 30B
 142 



SAP Online Help  13.05.2002 

 Dropdown Box 
Definition 
The Web item  Dropdown Box allows you to filter characteristic values from a Web application in a 
dropdown box.  

Use 
When you select a value, the assigned query view is filtered according to this value. If a different method 
is used to select a filter value for the characteristic in the dropdown box, the current filter value appears in 
the dropdown box. 

Structure 
As well as its general attributes [Seite 38], the Dropdown Box Web item also has the following attributes: 

Attributes Description 

Index in the filter command (INDEX) Must have a clear value for all dropdown boxes 
and radio button groups [Seite 146] within the 
form tag. 

 
This attribute must be changed 
only if the ONLY_VALUES 
attribute is active. 

Characteristics / Structure (IOBJNM) Name of characteristic / structure according 
to which you want to filter 
Specify the technical name of the characteristic 
(for example, 0COUNTRY) or the structure (25 
characters) here. 

 
The technical name of the 
characteristic is stored in the query 
definition. In the BEx toolbar, 
choose Change Query View → 
Change Query (Local View) or 
(Global View) → . The technical 
names of the InfoObjects are 
displayed. 

 
Note that the characteristic you 
have chosen must be included in 
the query that the Web application 
is based on.  
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Read mode (BOOKED_VALUES) Specifies which values in the master data table 
are copied to the Checkboxes Web item as 
filter values: 

• 

• 

M: All values from the master data table. 

Values that do not appear in the Data 
Provider under the current filter 
conditions and that produce the result 
No suitable data found upon filtering 
might also be displayed However, this 
process might not be the fastest under 
certain conditions. 

D: Values that are basically posted, 
whereby the current drilldown status is not 
fully taken into consideration. 

Q: Only values that are also posted in the Data 
Provider under the currently valid filter 
conditions are displayed. It can take a long 
time under certain circumstances. 

Maximum number of values in the 
dropdown box (MAXVALUES) 
(optional) 

Contains the maximum number of values that 
are displayed in the dropdown box. 

 
If this attribute has the value 0, all 
the available values are written in 
the dropdown box. 

Label (SHOW_LABEL) 
‘X’ = Yes, ‘  ’ = No 

Use BW description as label 
If this attribute is activated, the long text of the 
characteristic is written as a label in front of the 
dropdown box. In addition, you can use the 
context menu related to the description of the 
characteristic in this label. 

Display values only (ONLY_VALUES) 
‘X’ = Yes, ‘  ’ = No 

(optional) 

Create dropdown box only 
If you activate this attribute, only the HTML 
form Web item for the value list is created. You 
have to create the form, in which the dropdown 
box is contained, by hand in this case. 

 
This attribute is suitable for 
creating forms [Seite 262] that 
contain several dropdown boxes. 

Do not display entry All values 
(NO_REMOVE_FILTER) 
'X' = “All values” not offered, 

'  '  = Display entry “All values” 

If this field is not blank, the entry All values is 
not set as a selection option in the radio button 
group. 
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Data provider affected 
(TARGET_DATA_PROVIDER) 

Contains a list of all data providers to which the 
filter commands are sent. 

 
If you filter according to a 
characteristic and then activate this 
attribute, the different data 
providers for the Web item are 
notified. For further information 
about this attribute see General 
Attributes [Seite 38]. 
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 Radio Button Groups 
Definition 
The radio button group Web Item  allows you to filter characteristic values in a group of radio buttons. 

Use 
When you select a value, the assigned query view is filtered according to this value. If you select a filter 
value in another way for the characteristic of the radio button group, the current filter value is selected. 

Structure 
As well as its general attributes [Seite 38], the Radio Button Group Web item has the following attributes: 

Attributes Description 

Characteristics / Structure (IOBJNM) Name of the characteristic / structure that 
you want to filter by 
Specify the technical name of the characteristic 
(for example, 0COUNTRY) or the structure (25 
characters) here. 

 
The technical name of the 
characteristic is stored in the query 
definition. In the BEx toolbar, 
choose Change Query View → 
Change Query (Local View) or 
(Global View) → . The technical 
names of the InfoObjects are 
displayed. 

 
Note that the characteristic you 
have chosen must be included in 
the query that the Web application 
is based on. 
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Read mode (BOOKED_VALUES) Specifies which values in the master data table 
are copied to the Checkboxes Web item as 
filter values: 

• 

• 

M: All values from the master data table. 

Values that do not appear in the Data 
Provider under the current filter 
conditions and that produce the result 
No suitable data found upon filtering 
might also be displayed However, this 
process might not be the fastest under 
certain conditions. 

D: Values that are basically posted, 
whereby the current drilldown status is not 
fully taken into consideration. 

• Q: Only values that are also posted in the 
Data Provider under the currently valid filter 
conditions are displayed. It can take a long 
time under certain circumstances. 

Maximum number of displayed values 
(MAXVALUES) 
(optional) 

Contains the maximum number of values that 
are displayed in the radio button group. 

 
If you set the value to 0, all the available values 
in the radio button group are displayed. 

Label (SHOW_LABEL) 
‘X’ = Yes, ‘  ’ = No 

Use BW description as label 
If this attribute is activated, the long text of the 
characteristic is written as a label in front of the 
radio button group. In addition, you can use the 
context menu related to the description of the 
characteristic in this label. 

Entries next to one another 
(HORIZONTAL_ALIGNMENT) 
‘X’ = Yes, ‘  ’ = No 

If this attribute is activated, the different 
characteristic values are grouped vertically. If 
this attribute is deactivated, the characteristic 
values are grouped horizontally. 

Number of entries next to one 
another/below one another 
(HORIZONTAL_NUMBER) 

Contains the number of entries listed next to 
one another or below one another, depending 
on the attribute settings for 
HORIZONTAL_ALIGNMENT. 
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Display values only (ONLY_VALUES) 
‘X’ = Yes, ‘  ’ = No 

Create radio button group only 
If you activate this attribute, only the HTML 
form Web item for the radio button group is 
created. Here, you have to create the form, in 
which the radio button group is contained, by 
hand. 

 
This attribute is suitable for 
creating forms [Seite 262] that 
contain several radio button 
groups. 

Do not display entry All values 
(NO_REMOVE_FILTER) 
'X' = “All values” not offered, 

'  '  = Display entry “All values” 

If this field is not blank, the entry All values is 
not set as a selection option in the radio button 
group. 

Affected DataProvider 
(TARGET_DATA_PROVIDER) 

List of data providers to which all selection 
button commands are sent. 

Index in the filter command (INDEX) 
(optional) 

Must have a clear value for all dropdown boxes 
[Seite 143] and radio button groups within the 
form tag. 

 
This attribute must be changed 
only if the ONLY_VALUES 
attribute is active. 
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 Checkboxes 
Definition 
Checkboxes  is a Web item that places characteristic values for filtering in a group of checkboxes. 

Use 
The Checkboxes Web item can be used to easily filter a connected saved query view according to a 
certain characteristic. 

You can set or remove filter values in the Web application by setting one or more indicators. 

Structure 
As well as its general attributes [Seite 38], the Checkboxes Web item has the following attributes: 

Attribute Values Description 

Characteristic/structure 

(IOBJNM) 

Selection list Select the technical name of 
the characteristic. 

Characteristics and structures 
are read from data providers. 
The characteristic values are 
provided in a dropdown box in 
the Web application as filter 
values. 

Read mode 

(BOOKED_VALUES) 
• 

• 

• 

• 

• 

• 

Master data table (M) 

Dimension table (D) 

Posted values (Q) 

Standard setting “Dimension 
table” 

Specifies which values in the 
master data table are copied 
to the Checkboxes Web item 
as filter values: 

M: All values from the 
master data table. 

Values that do not 
appear in the Data 
Provider under the 
current filter conditions 
and that produce the 
result No suitable data 
found upon filtering 
might also be 
displayed However, 
this process might not 
be the fastest under 
certain conditions. 

D: Values that are 
basically posted, whereby 
the current drilldown 
status is not fully taken 
into consideration. 

Q: Only values that are 
also posted in the Data 
Provider under the 
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currently valid filter 
conditions are displayed. It 
can take a long time under 
certain circumstances. 

Maximum number 

(MAXVALUES) 

Default value: “0” Maximum number of displayed 
filter values If "0", all values 
are displayed. 

Maximum length 

(MAXLENGTH) 

 Maximum number of 
characters in the label. 

Label 

(SHOW_LABEL) 

‘X’ = Yes, ‘  ’ = No 

Default setting: ‘X’ = Yes 

If this attribute is activated, the 
long text of the characteristic 
is written as a label in front of 
the control box. 

Affected DataProvider 

(TARGET_DATA_PROVIDER
) 

Selection list List of data providers to which 
all checkbox commands are 
sent. 

Entries next to one another 
(HORIZONTAL_ALIGNMENT) 

 

‘X’ = Yes, ‘  ’ = No 

Default setting: ‘ ‘ = No 

Order entries next to one 
another 

If this attribute is activated, the 
different characteristic values 
are grouped vertically. If this 
attribute is deactivated, the 
characteristic values are 
grouped horizontally. 

Number of entries next 
to/under one another 
(HORIZONTAL_NUMBER) 

Default value: 1 Contains the number of entries 
listed next to one another or 
below one another, depending 
on the attribute settings for 
HORIZONTAL_ALIGNMENT. 
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 Generic Navigation Block 
Definition 
A Web item that obtains data from a query view to create a generic navigation block for a Web application. 
This block contains keys that you can use to transfer characteristics, for example, into rows or columns. 

Use 
The Web item  Generic Navigation Block displays the navigational state of a query view in the Web 
application in the form of a table. All characteristics and structures in the query view are listed in the table 
and their filter values are displayed. You can change the navigational status of the query view. You can 
transfer characteristics and structures to an axis (rows or columns) or from axes. You can filter according 
to single values and remove the filter again. 

Structure 
As well as its general attributes [Seite 38], the Generic Navigation Block Web item has the following 
attributes: 

Attributes Description 

Read mode 
 (BOOKED_VALUES) 
(BOOKED_VALUES_N) 

“Master data table” 

“Dimension table” 

“Posted values” 

Specifies which values in the master data table 
are copied to the Checkboxes Web item as 
filter values: 

• 

• 

M: All values from the master data table. 

Values that do not appear in the Data 
Provider under the current filter 
conditions and that produce the result 
No suitable data found upon filtering 
might also be displayed However, this 
process might not be the fastest under 
certain conditions. 

D: Values that are basically posted, 
whereby the current drilldown status is not 
fully taken into consideration. 

• Q: Only values that are also posted in the 
Data Provider under the currently valid filter 
conditions are displayed. It can take a long 
time under certain circumstances. 

Read mode for filter items 

The “master data” read mode may lead to 
many unposted values being displayed; the 
“posted values” read mode may be slow. 

Order entries next to one another 
(HORIZONTAL_ALIGNMENT) 
‘X’ = Yes, ‘  ’ = No 

As well as arranging the characteristics below 
one another, you can also display them next to 
one another. In many cases, this makes better 
use of the display area and there is a stronger 
visual link between, for example, the table and 
the navigation block. 
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Entries next to one another 
(HORIZONTAL_NUMBER) 
Default value: 3 

Describes the maximum number of 
characteristics that can be displayed next to 
one another. If the navigation block contains 
more than the specified number of 
characteristics, then it is automatically 
displayed in more than one row, where the 
number of characteristics per row is optimized 
regarding the equal distribution of rows and the 
required number of characteristics. 

 
This attribute is only included when 
HORITONTAL_ALIGNMENT 
(Define entries next to one 
another) is activated. 

Maximum filter value length 
(FILTER_VALUE_LENGTH) 
Default value: 80 

You specify the number of characters, 
according to which filter value is indicated, by 
<Number>. 

 
If you set the value to 0, then the complete filter 
value is displayed. 

Frame name for input help 
(TARGET_HELP_FRAME) 
(optional) 

You can display input help in a different frame 
from the data. If you do not activate this 
attribute, then input help is displayed in the 
same window. 

 
This parameter is not offered in the 
Web Application Designer and can 
only be used for parameterization 
in the Web template. 

List of characteristics with read mode 
(IOBJNM_LIST) 

This attribute contains a list of characteristics 
with read mode. You can select a characteristic 
of a structure and activate the read mode for it. 

Affected DataProviders 
(TARGET_DATA_PROVIDER) 

Contains a list of all data providers to which the 
navigation block is sent. 

 
If you filter according to a characteristic and 
then activate this attribute, the different data 
providers for the Web item are notified. For 
further information about this attribute, see 
General Attributes [Seite 38]. 
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List of navigation block entries 
(ITEM_NAV_BLOCK_IOBJNM_N) 
(optional) 

 
In the WAD, this attribute is 
displayed using the List of 
Characteristics with Read Mode 
attribute (IOBJNM_LIST). 

Listing the names of characteristics and 
structures enables you to determine which 
entries appear in the navigation block, and in 
which order. 

 
If you do not specify this 
parameter, all characteristics and 
structures in the navigation block 
are displayed. 

Attributes that cannot be set in the Web Application Designer: 

MODIFY_CLASS ABAP class that changes the content of the 
navigation block 
By using the Web design API for tables, you 
can adjust the cell content individually in the 
navigation block. 

See also: 

Web Design API for Tables [Seite 338] 
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 Hierarchical Context Menu 
Definition 
Web item  that creates a context menu from the hierarchy of a characteristic or structure. The hierarchy 
nodes appear as context menu entries and can be set as a filter. 

Use 
You can filter a query view by hierarchy nodes using the hierarchical context menu. 

Structure 
As well as its general attributes [Seite 38], the Web item Hierarchical Context Menu has the following 
attributes: 

Attribute Values Description 

Reload level dynamically 

(DYNAMIC) 

‘X’ = Yes, ‘  ’ = No 

Default setting: ‘X’ = Yes 

Reload from levels underneath 
the start level. 

If this attribute is set, the levels 
below the start level are 
reloaded dynamically, if 
required. Otherwise, they are 
not offered. 

Characteristic/structure 

(IOBJNM) 

Selection list Select the technical name of 
the characteristic/structure. 

The hierarchy and structure 
nodes are read from the Data 
Provider and can be used as 
filter values in the context 
menu. 

Hierarchy name 

(HIERARCHY_NAME) 

Selection list Technical name of the 
hierarchy which should be 
used for filtering nodes. If the 
field is blank, the system uses 
the hierarchy that is currently 
set. 

Version 

(HIERARCHY_VERSION) 

Selection list Version of the hierarchy that 
should be used for filtering 
nodes. If the field is blank, the 
current version of the 
presentation hierarchy is used. 

Key Date 

(DATE) 

 Key date for which the 
hierarchy is evaluated. 

The hierarchy is used as it 
existed on the given date. If 
this field is blank, the key date 
of the query is used. 
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You can remove 
the key date using 
the Delete Date 
pushbutton. 

Drill level 

(DRILL_LEVEL) 

Default value: “3” Maximum drill level of the 
context menu (blank= drill 
level corresponding to query 
definition) 

Affected DataProvider 

(TARGET_DATA_PROVIDER
) 

 List of DataProviders to which 
all hierarchy commands are 
sent. 
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 Filters 
Definition 
A filter is a Web item that displays the filter values resulting from navigation for a query view in the Web 
application. 

Use 
The Web item  Filter displays the filter values that have been generated by navigating in a query view in 
a Web application. You also use filters to select individual values. 

Structure 
As well as its general attributes [Seite 38], the Filter Web item has the following attributes: 

Attributes Description 

Display Filter Values 
PRESENTATION (optional) 
PRESENTATION_N (optional) 
'KEY' = key 

'TEXT' = Descriprtion 

'KEY_TEXT' = Key and description 

'TEXT_KEY' = Description and key 

The filter value is displayed in accordance with 
the setting. If no display is specified for an 
index, the index 0 display (no index) is used. 

 
If this parameter is not specified, 
the display, which is valid for the 
characteristic, is used. 

List of characteristics 
(ITEM_LIST) 

List of characteristics with display 

Maximum filter value length 
(FILTER_VALUE_LENGTH) 
Default value: 0 

You specify the number of characters, 
according to which a filter value is indicated, by 
“...”. 

 
If you keep the value as 0 (default), 
the complete filter value is 
displayed. 

Only display values 
(ONLY_VALUES) 
"X" = Yes, " " = No 

When you activate this attribute, the filter 
values are displayed without any labeling, and 
the formatting is separated using semi-colons. 
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List characteristics and structures 
(ITEM_FILTER_IOBJNM_N) 
(optional) 

 
This attribute is displayed in the 
Web Application Designer in the 
attribute list of the characteristic 
(ITEM_LIST). 

 

Listing the names of characteristics and 
structures enables you to determine which 
entries appear in the filter and in which order. 
Only those entries for which a filter value exists 
are displayed. The remaining entries are 
skipped over. 

 
If you do not specify this 
parameter, all the characteristics 
and structures that are filtered are 
displayed. 

If you combine ONLY_VALUES=X and ITEM_FILTER_IOBJNM=MyInfoObject, it is possible to identify a 
single filter value in the Web template. This is also useful in headers, for example. 

 
Displaying filter values for the characteristic Calendar year without formatting 
<object> 

 <param name=’OWNER’ value=’SAP_BW’> 
 <param name=’CMD’ value=’GET_ITEM’> 
 <param name=’ITEM’ value=’Filter’> 
 <param name='ITEM_ID' value='FILTER'> 
 <param name='DATA_PROVIDER' value='View1 > 
 <param name=’ONLY_VALUES’ value=’X’> 
 <param name=’ITEM_FILTER_IOBJNM’ value=’0CALYEAR’> 
 ITEM :Filter 

</object> 

Input field for filtering according to Calendar year with preassigned dynamic filters 
(only works with single value filters) 
<form action="<SAP_BW_URL DATA_PROVIDER='View 1' 
FILTER_IOBJNM='0CALYEAR'>" method="post"> 

Calendar year: <input name="FILTER_VALUE_EXT" size=4 maxlength=4 value=" 

<object> 

 <param name=’OWNER’ value=’SAP_BW’> 
 <param name=’CMD’ value=’GET_ITEM’> 
 <param name=’ITEM’ value=’Filter’> 
 <param name='ITEM_ID' value='FILTER'> 
 <param name='DATA_PROVIDER' value='View1 > 
 <param name=’ONLY_VALUES’ value=’X’> 
 <param name=’ITEM_FILTER_IOBJNM’ value=’0CALYEAR’> 
 <param name='PRESENTATION' value='KEY'> 
 ITEM :Filter 

</object> 

<input type=submit value="Submit"> 
<input type=reset value="Reset"> 

</form> 
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 Label 
Definition 
The   Label Web item allows you to display the descriptions of characteristics, attributes, or structural 
components. You can also create a link to the context menu of these characteristics, attributes, or 
structural components. 

Use 
This Web item, together with the Web items Dropdown Box [Seite 143] and Radio Button Group [Seite 
146], can be used to configure a comfortable cockpit. You can create navigation blocks by putting different 
labels for characteristics and structural components into a table. 

Structure 
As well as its general attributes [Seite 38], the Label Web item has the following attributes: 

Attribute Description 

Context menu (CONTEXT_MENU) 
‘X’ = Yes, ‘  ’ = No 

If this attribute is activated, a link to the context 
menu of the characteristic or the structural 
component is displayed in the description of 
the characteristic.  

Characteristics / Structure (IOBJNM) Name of the characteristic/structure 
Specify the technical name of the characteristic 
(for example, 0COUNTRY) or the structure (25 
characters) here. 

 
The technical name of the characteristic is 
stored in the query definition. In the BEx 
toolbar, choose Change Query View → 
Change Query (Local View) or (Global View) → 

. The technical names of the characteristics 
are displayed. 

Structural component 
(STRUCTURE_MEMBER) 

Structural component whose text or context 
menu is displayed. 

Attribute name (ATTRINM) Technical name of the attribute whose header 
is to be displayed as a label. 

Only display values 
(ONLY_VALUES) 
‘X’ = Yes, ‘  ’ = No 

Unformatted display 
Only the link to the context menu is generated. 

If this attribute is activated, only the link to the 
context menu is displayed. The label is 
displayed without formatting. You can 
determine in the Web template how you would 
like to put the link underneath. 
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If you would like to add a label for a structural component in your Web application, then you 
have to enter the technical name of the structure under InfoObject and enter the filter value of 
the structure under Structural Component (STRUCTURE_MEMBER). The correct values are 
determined as follows: 

a. Execute a Web application that contains the structural component. 

b. Filter according to the structural component in question: Choose Keep as filter value in the context 
menu of the structural component. 

c. Copy the parameter value FILTER_IOBJNM from the URL into the clipboard. 

d. Choose the attribute  in the Web Application Designer and enter the value that was saved in the 
clipboard. 

e. Copy the parameter value FILTER_VALUE from the URL into the clipboard. 

f. Choose the attribute Structural component from the Web item Label in the Web Application 
Designer and enter the value that was saved in the clipboard. 

g. Save your entries.  
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 Text Elements 
Definition 
Web item that the text items display for a query view in a Web application. 

Use 
The Web item  Text elements displays the query information that the query view and the Web 
application are based on. It is also possible to choose text elements individually. 

Structure 
The text elements are similar to the text elements in the BEx Analyzer and are made up of the following 
parts: 

• common text elements: 

− technical name of the query (REPTNAME) 

− description of the query (REPTXTLG) 

− InfoProvider (INFOCUBE) 

− key date for the query (SRDATE) 

− accuracy of the data (date and time) (ROLLUPTIME) 

− the person who wrote the query (AUTHOR) 

− the last time the query was changed (date and time) (MODTIME) 

− the last person to make changes to the query (MODUSER) 

− current user (SYUSER) 

− the last time the query was refreshed (date and time) (SYUZEIT) 

• variables 

• static filter values 

As well as its general attributes [Seite 38], the Text Elements Web item has the following attributes: 

Attributes Description 

Display common text elements 
(SHOW_COMMON_ELEMENTS) 
‘X’ = Yes, ‘  ’ = No 

If you activate this attribute, the common text 
elements are displayed. 

Display static filter values 
(SHOW_FILTERS) 
‘X’ = Yes, ‘  ’ = No 

If you activate this attribute, the filter values 
that you determined in the filter area of the 
query definition are displayed. 

Display variable values 
(SHOW_VARIABLES) 
‘X’ = Yes, ‘  ’ = No 

If you activate this attribute, the variable values 
for the query (on which the Web application is 
based) are displayed. 
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List of text elements (ELEMENT_NAME_N) 
 

By listing the text element names in 
combination with their type 
ELEMENT_TYPE_N, you are able to 
determine which entries appear as text items 
and the order in which they appear. With 
general text elements the name corresponds to 
one of the values listed above (under General 
Text Items). With variables the name 
corresponds to the variable name, and with 
filters the name corresponds to the name of the 
characteristic. 

 
If you do not specify this parameter, all the 
filtered characteristics and filtered 
structures are displayed. 

List of the types of text elements 
(ELEMENT_TYPE_N) 

 
Both attributes, List of Text 
Elements (ELEMENT_NAME_N) 
and List of Text Element Types 
(ELEMENT_TYPE_N), are 
addressed in the Web Application 
Designer in the Element List 
(ITEM_LIST) attribute that lies 
below. 

 

See above: List of Text Elements 

COMMON = Common text element 

FILTER = Static filter value 

VARIABLE = Variable value 

VARIABLE_KEY = Key for variable value 

List of items 
(ITEM_LIST) 

This attribute contains a list of text items with 
type and name. You can choose the type of 
text item from the list or enter the name of the 
item manually. 

Only display values 
(ONLY_VALUES) 
‘X’ = Yes, ‘  ’ = No 

If you activate this attribute, the values for the 
text elements are displayed without any 
labeling, and the formatting is separated by 
semi-colons. 

The combination of ONLY_VALUES=X, ITEM_TYPE =COMMON, and ITEM_NAME=REPTXTLG, makes 
it possible to access a text element directly in the Web template, here for example, the query name. The 
name is used in a title, for example. 

 
Display of validity of data, filter value for cost center and values for 2 variables 
<object> 

<param name='OWNER' value='SAP_BW'> 
<param name='CMD' value='GET_ITEM'> 
<param name='ITEM' value='Text'> 
<param name='ITEM_CLASS' value='CL_RSR_WWW_TEXT_ELEMENTS'> 
<param name='ELEMENT_TYPE_1' value='COMMON'> 
<param name='ELEMENT_NAME_1' value='ROLLUPTIME'> 
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<param name='ELEMENT_TYPE_2' value='FILTER'> 
<param name='ELEMENT_NAME_2' value='0COSTCENTER'> 
<param name='ELEMENT_TYPE_3' value='VARIABLE'> 
<param name='ELEMENT_NAME_3' value='myFirstVariable'> 
<param name='ELEMENT_TYPE_4' value='VARIABLE'> 
<param name='ELEMENT_NAME_4' value='mySecondVariable'> 
<param name='DATA_PROVIDER' value='MyDataProvider'> 

ITEM :Text 

</object> 
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 List of Exceptions 
Definition 
A Web item that lists the available exceptions for a stored query view, along with their status (active/not 
active) in the Web application.  

Use 
The  List of Exceptions Web item displays the status of the exceptions for a stored query view in the 
Web application, in the form of a table. For each exception, the status of the exception (active/not active) 
is also displayed. You can activate or deactivate the exceptions by clicking on the  symbol. 

Structure 
The Web item List of Exceptions has only general attributes. 

See General Attributes [Seite 38] 
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 List of Conditions 
Definition 
A Web item that displays all the available conditions including their corresponding statuses (active/not 
active/not applicable/not used) for a stored query view in the Web application.  

Use 
The  List of Conditions Web item displays the status of conditions for a stored query view in the Web 
application, in the form of a table. All the conditions that can be applied to the current navigation status for 
the query view are listed. With every condition that is displayed, the status of the condition is also 
displayed (active/not active/not applicable/not used). You use the  symbol to activate/deactivate the 
conditions. 

See also: 
Using Conditions [Extern] in the BEx Analyzer 

Structure 
The Web item List of Conditions only has general attributes. 

See General Attributes [Seite 38] 
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 Alert Monitor 
Definition 
 Reporting Agent [Extern]. 

Use 
With the help of the  Alert Monitor Web item, you can go to the query views generated in the Exception 
Reporting [Extern] and Reporting Agent processes and see at a glance any noticeable, deviating key 
figures from defined threshold values. You can also set filters. 

 
Since there is only one data source for the Alert Monitor, there is no need to set up the  Alert 
Monitor Web item as a separate data provider. The Alert Monitor Web item generates a 
suitable data provider for itself and transfers the filter operations to this data provider 
automatically. 

Structure 
As well as its general attributes [Seite 38], the Alert Monitor Web item has the following attributes: 

Attributes Description 

Query (FILTER_QUERY) You can use this attribute to filter according to 
entries that come under a specific query. If you 
do not specify a query, no filter applies. 

Display minimal view list (MINIMAL_VIEW) 
(optional) 
‘X’ = Yes, ‘  ’ = No 

When you go to the detail view, only the key 
figure columns are displayed for which 
exceptions can arise. 

If you do not specify the parameter, the key 
figures are shown as scheduled. 

InfoCube (FILTER_INFOCUBE) You can use this attribute to filter according to 
entries that come under a specific InfoCube. If 
you do not specify an InfoCube, no filter 
applies. 

InfoArea (FILTER_INFOAREA) You can use this attribute to filter according to 
entries that come under a specific InfoArea. If 
you do not specify an InfoArea, no filter 
applies. 

Red entries (FILTER_RED) 
"X" = Yes, " " = No 

If you activate this attribute, you see the rows 
with at least one red entry. 

Yellow entries (FILTER_YELLOW) 
"X" = Yes, " " = No 

If you activate this attribute, you see the rows 
with at least one yellow entry. 

Green entries (FILTER_GREEN) 
"X" = Yes, " " = No 

If you activate this attribute, you see the rows 
with at least one green entry. 
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Display highest alert level 
(DISPLAY_MAX_LEVEL) 
"X" = Yes, " " = No 

Instead of displaying red, yellow, and green 
entries with their frequency for each query 
view, you can display just the entry with the 
highest alert level. This may make the display 
easier to study. 

Number of rows in table (BLOCK_SIZE) 
Default value: 10 

Number of rows displayed at once in the table.  

With the help of this attribute, you can 
determine the number of entries you want to 
display at the same time. 

 
We recommend that you restrict 
the number of entries, especially 
when the number of alerts is high. 

 
If you set the value to 0, all entries 
are displayed. 

If there are more rows with alerts, 
an index is added for you to scroll 
down. 

Display as hierarchy (HIERARCHY) 
"X" = Yes, " " = No 

If you activate this attribute, the alerts are 
displayed in a hierarchy, starting with the level 
of InfoArea, InfoProvider, and query, and going 
up to the individual query views. If you 
deactivate this attribute, the alerts are 
displayed as a flat list. This means only the 
query views are displayed (no InfoAreas, 
InfoProviders, or queries).  

Template for display 
(TARGET_TEMPLATE_ID) 
(optional) 

Web template, on which the detail view display 
is based. 

List display 
(LIST_FOCUS_LEVEL) 

This setting only affects the non-hierarchical 
display. You can choose between INFOAREA, 
INFOCUBE, QUERY, VIEW, CELL, and 
EXCEPTION. Only lines of this type are 
displayed, according to the selection. 

List of columns with labels 
(COLUMN_LIST) 

You can structure the columns however you 
want and display headers for the individual 
columns. 

 
This attribute compounds the 
attributes COLUMN_NAME and 
COLUMN_CAPTION. 
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Display column captions 
(DISPLAY_COLUMN_CAPTION) 
‘X’ = Yes, ‘  ’ = No 

If you do not activate this attribute, then the 
column headings are not displayed. 

 

Display toolbar 
(DISPLAY_TOOLBAR) 

If this attribute is specified, then the user can 
use it to control the parameters FILTER_RED, 
FILTER_YELLOW, FILTER_GREEN, 
HIERARCHY, and LIST_FOCUS_LEVEL. 

Display DataProvider 
(DISPLAY_DATA_PROVIDER) 
(optional) 
‘X’ = Yes, ‘  ’ = No 

The detail view for an entry can also be 
displayed in the same Web template. To do 
this, the logical name of the DataProvider to be 
used for the display must be specified. The 
Web items that retrieve your data from this 
DataProvider display the detail view for the 
Alert Monitor entry automatically. 

Detail frame (TARGET_FRAME) Name of the frame for the detail view 
If you do not specify a detail frame, the detail 
view is displayed using pure HTML in the same 
window and opens a separate window using 
activated Java Script. 

 
The parameters JUMP_WBID and JUMP_PAGEID used in BW 2.x are still supported. 
However, we recommend you no longer use these. 
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 Role Menu 
Definition 
The   Role Menu Web item displays user favorites and/or roles in a tree. 

Use 
You can restrict the role menu to user favorites and roles or to a particular role. No menu entries are 
shown if the user is not assigned to this particular role. You can filter the menu entries according to 
various categories. A menu entry is a URL in a BEx Web application, for example. You can use the 
attribute TARGET to define in which window the URL is executed. 

Structure 
As well as its general attributes [Seite 38], the Role Menu Web item has the following attributes: 

Attributes Description 

Role name 
(ROLE) 

Restriction to favorites and/or roles or to a 
particular role. 
When ROLE is empty, the user favorites and 
roles are displayed. The favorites can be 
displayed with ROLE=SAP_BW_FAVORITES_ 
(with two _ between SAP_BW and 
FAVORITES_). Enter the technical name of the 
role when you want to restrict the display to a 
particular role. 

Number of levels. 
(LEVEL) 
‘0’ = all levels 

Number of levels that are initially read. 
The role menu is loaded initially with the 
specified levels. Further levels are read 
dynamically by expanding folders. All levels are 
read for LEVEL=0. 

Filters 
(FILTER) 

Filter menu entries according to type 
You can filter according to the following types 
or type combinations. 

• 'U' = URLs 

• 'P '  = Web templates 

• ‘Y’ = Queries 

• 'R '  = Crystal Reports 

All entries for these types are displayed when a 
filter is not specified. 

 
For example, the filter ‘UP’ shows 
all URLs and Web templates with 
reference to ROLE. 
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Name of the target frame 
(TARGET) 
 

Name of the frame for executing menu 
entries. 
The URL is executed in the specified frame 
behind a menu entry. 

Scrollbar presentation 
(SCROLL_STYLE) 
“Auto” = Automatic scrollbar presentation 

“Yes” = Scrollbar always displayed 

“No” = Scrollbars never displayed 

Scrollbar presentation 
Scrollbars are displayed either dependently on 
the size of the contents (Auto) or independently 
of the size, either always (Yes) or never (No). 

Display with IFrame 
(IFRAME) 
‘X’ = Yes, ‘  ’ = No 

Display as IFrame 
You can display the Role Menu Web item in an 
Iframe (a frame imbedded in HTML) or in a 
Frameset. On the one hand, the combination 
from other Web items with the Role Menu Web 
item is possible for an IFrame. On the other 
hand, Netscape 4.7 and PDAs do not support 
IFrames. Only the Role Menu Web item is 
displayed for the Frameset. The other Web 
items are ignored. 

The advantage of IFrames is that they allow 
you to structure the HTML page for the role 
menu freely, for example, with text, logos, or 
other Web items. The role menu in the frame 
set is created generically and cannot be 
changed externally. 

 
If a role menu is called up with 
IFrame on Netscape 4.7 or on a 
PDA, the IFrame is ignored and a 
frameset is automatically sent to 
the Web browser. 

Display with frames and IFrame 
(IFRAME_STYLE) 
‘X’ = Yes, ‘  ’ = No 

Displaying the frame around the IFrame 
A frame border is displayed around the IFrame. 
The proposed value is ‘ ‘ = No. 

User and logo display 
(DISPLAY_USER) 
‘X’ = Yes, ‘  ’ = No 

User and logo display 
Above the role menu, the user name is 
displayed along with a logo. 

Path of the logo icon 
(ICON_LOGO) 

Path of the logo icon 
The path of the icon in the MIME repository 
that is displayed as a logo. You can only use 
this attribute in the context of DISPLAY_USER. 
For example: ‘Bex/Icons/s_logo.gif’ 
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 Ticker 
Definition 
The Web item  Ticker enables you to display the content of a table as a ticker.  

Use 
To use the ticker, you need a Web browser that enables JavaScript. 

Structure 
As well as its general attributes [Seite 38], the Role Menu Web item has the following attributes: 

Attributes Description 

Create invisible form 
(ONLY_VALUES) 
‘X’ = Yes, ‘  ’ = No 

Create invisible form. 
You can create an invisible form so that you 
can further process the ticker text. 

Separator 
(SEPARATOR) 

Separator between two ticker rows. 

Separators are added when the data for a new 
data row is displayed. 

Speed in milliseconds. 
(SPEED) 
Default value: 200 

Time in milliseconds until the ticker moves 
again. 

Width of the ticket text in characters 
(TICKER_SIZE) 
Default value: 60 

Width of the ticket text in characters. 

Place title at start of ticker text 
(USE_CAPTION) 
‘X’ = Yes, ‘  ’ = No 

Default setting: ‘X’ = Yes 

Place title at start of ticker text. 

Delay in milliseconds 
(DELAY) 
Default value: 3000 

Delay in milliseconds until the ticker starts run. 
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 Maps 
Purpose 
Many characteristics in the Business Information Warehouse, for example, customer, sales region, and 
country, contain important geographical characteristics. The geographical information can be evaluated in 
a map together with the business-orientated, relevant key figures.  

Use maps to visualize business-oriented connections and distributions. You can clearly display specific 
key figures as color shading, pie charts, or bar charts for a country, a region, or a city. 

 
You have the option to change the view of a map in which you either zoom in to display a detailed view or 
zoom out for an overall view. In this way, it becomes easier to view, for example, the sales analysis of a 
specific product that refers to a specific region or a country You can recognize the potential or dangers of 
a market all at a glance. 

 

Integration 
Maps help you with reporting geo-relevant data. By using the map Web item, you determine a 
geographical display in the BEx Web Application Designer for your business-oriented data for the Web 
application. 

Geo-relevant InfoObjects are stored and maintained in the Metadata Repository. The master data for 
geo-InfoObjects is equipped with geo-attributes. Assigning the range of geographic to business-oriented 
data  (mapping/geocoding) using an external tool: ArcView from ESRI (Environmental Systems Research 
Institute). 

Functions 
With maps you prepare and evaluate data of a geographical nature (characteristics such as customer, 
sales region, and country, for example). The geo-relevant data is displayed graphically on a map. Using 
enhanced navigation options (“geographical drilldown”), regional information can be evaluated more easily 
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at different levels of detail. A map shows the spatial proximity of places and regions, allowing geographical 
connections to be more clearly represented. 

Process 
The following graphic illustrates the geographic evaluation of data run by the system: 

Business Explorer

BW Server

Administrator 
Workbench

Staging EngineStaging Engine

BAPIBAPI

InfoCubes
Master Data
InfoCubesInfoCubes

Master DataMaster Data

AnalyzerAnalyzer

        Grid Data        Grid Data Map DataMap Data

APIAPI

OLAP ProcessorOLAP Processor

BrowserBrowser

Meta Data
Repository
Meta Data
Repository

Geo
Coding

GIS
InfoObject

Geo
Coordinates

 
1. In the InfoObject maintenance, flag the geo-relevant characteristics (country, for example) that you 

want to use as geo-characteristics. 

2. You load the corresponding shapefiles [Extern]  into the BW system. You maintain the assignment of 
shape file and master data (mapping between geo-characteristic and shape file). See Maintaining the 
SAPBWKEY for Static Geo-Characteristics [Extern] 

If you want to use the maps to report on geo-characteristics that show information in point form 
(customer, plant, sales office, for example) you have to geocode these characteristics. See 
Geocoding [Extern]. 

3. In the BEx Web Application Designer you include a map in your Web application and connect these 
with a data source and a previously-defined query. By using these attributes, you determine the map 
display and the business-oriented data. 

Finally, you publish the application on the Web. You navigate in the map to report further on the 
geo-relevant data. 
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 Map Attributes 
Definition 
The Map Web item consists of the objects Map and Map layer. They are used to display business data 
geographically.  

Use 
You use the Map object to define a map’s basic display.  

The Map Layer object is used to define the different map layers; map layers are components, with which 
you construct a map. 

Attributes control how a map and its layers are displayed in the Web application.  

You can find informationen about layer attributes under Attributes for Map Layers [Seite 178]. 

The following section looks at attributes for the Map object. 

Structure 
The map object has two kinds of attributes, as do all other Web items: 

1. General attributes that are fundamental to all display types. 

The general attributes for the Map object are the same as the general attributes [Seite 38] for all 
Web items. The Map object also has some additional general attributes. In the Web Application 
Designer, you can find the general attributes in the Properties window, on the Web item → 
General  tab page.  

2. Special attributes which depending on the individual Web item. 

In the Web Application Designer, you can find the special attributes in the Properties window, on 
the Web item → Special  tab page. 

General attributes 

Attribute Values Description 

Title (CAPTION)  Title of the map 

Generate title 

(GENERATE_CAPTION) 

 

• ‘X’ = Yes 

• ‘ ‘ = No 

Default setting ‘X’ = Yes 

 

Setting the indicator 
automatically generates a title 
for the map as in 
"SAPBEXTableCaption".  

Width in pixels 

(WIDTH) 

Input in pixels 

Standard setting “300” 

Width of the map and legend 
in pixels 

Map height 

(HEIGHT) 

Input in pixels 

Standard setting “300” 

Height of the map in pixels 
taking geographic relations 
into consideration 

Compute map height 
automatically 

(IGNORE_HEIGHT) 

• ‘X’ = Yes 

• ‘ ‘ = No 

Default setting ‘X’ = Yes 

Ignores the height set 
manually (map height 
attribute) and calculates the 
height automatically using the 
height/width relationship in the 
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  underlying map. 

(BORDER_STYLE) • With border 

• Without border 

• For form 

Default setting “No borders” 

Type of border drawn around 
object. 

Collapsed 

(CLOSED) 
• ‘X’ = Yes 

• ‘ ‘ = No 

Default setting ‘ ‘ = No 

Setting the indicator means 
the map is collapsed when the 
Web application is opened. 

Hide object 

(HIDDEN) 
• ‘X’ = Yes 

• ‘ ‘ = No 

Default setting ‘ ‘ = No 

If the indicator is set, neither 
the map nor the title is 
displayed in the Web 
application. 

Objects with navigation links 

(GENERATE_LINKS) 

 

• ‘X’ = Yes 

• ‘ ‘ = No 

Default setting ‘X’ = Yes 

 

When the indicator is set, a an 
image map is generated for 
map which enables navigation 
within it. At the same time, the 
corresponding attributes of all 
the levels belonging to the 
map are also set to ‘X’ = Yes. 

Special attributes 
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Attribute Values Description 

Map layers 

(LAYERS) 

 

 This attribute defines which 
layers and the number of 
layers from which your map 
should be built. 

Geo-functions 

(GEO_FUNCTIONS_POS) 

 

• Do not display 

• Top 

• Bottom 

• Left 

• Right 

Default setting: "Do not 
display" 

Position of the geographic 
function bar in relation to the 
map. 

 

Legend position 

(LEGEND_POSITION) 

 

• Left of the map 

• Right of the map 

• no legend 

Default setting "Right of the 
map" 

Position of the legend in 
relation to the map. 

 

Legend size 

(LEGEND_SIZE) 

Input in pixels 

Standard setting “150” 

Size of the legend in pixels 

 

Visible map area • Data with associated 
geography 

Specifies which areas of a 
map are displayed in the Web 
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(MAP_EXTENT) 

 
• data only 

• Data and the all 
available geography  

Default setting: “Data with 
associated geography” 

 

application. This depends on 
the stored data in the 
application. 

“Data with associated 
geography”, the default 
setting, allows you to display 
data taking the corresponding 
geographic context into 
account. 

Map background transparent 

(CART_COLOR_TRANSPAR
ENT) 

 

• ‘X’ = Yes 

• ‘ ‘ = No 

Default setting ‘X’ = Yes 

 

Setting the indicator means 
that the "Map background 
color" attribute is ignored and 
the background appears as 
transparent in the Web 
application. 

 

Background color 

(CART_BACKGROUND_COL
OR) 

 

Color value 

 

Background color of the map. 

The color values are selected 
in a color selection dialog. 

 

Fill color (no data) 

(CART_FILL_COLOR) 

 

Color value 

 

Fill color of a region if it is not 
stored with data. 

The color values are selected 
in a color selection dialog. 

Map outline color 

(CART_OUTLINE_COLOR) 

 

Color value 

 

Color of the map outline. 

The color values are selected 
in a color selection dialog. 

Map outline width 

(CART_OUTLINE_WIDTH) 

Input in pixels 

Standard setting “1” 

Width of the map outline in 
pixels. 
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 Attributes for Map Layers 
Definition 
Objects that define the different layers in a map. 

Use 
The layers of a map contain different geographic and business information. The individual layers are laid 
over one another in the Web application and, in this way, make up the overall view of the map. You can 
show or hide individual layers and change the information contained in a map. 

For each map layer, you must define how the data is displayed in this layer. Do this by selecting a Map 
Renderer [Seite 203]. 

Structure 
The Map Layer object has two kinds of attributes, as do all other Web items: 

1. General attributes that are fundamental to all display types. 

The general attributes for the Map Layer object are the same as the general attributes for all Web 
items. In the Web Application Designer, you can find the general attributes in the Properties 
window, on the Web item →  General  tab page.    

See General Attributes [Seite 38] 

2. Special attributes that vary according to the selected map renderer. 

Special attributes appear in the Web Application Designer depending on the map renderer, in the 
Web item  → Special  tabpage. 

 
You can select the map renderer from the selection list of the Renderer for a Map on the Web 
Item → Special tabpage. 

You can find additional information about the special attributes for the individual map renderer 
under  

Special Attributes for Color Shading [Seite 180]  

Special Attributes for Bar Charts [Seite 182] 

Special Attributes for Pie Charts [Seite 184] 

Special Attributes for Pie Charts (split) [Seite 186] 

Special Attributes for Dot Densities [Seite 187] 

Special Attributes for Symbol [Seite 189] 

Special Attributes for Symbol (Size-dependent) [Seite 191] 

Special Attributes for Symbol (Color-dependent) [Seite 193] 

Special Attributes for Line [Seite 195]  

Special Attributes for Line (Size-dependent) [Seite 197] 

Special Attributes for Lines (Color-dependent) [Seite 199] 
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Web Application Design: BEx Web Application Designer 30B
 179 



SAP Online Help  13.05.2002 

 Special Attributes for Color Shading 
Definition 
A map renderer, with which you determine how BW data is displayed in a map layer. 

Use 
The color shading map renderer allows you to display color classes that correspond to special value 
classes.  

Structure 
Attribute Values Description 

Number of classes 

(CLASSES) 

 Number of color levels 
(variable “n”) 

Initial color 

(COLOR_START) 

 

Color value 

 

Defines the color of the 
symbol that represents the 
smallest data value in the 
connected data source. 

The color values are selected 
in a color selection dialog. 

End color 

(COLOR_END) 

Color value Defines the color of the 
symbol that represents the 
largest data value in the 
connected data source. 

The color values are selected 
in a color selection dialog. 

Individual values 

(CS_DYN) 

List Individual values entry for 
color and class boundaries. 

Color interpolation 

(COLOR_INTERPOLATION) 

RGB (Color value) 

HSB (color area) 

You can determine the color 
interpolation method here. 
Colors between the start and 
the end color are interpolated 
linearly.  

Color (if no data) 

(COLOR_NONE) 

Color value Defines a color value for filling 
all the regions of a map that 
do not have data in the 
connected data source.  

The color values are selected 
in a color selection dialog.  

ToolTip for map layer 

(GENERATE_TOOLTIP) 

‘X’ = Yes, ‘  ’ = No 

Default setting: ‘X’ = Yes 

This attribute allows you to 
display tooltips for the map 
layer. 

Map Layer Label 

(LABEL) 

“No Label” 

“Text as label” 

This attribute allows you to 
label the map. 
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“Key as label” 

Default setting: “No Label” 

Affected DataProvider 

(TARGET_DATA_PROVIDER
) 

List List of data providers to which 
all commands of the map layer 
are sent. 

Map interaction control 

(IMAGEMAP_PATTERN) 

“Normal context menu after 
clicking on map” 

“Filtering for data providers 
after clicking on map” 

 

How the map interaction 
appears.  You can use this 
attribute to determine which 
action is to take place when 
clicking on the map, as an 
alternative to the context 
menu.  

You can find additional 
information about this attribute 
in the WEB API Reference, 
section Web Item → Map 
→ Map Layer. 
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 Special Attributes for Bar Charts 
Definition 
A map renderer, with which you determine how BW data is displayed in a map layer. 

Use 
You can display values in the form of bars with the bar chart map renderer. 

Structure 
Attribute Values Description 

Bar height 

(BAR_HEIGHT) 

 

Input in pixels 

Default value: “30” 

 

Defines the maximum height 
of a bar in the diagram. This 
height corresponds to the 
largest value of the connected 
data source. 

Bar width 

(BAR_WIDTH) 

Input in pixels 

Default value: “10” 

Defines the width of the bar in 
the diagram. 

Individual color values 

(COLOR_VALUE) 

 

 

 

Entry for individual color 
values  

 

ToolTip for map layer 

(GENERATE_TOOLTIP) 

‘X’ = Yes, ‘  ’ = No 

Default setting: ‘X’ = Yes 

This attribute allows you to 
display tooltips for the map 
layer. 

Map Layer Label 

(LABEL) 

 

“No Label” 

“Text as label” 

“Key as label” 

Default setting: “No Label” 

This attribute allows you to 
label the map. 

 

Affected DataProvider 

(TARGET_DATA_PROVIDER
) 

List 

 

List of data providers to which 
all commands of the map layer 
are sent. 

Map interaction control 

(IMAGEMAP_PATTERN) 

 

“Normal context menu with 
click on map” 

“Filtering for data providers 
with click on map” 

 

How the map interaction 
appears. You can use this 
attribute to determine which 
action is to take place when 
clicking on the map, as an 
alternative to the context 
menu.  

You can find additional 
information about this attribute 
in the WEB API Reference, 
section Web Item® Map ®Map 
Layer. 
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 Special Attributes for Pie Charts 
Definition 
A map renderer, with which you determine how BW data is displayed in a map layer. 

Use 
You can display values in the form of pie charts with the pie chart renderer. 

Structure 
Attribute Values Description 

Individual color values 

(COLOR_VALUE) 

 

 

Entry for individual color 
values  

Pie diameter (maximum) 

(PIE_MAX) 

Input in pixels Defines the largest diameter of 
a circle in the diagram. This 
diameter is the sum of all the 
maximum values displayed in 
the Web application. 

If you set "circle diameter 
(minimum) = circle diameter 
(maximum)“, all the circles in 
the Web application are 
displayed with the same 
diameter. 

Pie diameter (minimum) 

(PIE_MIN) 

 

Input in pixels Defines the smallest diameter 
of a circle in the diagram. This 
diameter is the sum of all the 
minimum values displayed in 
the Web application. 

If you set "circle diameter 
(minimum) = circle diameter 
(maximum)“, all the circles in 
the Web application are 
displayed with the same 
diameter. 

ToolTip for map layer 

(GENERATE_TOOLTIP) 

‘X’ = Yes, ‘  ’ = No 

Default setting: ‘X’ = Yes 

This attribute allows you to 
display tooltips for the map 
layer. 

Map Layer Label 

(LABEL) 

 

“No Label” 

“Text as label” 

“Key as label” 

Default setting: “No Label” 

This attribute allows you to 
label the map. 

 

Affected DataProvider 

(TARGET_DATA_PROVIDER
) 

List 

 

List of data providers to which 
all commands of the map layer 
are sent. 
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Map interaction control 

(IMAGEMAP_PATTERN) 

 

“Normal context menu with 
click on map” 

“Filtering for data providers 
with click on map” 

 

How the map interaction 
appears. You can use this 
attribute to determine which 
action is to take place when 
clicking on the map, as an 
alternative to the context 
menu.  

You can find additional 
information about this attribute 
in the WEB API Reference, 
section Web Item® Map ®Map 
Layer. 
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 Special Attributes for Pie Charts (split) 
 
Definition 
A map renderer, with which you determine how BW data is displayed in a map layer. 

Use 
You can use the split pie chart renderer to display values in the form of split pie charts. In a split pie chart, 
the split occurs automatically if there is a "change of group" (that is from sales for the 1st quarter of 2001 to 
the sales for the 2nd quarter of 2001). 

Structure 
The special attributes of the split pie chart renderer are identical with the special attributes of the pie chart 
renderer.  

See Special Attributes for the Pie Chart Renderer [Seite 184]. 
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 Special Attributes for Dot Density 
Definition 
A map renderer, with which you determine how BW data is displayed in a map layer. 

Use 
You can use the dot density renderer to display values in a map using dot densities.  

Structure 
Attribute Values Description 

Dot base value 

(BASE_VALUE) 

 Describes the basis value for a 
dot (symbol). Example: When 
choosing the value 1000 for 
the BASE_VALUE 
(“BASE_VALUE = 1000”), 
and the data value for France, 
say, is 7400, the system 
produces the result 
7400/1000= 7.4 (rounded to 
7). 7 dots appear in the France 
map area, and these dots are 
distributed randomly. 

Color (COLOR) Color value Dot color (symbols) 

The color value is selected via 
a color selection dialog box. 

Maximum density, per cent 

(DENSITY) 

Input in percent Defines how dense the points 
should be displayed in a 
region for the largest value of 
the connected data source. 

The attributes "Value for a 
symbol" and "Maximum 
density in %" are self-
exclusive and may not be 
used at the same time. 

Size/With 

(SIZE) 

Input in pixels Defines the size of the points 
(symbols).  

Symbol type 

(STYLE) 

“Circle” 

“Rectangle” 

“Triangle” 

“Cross” 

Defines the symbol with which 
the data is displayed in a 
layer. 

 

ToolTip for map layer 

(GENERATE_TOOLTIP) 

‘X’ = Yes, ‘  ’ = No 

Default setting: ‘X’ = Yes 

This attribute allows you to 
display tooltips for the map 
layer. 

Map Layer Label “No Label” This attribute allows you to 
l b l h
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(LABEL) 

 

“Text as label” 

“Key as label” 

Default setting: “No Label” 

label the map. 

 

Affected DataProvider 

(TARGET_DATA_PROVIDER
) 

List 

 

List of data providers to which 
all commands of the map layer 
are sent. 

Map interaction control 

(IMAGEMAP_PATTERN) 

 

“Normal context menu with 
click on map” 

“Filtering for data providers 
with click on map” 

 

How the map interaction 
appears. You can use this 
attribute to determine which 
action is to take place when 
clicking on the map, as an 
alternative to the context 
menu.  

You can find additional 
information about this attribute 
in the Web API Reference, 
section Web Item→ Map 
→Map Layer. 
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 Special Attributes for Symbols 
Definition 
A map renderer, with which you determine how BW data is displayed in a map layer. 

Use 
You can display values using symbols with the Symbol renderer. 

Structure 
Attribute Values Description 

Color 

(VALUE) 

Color value Symbol color as RGB value 

The color values are selected 
in a color selection dialog. 

Size/With 

(SIZE) 

Input in pixels 

 

Defines the size of the 
symbols that represent the 
data. 

Symbol type 

(STYLE) 

Circle 

Rectangle 

Triangle 

Cross 

Defines the symbol with which 
the data is displayed in a 
layer. 

ToolTip for map layer 

(GENERATE_TOOLTIP) 

 

‘X’ = Yes, ‘  ’ = No 

Default setting: ‘X’ = Yes 

 

This attribute allows you to 
display tooltips for the map 
layer. 

Map Layer Label 

(LABEL) 

 

“No Label” 

“Text as label” 

“Key as label” 

Default setting: “No Label” 

This attribute allows you to 
label the map. 

 

Affected DataProvider 

(TARGET_DATA_PROVIDER
) 

 

List 

 

List of data providers to which 
all commands of the map layer 
are sent. 

 

Map interaction control 

(IMAGEMAP_PATTERN) 

 

“Normal context menu with 
click on map” 

“Filtering for data providers 
with click on map” 

 

How the map interaction 
appears. You can use this 
attribute to determine which 
action is to take place when 
clicking on the map, as an 
alternative to the context 
menu.  

You can find additional 
information about this attribute 
in the Web API Reference, 
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section Web Item→ Map 
→Map Layer. 
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 Special Attributes for Symbol (Size-dependent) 
Definition 
A map renderer, with which you determine how BW data is displayed in a map layer. 

Use 
You can use the symbol (size-dependent) renderer to display values using size-dependent symbols. The 
renderer takes the location and data values for this location into consideration. The size of the symbols 
depends on the data. 

Structure 
Attribute Values Description 

Number of classes 

(CLASSES) 

 

 Number of size levels (variable 
“n”) 

Color 

(COLOR) 

 

Color value 

 

Symbol color 

The color values are selected 
in a color selection dialog. 

Individual values 

(SG_SYM_DYN) 

List Individual values entry for 
symbol sizes and class 
boundaries. 

Symbol (end size)/ 

Line (end width) 

(SIZE_END) 

 

Input in pixels 

 

Defines the symbol size  / line 
width that represents the 
largest data value in the 
connected data source. 

Symbol (starting size) / 

Line (starting width) 

(SIZE_START) 

Input in pixels 

 

Defines the symbol size  / line 
width that represents the 
smallest data value in the 
connected data source. 

Symbol type 

(Style) 

“Circle” 

“Rectangle” 

“Triangle” 

“Cross” 

Defines the symbol with which 
the data is displayed in a 
layer. 

 

ToolTip for map layer 

(GENERATE_TOOLTIP) 

‘X’ = Yes, ‘  ’ = No 

Default setting: ‘X’ = Yes 

This attribute allows you to 
display tooltips for the map 
layer. 

Map Layer Label 

(LABEL) 

 

“No Label” 

“Text as label” 

“Key as label” 

Default setting: “No Label” 

This attribute allows you to 
label the map. 
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Affected DataProvider 

(TARGET_DATA_PROVIDER
) 

List 

 

List of data providers to which 
all commands of the map layer 
are sent. 

Map interaction control 

(IMAGEMAP_PATTERN) 

 

“Normal context menu with 
click on map” 

“Filtering for data providers 
with click on map” 

 

How the map interaction 
appears. You can use this 
attribute to determine which 
action is to take place when 
clicking on the map, as an 
alternative to the context 
menu.  

You can find additional 
information about this attribute 
in the WEB API Reference, 
section Web Item→ Map 
→Map Layer. 
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 Special Attributes for Symbol (Color-dependent) 
Definition 
A map renderer, with which you determine how BW data is displayed in a map layer. 

Use 
You can display values using color-dependent symbols with the Symbol (color-dependent) renderer. The 
renderer takes the location and data values for this location into consideration. The color of the symbols 
depends on the data. 

Structure 
Attribute Values Description 

Individual values 

(CG_SYM_DYN) 

 Individual values entry for 
color values and class 
boundaries. 

Number of classes 

(CLASSES) 

 Number of color levels 
(variable “n”) 

End color 

(COLOR_END) 

 

Color value 

 

Defines the color of the 
symbol that represents the 
largest data value in the 
connected data source. 

The color values are selected 
in a color selection dialog. 

Color interpolation 

(COLOR_INTERPOLATION) 

RGB 

HSB 

 

Color interpolation method 

Defines the method with which 
the color values that lie 
between the starting and end 
colors are interpolated. These 
color values represent the 
data that lies between the 
smallest and largest values of 
the data source. 

Initial color 

(COLOR_START) 

 

Color value 

 

Defines the color of the 
symbol that represents the 
smallest data value in the 
connected data source. 

The color values are selected 
in a color selection dialog. 

Size/With 

(SIZE) 

Input in pixels 

 

Defines the size of the 
symbols that represent the 
data. 

Symbol type 

(STYLE) 

Circle 

Rectangle 

Triangle 

Describes how a symbol is 
displayed. 
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Cross 

ToolTip for map layer 

(GENERATE_TOOLTIP) 

‘X’ = Yes, ‘  ’ = No 

Default setting: ‘X’ = Yes 

This attribute allows you to 
display tooltips for the map 
layer. 

Map Layer Label 

(LABEL) 

 

“No Label” 

“Text as label” 

“Key as label” 

Default setting: “No Label” 

This attribute allows you to 
label the map. 

 

Affected DataProvider 

(TARGET_DATA_PROVIDER
) 

 

List List of data providers to which 
all commands of the map layer 
are sent. 

 

Map interaction control 

(IMAGEMAP_PATTERN) 

 

“Normal context menu with 
click on map” 

“Filtering for data providers 
with click on map” 

 

How the map interaction 
appears. You can use this 
attribute to determine which 
action is to take place when 
clicking on the map, as an 
alternative to the context 
menu.  

You can find additional 
information about this attribute 
in the Web API Reference, 
section Web Item→ Map 
→Map Layer. 
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 Special Attributes for Line 
Definition 
A map renderer, with which you determine how BW data is displayed in a map layer. 

Use 
The Line renderer displays values with a line going from a starting to an end point. 

Structure 
Attribute Values Description 

Color 

(COLOR) 

 

Color value 

 

Line color. 

The color values are selected 
in a color selection dialog. 

Layer (starting points) 

(FROM_LAYER) 

 

 Layer for starting points 

Defines the layer on which the 
line’s starting points lie. 

All starting points must lie on 
one layer. 

 

Line type 

(LINE_STYLE) 

 

“Continuous” 

“Dotted” 

“Dashed” 

 

Defines how the lines are 
displayed. 

 

Size/With 

(SIZE) 

Input in pixels 

 

Defines the width of the line. 

Layer (end points) 

(TO_LAYER) 

 Layer for end points 

Defines the layer on which the 
end points of the lines lie. 

All end points must lie on one 
layer. 

ToolTip for map layer 

(GENERATE_TOOLTIP) 

‘X’ = Yes, ‘  ’ = No 

Default setting: ‘X’ = Yes 

This attribute allows you to 
display tooltips for the map 
layer. 

Map Layer Label 

(LABEL) 

 

“No Label” 

“Text as label” 

“Key as label” 

Default setting: “No Label” 

This attribute allows you to 
label the map. 

 

Affected DataProvider 

(TARGET_DATA_PROVIDER
)

List 

 

List of data providers to which 
all commands of the map layer 
are sent. 
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) 

Map interaction control 

(IMAGEMAP_PATTERN) 

 

“Normal context menu after 
clicking on map” 

“Filter data providers after 
clicking on map” 

 

How the map interaction 
appears. You can use this 
attribute to determine which 
action is to take place when 
clicking on the map, as an 
alternative to the context 
menu.  

You can find additional 
information about this attribute 
in the WEB API Reference, 
section Web Item→ Map 
→Map Layer. 
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 Special Attributes for Line (Size-dependent) 
Definition 
A map renderer, with which you determine how BW data is displayed in a map layer. 

Use 
You can use the bar chart map renderer to display values in the form of bars. 

Structure 
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Attribute Values Description 

Number of classes 

(CLASSES) 

 Number of size levels (variable 
“n”) 

Color 

(COLOR) 

 

Color value 

 

Line color. 

The color values are selected 
in a color selection dialog. 

 

Line type 

(LINE_STYLE) 

 

“Continuous” 

“Dotted” 

“Dashed” 

Defines how the lines are 
displayed. 

 

Individual values 

(SG_LI_DYN) 

 Entry of individual values for 
line width and class boundary. 

Symbol (end width) / line (end 
width) 

(SIZE_END) 

 Symbol/line end width 

Symbol (start width) / line 
(start width) 

 Symbol/Line start width 

ToolTip for map layer 

(GENERATE_TOOLTIP) 

‘X’ = Yes, ‘  ’ = No 

Default setting: ‘X’ = Yes 

This attribute allows you to 
display tooltips for the map 
layer. 

Map Layer Label 

(LABEL) 

 

“No Label” 

“Text as label” 

“Key as label” 

Default setting: “No Label” 

This attribute allows you to 
label the map. 

 

Affected DataProvider 

(TARGET_DATA_PROVIDER
) 

List 

 

List of data providers to which 
all commands of the map layer 
are sent. 

Map interaction control 

(IMAGEMAP_PATTERN) 

 

“Normal context menu with 
click on map” 

“Filtering for data providers 
with click on map”

How the map interaction 
appears. You can use this 
attribute to determine which 
action is to take place when 
li ki th
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with click on map” 

 

clicking on the map, as an 
alternative to the context 
menu.  

You can find additional 
information about this attribute 
in the WEB API Reference, 
section Web Item→ Map 
→Map Layer. 
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 Special Attributes for Lines (Color-dependent) 
Definition 
A map renderer, with which you determine how BW data is displayed in a map layer. 

Use 
The line (color-dependent) renderer displays values with a line from the starting to the end point. The data 
values define the color of a line. 

Structure 
Attribute Values Description 

Individual values 

(CG_LI_DYN) 

 Individual values entry for 
color values and class 
boundaries. 

Number of classes 

(CLASSES) 

 Number of color levels 
(variable “n”) 

End color 

(COLOR_END) 

 

Color value Defines the color of the 
symbol that represents the 
largest data value in the 
connected data source. 

The color values are selected 
in a color selection dialog. 

Color interpolation 

 

RGB 

HSB 

 

Defines the method with which 
the color values that lie 
between the starting and end 
colors are interpolated. These 
color values represent the 
data that lies between the 
smallest and largest values of 
the data source. 

Initial color 

(COLOR_START) 

 

Color value 

 

Defines the color of the 
symbol that represents the 
smallest data value in the 
connected data source. 

The color values are selected 
in a color selection dialog. 

Line type 

(LINE_STYLE) 

 

“Continuous” 

“Dotted” 

“Dashed” 

Defines how the lines are 
displayed. 

 

Size/With 

(SIZE) 

Input in pixels Defines the width of the line. 

 

ToolTip for map layer 

(GENERATE_TOOLTIP) 

‘X’ = Yes, ‘  ’ = No 

Default setting: ‘X’ = Yes 

This attribute allows you to 
display tooltips for the map 
layer. 
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Map Layer Label 

(LABEL) 

 

“No Label” 

“Text as label” 

“Key as label” 

Default setting: “No Label” 

This attribute allows you to 
label the map. 

 

Affected DataProvider 

(TARGET_DATA_PROVIDER
) 

List 

 

List of data providers to which 
all commands of the map layer 
are sent. 

Map interaction control 

(IMAGEMAP_PATTERN) 

 

“Normal context menu with 
click on map” 

“Filtering for data providers 
with click on map” 

 

How the map interaction 
appears. You can use this 
attribute to determine which 
action is to take place when 
clicking on the map, as an 
alternative to the context 
menu.  

You can find additional 
information about this attribute 
in the WEB API Reference, 
section Web Item® Map ®Map 
Layer. 
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 Array Attributes 
Use 
Some map attributes are the so-called array attributes. You can recognize these attributes by the suffix 
“(n)“ (see to Map Attributes [Extern]). 

This section describes the function of array attributes. 

The following are array attributes: 

• Symbol size (n) 

• Class boundary (n) 

• Color value (n) 

•  Line width (n) 

• Bar color (n) 

• Segment color (n) 

 
The variable n is the number of classes. You can set this variable with the attribute class 
number 

Example 
Use the above attributes to change the default settings in the system. The default settings provide a linear 
calculation of the interim values for each class. 

For example: symbol size (n) 

If the attribute symbol size (n)  is not set, the size of the symbols displayed in a map, starting with starting 
value A and ending with end value B, are distributed linearly across the number of classes. If you have for 
example 4 classes, a starting size of 8 and an end size of 20 points, you would get the following values for 
the individual class sizes:  

Class 1 -8 points • 

• 

• 

• 

• 

• 

• 

• 

Class 2 -12 points 

Class 3 -16 points 

Class 4 -20 points 

You can adjust this automatic assignment by manually setting the values for the attribute symbol size (n), 
for example, in the following way:  

Class 1 -8 points 

Class 2 -10 points 

Class 3 -12 points 

Class 4 -20 points 

 
The attributes symbol size (n), color value (n) and line width (n) are always bound to the 
attribute class boundary (n). That is, when you set one of these attributes, you also need to 
set a value for the corresponding class boundary.  
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For further information about the use of these objects, go to the SAP Service Marketplace on the BW 
pages under Documentation → Documentation Enhancements → Web API Reference in the section Web 
Items → Maps. 
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 Map Renderer 
Definition 
With a map renderer, you determine how BW data is displayed on a map layer. 

• Symbol (color-dependent) (COLORGRADUATEDSYMBOL or CG_SYMBOL) 

• Bar charts (BAR) 

• Pie charts (PIE) 

• Pie charts (divided) (SPLITPIE) 

Structure 
There are 11 different map renderers in the BEx Web Application Designer. These renderers are divided 
into three different classes: 

Class 1: Renderers that relate to polygonal areas (static geo-characteristics). They display the following: 

• Color shading (COLORSHADING or CS) 

• Bar charts (BAR) 

• Pie charts (PIE) 

• Pie charts (divided) (SPLITPIE) 

• Pixel density (DOTDENSITY or D_DENSITY) 

For these renderers, the static geo-characteristic must appear in the related data provider in the 
rows and the values to be displayed in the renderer must be in the columns. You can use 
hierarchies in both cases. You cannot have any other characteristic other than the geo-
characteristic, or any key figure in the rows. You can use several characteristics or key figures in 
the columns. 

Class 2: Renderers that relate to locations (dynamic geo-characteristics). They display the following: 

• Symbol (SYMBOL) 

• Symbol (size-dependent) (SIZEGRADUATEDSYMBOL or SG_SYMBOL) 

For these renderers the dynamic geo-characteristic must appear in the data provider belonging to 
it in the rows. You must have also selected the Longitude and Latitude display attributes to be 
displayed. You cannot have any other characteristics or key figures in the rows. Only the first 
column is considered by the symbol renderers. The renderers bar chart, pie chart and pie chart 
(divided) consider all columns. 

Class 3: Renderers that display relationships between locations (dynamic geo-characteristics): 

• Line (LINE) 

• Line (size-dependent) (SIZEGRADUATEDLINE or SG_LINE) 

• Line (color-dependent) (COLORGRADUATEDLINE or CG_LINE) 

It is important to have at least three map layers for these renderers. You define Start Point in one 
map layer and the End Point in another map layer. The prerequisites described in class 2 are also 
valid for both of these map layers. The third map layer contains the relationship between the 
dynamic geo-characteristics Start Point and End Point, that is, both characteristics must be in the 
rows. The same prerequisites are valid for the columns as described in class 2. 
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For those map renderers that have a long technical name, you can specify a shorter, 
alternative name (for example, COLORGRADUATEDLINE or CG_LINE). Both variations are 
supported. 

Integration 
So that you can present the BW business data on individual map layers graphically, you have to assign a 
map renderer to each map layer in the BEx Web Application Designer and determine the properties for 
this renderer. 

Example of a Renderer in Class 3 
Map layer query view that describes the relationship 

Sales Office Sales Representative 

100 $ 

A 2 150 $ 

A 120 $ 

B 11 

80 $ 

Map layer query view that describes the start point 

Sales Office Longitude Latitude # Employees 

Sales 

A 1 

3 

90 $ 

B 12 

A 2.3 3.4 120 

A 2.3 3.4 15 

A 2.3 3.4 120 

B -3.5 -2.0 87 

B -3.5 -2.0 80  

Map layer query view that describes the end point 

Sales 
Representative 

Longitude Latitude # Customers 

1 2.8 4.7 12  

2 2.6 5.7 11  

3 2.4 6.7 13  

 

12 -3.4 -1.8 21  

11 -3.8 -1.2 23 
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 Single Document 
Definition 
Web item allowing you to display single documents that you created in the Administrator Workbench or in 
master data maintenance for master data in the Web application. 

 
You can create the documents in different formats and versions (see 

Use
Documents [Extern]). For example 

you can add several documents such as route directions and a picture of the local office for each value of 
a characteristic, such as Business partner. You can use the document type attribute to decide which 
document you want to display in the Web application. 

 Structure
As well as its general attributes [Seite 38], the Web item  Single document has the following attributes: 

Attributes Description 

Characteristics (IOBJNM) Name of the characteristic which the Web item 
Single document should reference. 

Give the technical name of the characteristic 
here (25 character string). 

Document type (WWW_DOC_TYPE) If you created several documents for a 
characteristic in the Administrator Workbench 
or in the master data maintenance screen, the 
different document types that reference the 
characteristic are displayed here for selection. 

 
If you do not make an entry here, 
the system assumes that there is a 
document for the selected 
characteristic. 

If this is not the case you get a 
message 

Default picture (DEFAULT_PICTURE_URL) Absolute or relative URL for a picture. This 
picture is displayed in a Web item if no 
document has been found, or if the document 
is not consistent. Pictures from the MIME 
Repository can be selected here using a 
relative address.  

− that no document was found or 

− that the document is not unique (there 
is more than one) 
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Document display style (IS_INPLACE) 
‘X’ = Yes, ‘  ’ = No 

You can define if the single document is 
displayed 

with this attribute. 

Inplace ("X") is especially suitable for screens 
and short texts. 

Links to document display 
(LINK_TO_BROWSER) 
‘X’ = Yes, ‘  ’ = No 

You can use this attribute to determine whether 
you can link from the document to the general 
document display. 

If the value is set to X, clicking on the picture 
displays all documents for the currently filtered 
characteristic value (or all documents for the 
characteristic master data, if no value is in the 
filter) in a separate window. 

• in the Web application (“X”) 

• in a separate window (" ") 
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 List of Documents 
Definition 
Web item that displays a list of documents in the Web application. You can also create new documents 
[Extern] yourself in the Web application. 

Use 
The Web item List of Documents enables you to call or create context-sensitive information about the 
transaction data used in the Web application. If you navigate in the Web application and, for example, 
restrict a characteristic to a certain characteristic value, the list of documents is automatically adjusted. 
This means that only the documents that are relevant for the restricted navigation status appear. 

 
The documents for the characteristics that were set as the Document Properties in the 
Administrator Workbench appear automatically in the list. 

Structure 
The Web item  List of Documents has the following structure: 

• Context 
The context is the counterpart to the navigation block and shows the characteristics that are 
Document Properties and are contained in the basic data provider (query or query view), and their 
values. 

 
If you have already inserted a navigation block into your Web template, you do not need the 
context information in the list of documents if you want to see only those documents that refer 
to the numbers of the table. 

The context is adjusted dynamically depending on the navigation in the Web application. This 
means that the list of documents displays only those documents that refer to the requested data in 
the table. If the context can be changed, you can also focus on the documents and, for example, 
display all the documents that refer to the InfoProvider. 

You can set the following in the Web Application Designer using attributes: 

− Whether or not you want to display the context 

− Whether or not you can change the context in the Web report 

• Further Functions 
You can also: 

− Create a new document [Extern] 

− Set whether or not the characteristics of the documents are to be displayed 

− Choose all the selections. In the context, all the characteristics for which you can restrict the list of 
documents or a new document are displayed. 

• List of Documents 
The links to the documents are listed here in alphabetical order.  

In addition to its general attributes [Seite 38], the List of Documents Web item has the following attributes: 
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Attributes Description 

Display Properties 
(SHOW_PROPERTIES) 
‘X’ = Yes, ‘  ’ = No 

This attribute indicates if the document 
property is to be displayed. The document 
properties tell you about how the documents 
are assigned, for example base planning object 
4711, month of May. The context to which the 
document was restricted determines the 
assignment. 

 
If a document property is identical 
for all selected documents, this 
property is not displayed under the 
document link. 

You define the initial display with the Document 
Properties attribute. Using Further Functions, 
you can  toggle the display of the properties in 
the Web application. 

 
Furthermore, in the 
PROPERTY_LIST attribute you 
can set which additional document 
properties need to be displayed 
here. 

 

Context Information 
(SHOW_CONTEXT) 
'X' = is changeable 

'N'  = is not changeable, but is displayed 

 ' ' = is not displayed 

With this attribute you can indicate whether the 
context, meaning the selection conditions for 
the documents for the List of Documents Web 
item, is displayed, as well as whether these 
selection conditions are changeable. 

Number of Rows in the Table 
(BLOCK_SIZE) 

With this attribute you can define the number of 
rows (document links and properties) that are 
displayed at one time. If there are not enough 
rows, an index for scrolling appears in the 
bottom row. 

Maximum Number of Displayed Values 
(MAXVALUES) 

With this attribute you can define the maximum 
number of characteristic values to be displayed 
in the dropdown box of the context. 

Document Changeable 
(DOCUMENTS_ARE_CHANGEABLE) 
‘X’ = Yes, ‘  ’ = No 

With this attribute you can define whether 
documents can be created, changed, or 
deleted. 
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Frame for Display 
(TARGET_FRAME) 

Here, you can specify an HTML frame in which 
the individual documents that you call from the 
list of documents is displayed. 

 
The HTML frame must be 
integrated in the Web template. 

If you use the Web template within 
a frame set, you can also integrate 
the List of Documents Web item in 
another frame of this set. 

If you do not define an HTML frame, the 
individual documents are displayed in separate 
windows. 

Additional Properties 
(PROPERTY_LIST) 

Additional document properties that are 
displayed for each document displayed in the 
Web item. Here, you can set the following 
properties: 

LAST_CHANGED_BY: Last person to make 
changes 

LAST_CHANGED_AT: Change time 

CREATED_BY: Creator 

CREATED_AT: Creation time 

CHECKOUT_USER: Editor 

LANGUAGE: Language 
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 Ad-hoc Query Designer 
Definition 
A Web item that enables you to create and change queries in a Web application on an ad-hoc basis. 

Use 
You can use the  Ad-hoc Query Designer Web item in the Web Application Designer to structure Web 
applications in which you create or change queries. The Web item is as a tool for designing ad-hoc 
queries in a Web environment. 

In particular it enables you to: 

• Create queries by assigning characteristics from an InfoProvider to rows, columns, filters, and free 
characteristics, and including key figures from the InfoProvider in the key figure structure of the query. 

• Restrict or filter key figures and characteristics 
• Use predefined key figure structures and restricted or calculated key figures in the query 
• Set or change query properties and key figure/characteristic properties in the query 

Create or change conditions and exceptions • 
When compared with the BEx Query Designer [Extern], the Ad-hoc Query Designer Web item has the 
following restrictions when creating or changing queries: 

• You cannot integrate variables into the query directly. 
However, you can use variables in reusable structures, or restricted or calculate key figures, 
which are used in the Ad-hoc Query Designer 

• The query can contain only one structure. This structure has to be the key figure structure and be in 
the rows or columns of the query. 
− You cannot use key figures or key figure structures in the filter. 
− You cannot define exception cells, since this requires two structures. 

 
You cannot create reusable structures or restricted or calculated key figures in the Ad-hoc 
Query Designer Web item. 

 
You can edit existing queries in the Ad-hoc Query Designer Web item, if the queries adhere to 
the restrictions laid out above The Ad-hoc Query Designer checks these requirements when 
loading a query. If the query is too complex, the query can be loaded into the Ad-hoc Query 
Designer but you cannot change it there. You then receive the appropriate message. You can 
still check and execute the query. 

Structure 
As well as its generic attributes [Seite 38], the Ad-hoc Query Designer Web item has the following 
attributes: 

Attributes Description 
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InfoProvider Name (INFOCUBE) Technical name of the InfoProvider used to 
start the Ad-hoc Query Designer. 

Double-click on the empty value cell next to the 
attribute InfoProvider Name. The BEx Open 
dialog box appears. Select the InfoProvider 
that you want to use from your history or from 
the complete list under InfoAreas. 

Name of Query (QUERY) Technical name of the query used to start the 
Ad-hoc Query Designer. 

Double-click on the empty value cell next to the 
attribute Name of Query. The BEx Open dialog 
box appears. Select the query from your 
history, favorites or roles of from the complete 
list under InfoAreas. 

Template for Output 
(TARGET_TEMPLATE_ID) 
optional 

Name of the Web template used to display the 
query result. 

Double-click on the empty value cell next to the 
attribute Template for Output. The BEx Open 
dialog box appears. Select the Web template 
from your history, favorites, roles, or the list of 
workbooks. 

 
If you do not specify a Web 
template, the default Web template 
is used. 

Frame for Query Output (TARGET_FRAME) 
optional 

Frame in which the query is displayed when 
executed. 

If you specify a frame, the query output is 
controlled within this frame. Otherwise the 
query is displayed in a new browser window. 

Prerequisites for specifying a frame: 

You have created a frameset in an external 
HTML editor or manually (in Notepad). 
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Action on Execution 
(ON_EXECUTE) 

You can use this attribute to determine what 
happens to the Ad-hoc Query Designer Web 
item in the Web Application after clicking on the 
Execute pushbutton in the Ad-hoc Query 
Designer. 

The following options are available: 

The query is executed. 

No change is made to the Ad-hoc 
Query Designer Web item. 

The Ad-hoc Query Designer 
disappears when executing the query. 

If you want to open the  Ad-hoc Query 
Designer again, while using the 
standard Web template, click on  in 
the symbol toolbar.  

If you are using a different Web 
template, you need to install the option 
of calling up the Ad-hoc Query 
Designer again manually in the Web 
template. 

The Ad-hoc Query Designer is 
compressed when executing the query. 
You now see the Web item with a 
compressed arrow and title. 

If you want to open the Ad-hoc Query 
Designer again, use the arrow to open 
it. 

• No change to the item 

• Item is hidden 

• Item is compressed  
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Action on closing 
(ON_CLOSE) 

You can use this attribute to determine what 
happens to the Ad-hoc Query Designer Web 
item in the Web Application after clicking on the 
Close pushbutton in the Ad-hoc Query 
Designer. 

The following options are available: 

After closing, the query is closed in the 
ad-hoc query designer. The individual 
fields (rows, columns, filter, free 
characteristics) are now empty. There 
is no change to the Web item itself. 

The Ad-hoc Query Designer 
disappears when closing. 

If you want to open it again in the 
standard Web template, click on  in 
the symbol toolbar. 

If you are using a different Web 
template, you need to install the option 
of calling up the Ad-hoc Query 
Designer again manually in the Web 
template. 

The Ad-hoc Query Designer is 
compressed when closing. You now 
see the Web item with a compressed 
arrow and title. 

If you want to open the Ad-hoc Query 
Designer again, use the arrow to open 
it. 

Display Data Provider 
(DISPLAY_DATA_PROVIDER) 
optional 

Data provider through which you want to 
display the query in the current Web template 
after you have executed it. 

Specify the name of the DataProvider with 
which you want to display the query in the Web 
template. By double-clicking on an empty value 
cell next to the Data Provider Display attribute, 
a dropdown box containing a list of the data 
providers available appears. 

 
If you specify 
DISPLAY_DATA_PROVIDER but 
not TARGET_FRAME or 
TARGET_TEMPLATE_ID, when 
you execute the query the display 
data provider specified is replaced 
in the current Web template. 

• No change to the item 

• Item is hidden 

• Item is compressed  
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If you do not specify the optional attributes DISPLAY_DATA_PROVIDER, TARGET_FRAME 
and TARGET_TEMPLATE_ID, the query results are displayed in a new browser window in 
the default Web template. 

Integration 
You can  work with all queries in the BEx Query Designer, regardless of the tool they were created with. 
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 What If Prediction 
Definition 
The What If Prediction web item enables you to perform online prediction for a single customer record on 
models defined under services such as Decision Tree, Scoring and Clustering.  

Use 
The prediction for prospective customer behavior is based on specific attributes of that customer. For 
example, when a customer applies for a loan, you can predict if the customer is creditworthy or not, based 
on certain attributes such as income, profession or transaction history. 

Structure 
The What If Prediction web item has the following specific attributes: 

 

Attributes Description 
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MODEL_NAME (optional) Name of the mining model  
The name of the model that would be used to perform the 
prediction.  
 
If you do not enter a model name, a drop down box 
containing the names of all the models that are ready for 
prediction  in the selected service would appear in the web 
item. 
 
If you specify a model name, but do not specify the 
corresponding service name to which it belongs, an error will 
be generated.  
 

SERVICE_NAME (optional) Name of the service 
The name of the service for the web item. 
 
If you do not enter the service name, you can choose the 
service from a drop down box containing the list of services 
that support What If Prediction.  
 
If you specify the service name and the model name, then 
the web item will be for that particular service and model 
only.    
 
If you specify the service name but do not specify the model 
name, then the web item will be published for that service. 
You can choose the name of the model from the drop down 
box.  
 

DISPLAY_MODEL 
"X" = Yes, " " = No 

Display Model Name 
Specifies whether the model name should be displayed in 
the web item.  

This option is relevant only if you have specified the model 
name. Otherwise, it will not have any effect. 

 

DISPLAY_SERVICE 
"X" = Yes, " " = No 

Display Service Name 
Specifies whether the service name should be displayed in 
the web item. 
This option is relevant only if you have specified the service 
name.  

DISPLAY_CHART_OPT 
"X" = Yes, " " = No 

Display Chart Customize 
Specifies whether the option to customize the what if 
prediction analysis chart must be displayed or not. 
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 ABC Classification 
Definition 
The ABC Classification  web item allows you to classify objects (Customers, Products or Employees) 
based on a particular measure (Revenue or Profit) using certain classification rules.  

Structure 
The ABC Classification web item has the following specific attributes: 

Attributes Description 

ABC_NAME (optional) Name of the ABC Classification  

The name of the ABC Classification model that would be used.    

If you do not enter a model name, a drop down box containing the 
names of all the models that are ready for prediction in the selected 
service would appear in the web item. 

SHOW_ABC_CLASSIFIC
ATION 
"X" = Yes, " " = No 

Show ABC Classification 
Specifies whether the drop down box for selecting ABC 
Classification should be displayed in the web item.  

This option is relevant only if you have specified the ABC 
Classification. Otherwise, it will not have any effect. 

SHOW_STAT 
"X" = Yes, " " = No 

Display Statistics 
Specifies whether statistical information about the selected ABC 
Classification should be displayed in the web item.  

SHOW_CHART 
"X" = Yes, " " = No 

Display ABC Classification Chart 
 Specifies whether the selected ABC Classification should be 
displayed as chart in the web item. 

SHOW_MODEL 
"X" = Yes, " " = No 

Display Model Name 
Specifies whether meta data (which Info Object is classified by 
which key figure from which Query) about the selected ABC 
Classification should be displayed in the web item. 
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 BW Stylesheets 
Definition 
Cascading stylesheets that are stored in the MIME repository under the name BWReports.css. 

Use 
Cascading stylesheets add to the basic functions of HTML by enabling you to determine different formats. 
You use CSS classes in HTML (which is created by the BEx Web items). The styles are identified in the 
generated HTML using class attributes according to the HTML standard. 

You can change the styles and thereby influence how the BW contents are displayed. 

 
Note that a stylesheet always has to be included in a Web template. 

Structure 
The following classes are identified when HTML is generated: 
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CSS classes Use 
Container for Web items  

SAPBEXBorderFlexBoxTtl Title area for Web items with borders 

SAPBEXBorderlessFlexBoxTtl Title area for Web items without borders and those with form 
characters 

SAPBEXBorderFlexBox Web items with borders 

SAPBEXBorderlessFlexBox Web items without borders and those with form characters 

SAPBEXFlexBoxStdBg Background 

SAPBEXFlexBoxFormBg Background for Web items with form characters 

Group Boxes  

SAPBEXGrpTtl Title 

SAPBEXGrpBdy Background 

Table  

SAPBEXstdData Numerical value in the data cells 

SAPBEXstdDataOdd Even, alternate rows 

SAPBEXaggData Aggregated numerical values in data totals cells 

SAPBEXstdDataEmph Emphasized numerical values in data cells 

SAPBEXstdDataEmphOdd Even, alternate rows with emphasized numerical values 

SAPBEXaggDataEmph Aggregated emphasized numerical values in data totals cells 

SAPBEXstdItem Structure component, characteristic value, attribute 

SAPBEXKeyAttr Numerical attribute 

SAPBEXaggItem Aggregated structure component, characteristic value sum 
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total, attribute sum total 

SAPBEXchaText Caption for characteristics and attributes 

SAPBEXformats Formatting cell (scaling factors) 

SAPBEXexcGood1 Exception with priority good 1 

Exception with priority good 2 

SAPBEXexcGood3 Exception with priority good 3 

SAPBEXexcCritical4 Exception with priority critical 4 

SAPBEXexcCritical5 Exception with priority critical 5 

SAPBEXexcCritical6 Exception with priority critical 6 

SAPBEXexcBad7 Exception with priority bad 7 

SAPBEXexcBad8 Exception with priority bad 8 

SAPBEXexcBad9 Exception with priority bad 9 

SAPBEXundefined Numerical value cannot be defined, or is invalid, such as 
division by zero 

SAPBEXTableGrid Color of grid lines 

SAPBEXCellspacing Grid lines on/off 

Navigation Block, Filter  

SAPBEXNavigatorChaTxt Description of characteristics 

SAPBEXNavItem Characteristic values in navigation block and filter 

Alert Monitor  

SAPBEXAlertItem Represented as a list 

SAPBEXAlertToolbar Toolbar 

SAPBEXAlertHead Title 

SAPBEXAlertLevel0 Hierarchy level 0 

SAPBEXAlertLevel1 Hierarchy level 1 

SAPBEXAlertLevel2 Hierarchy level 2 

SAPBEXPageDspl Index for displaying values on several pages 

Text Elements  

SAPBEXTElemName Text element name 

SAPBEXTElemVal Text element value 

Exceptions  

SAPBEXExcName Description of exception 

SAPBEXExcStatus Status of exception (active/inactive) 

Conditions  

SAPBEXConName Description of condition 

SAPBEXConStatus Status of exception (active/inactive) 

SAPBEXexcGood2 
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Legend  

SAPBEXMapLgdHeading1 Title 

SAPBEXMapLgdHeading2 Area title 

SAPBEXMapLgdLine Values for color legend 

SAPBEXMapLgdBorder Formatting of color legend 

SAPBEXMapLgdMinmax Minimum or maximum 

SAPBEXMapLgdLegend Values for symbol legend 

Context Menu  

SAPBEXCtxtMenuItem Entries in the context menu 

SAPBEXCtxtMenuHeader Entry selected from the context menu 

Calendar  

SAPBEXCalBg Background 

SAPBEXCalBorder Border 

SAPBEXCalLink Left 

SAPBEXCalSkipMonth Leaves in the monthly and yearly display 

SAPBEXCalCurrentDate Monthly and yearly display 

SAPBEXCalWeekday Name of week day (Mon, Tues,...) 

SAPBEXCalDay Number of the day (1,...) 

SAPBEXCalDaySelectedNorm
al 

Selected day 

SAPBEXCalDaySat Saturday 

SAPBEXCalDaySelectedSat Selected Saturday 

SAPBEXCalDaySun Sunday 

SAPBEXCalDaySelectedSun Selected Sunday 

SAPBEXCalNoDay Week day without day number 

SAPBEXCalWeek Calendar week 

SAPBEXCalMonth Month in high-speed navigation 

SAPBEXCalCurrentMonth Selected month in high-speed navigation 

Dialogs  

SAPBEXDialogBorder Border 

SAPBEXDialogBg Background 

SAPBEXDialogTtl Title 

SAPBEXDialogAreaTtl Area title 

SAPBEXDialogOffset Horizontal and vertical spacing in dialogs 

Menu  

SAPBEXMenuLogo Header area 
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SAPBEXTreeLevel0 Tree level 0 

SAPBEXTreeLevel1 Tree level 1 

SAPBEXTreeLevel2 Tree level 2 

SAPBEXTreeLevel3 Tree level 3 

Hierarchies  

SAPBEXHLevel0 Hierarchy level 0 

SAPBEXHLevel1 Hierarchy level 1 

SAPBEXHLevel2 Hierarchy level 2 

SAPBEXHLevel3 Hierarchy level 3 

Messages  

SAPBEXMessage Messages 

SAPBEXSystemMessage System messages 

SAPBEXTicker Ticker 

Links, Text, Buttons  

SAPBEXLnk Standard links 

SAPBEXMarked Highlighted link 

SAPBEXTxtStd Standard text 

SAPBEXTxtStdBold Bold standard text 

SAPBEXBtnStd Standard button (background) 

SAPBEXBtnStdIe4 Standard button (Internet Explorer 4) 

SAPBEXBtnStdBorder Standard and disabled button (border) 

SAPBEXBtnEmph Emphasized button (background) 

SAPBEXBtnEmphIe4 Emphasized button (Internet Explorer 4) 

SAPBEXBtnEmphBorder Emphasized button (border) 

SAPBEXBtnStdDsbl Disabled button (background) 

SAPBEXBtnEmphDsbl Emphasized disabled button (background) 

Controls & Indicators  

SAPBEXDdl Dropdown Box 

SAPBEXChb Checkbox 

SAPBEXRb Radio button 

SAPBEXTxtFld Input field 

SAPBEXTxtFldright Right-aligned input field 

SAPBEXTxtFldDsbl Inactive input field 

SAPBEXTextArea Multi-line input area 

SAPBEXTxtLbl Indicator for input field 
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SAPBEXWhlOffset Horizontal and vertical spacing 

Loading Dialog Box *  

SAPBEXPopUpOuterBorder 3D border: Outer border 

SAPBEXPopUpInnerBorder  3D border: Inner border 

SAPBEXPopUpBg  Background 

SAPBEXPopUpHeader  Title 

Standard Template  

SAPBExTitle Title 

SAPBEXNavLine Navigation bar 

SAPBEXNavLineBorder Navigation bar border 

Tree Query Designer  

SAPBEXTreeLevel0Bg Background, tree level 0 

SAPBEXTreeLevel0Ttl Expandable items, tree level 0 

SAPBEXTreeLevel0Item Items, tree level 0 

SAPBEXTreeLevel1Bg Background, tree level 1 

SAPBEXTreeLevel1Ttl Expandable items, tree level 1 

SAPBEXTreeLevel1Item Items, tree level 1 

SAPBEXTreeLevel2Bg Background, tree level 2 

SAPBEXTreeLevel2Ttl Expandable items, tree level 2 

SAPBEXTreeLevel2Item Items, tree level 2 

SAPBEXTreeLevel3Bg Background, tree level 3 

SAPBEXTreeLevel3Ttl Expandable items, tree level 3 

SAPBEXTreeLevel3Item Items, tree level 3 

SAPBEXTreeBorder Tree border 

Tabs  

SAPBEXTbsLnk Link in selectable tab page  

SAPBEXTbsTab Tab to be selected 

SAPBEXTbsTabSel Selected tab 

SAPBEXTbsBdyEdg Tab area border 

SAPBEXTbsBorder Tab page frame (Netscape 4.7) 

Breadcrumbs Query 
Designer 

 

SAPBEXBrdCrBoxContBgColo
r 

Background color of column and row area 

SAPBEXBrdCrBoxBorder Color of border for column and row area 

SAPBEXBrdCrArea Formatting of column and row area 
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SAPBEXBrdCrIna Labeling of inactive navigation path 

SAPBEXBrdCrAct Labeling of active navigation path 

SAPBEXBrdCrDiv Formatting of navigation path 

Listen Query Designer  

SAPBEXLicWhl Formatting of list area 

SAPBEXLicTtl Display area header 

SAPBEXLic Bulleted list introduction 

SAPBEXLicBul Bullets 

list entries 

SAPBEXLicItemLnk Individual list entries with links 

SAPBEXLicItem Individual 

* Not relevant for Netscape browser 4.7 
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 Print Stylesheet 
Use 
When wanting to print out a Web application, you can apply a stylesheet to the print out. This differs from 
the stylesheet for the screen display.  This proves useful if you only want to change the font size for the 
printout, for example. 

 

Prerequisites 
Only Internet Explorer is able to attach a stylesheet to printouts. 

Procedure 
1. To attach a stylesheet to your Web application, choose Insert → Print Stylesheet. 

2. You can find the range of stylesheets in the Select Print Stylesheet dialog box.  Select a stylesheet to 
see it in the preview window on the right-hand side. 

3. To select a stylesheet for your Web application, select the required stylesheet and choose OK. 

 
Only those stylesheets stored on the BW server are displayed in the selection list. If you want 
to use a stylesheet that is not in the list, for example, one that is stored on your Web server, 
mark the checkbox beneath the selection list, enter the URL and choose OK. 

Result 
Your Web application HTML now contains the additional tag:  

<link href="MIME/BEx/StyleSheets/BWReports_print.css" type="text/css" rel="stylesheet" media="print"> 

 
Although a stylesheet is set for the screen display by default, you must explicitly use Insert → 
Print Stylesheet to attach the print stylesheet.  

As a result, the printed Web application is formatted according to this stylesheet. 
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 Web Templates 
Definition 
A Web template determines the structure of a Web application. You use the Web Application Designer to 
insert placeholders into a HTML document for Web items [Seite 36] (in the form of object tags [Seite 227]), 
data providers [Seite 268] (in the form of object tags) and BW URLs. The HTML document with the BW-
specific placeholders is called a Web template. Web templates are checked into the Web Application 
Designer. The HTML page that is displayed in the Internet browser is called a Web application. Depending 
on which Web items you have inserted into the Web template, a Web application contains one or more tables, 
an alert monitor, charts, maps, and so on. 

Structure 
The Web template is the keystone of a Web application. It contains placeholders for Web items and 
command URLs [Seite 231]. Data providers, Web items, and command URLs are generated for Web 
applications. 

In the Web template, you determine from which data provider and it what way (Web items) the BW data is 
displayed. You also determine which additional options there are (BW URLs). 

When a request is sent from a Web application to the SAP Web Application Server, a template object is 
generated. The structure of the requested HTML page is derived from this object. The following objects 
are generated on the basis of this template: 

• Data Provider 

• Web Item 

Integration 
As of BW 3.0, Web templates are stored on the SAP Web Application Server.  

 
The option to store Web templates (for BW 2.0B or BW 2.1C, for example) on the ITS is still 
possible. We recommend, however, that you use the SAP Web Application Server. 

Example 
The following is an example of a simple Web template with a navigation block [Seite 151] and a table 
[Seite 43]: 

<html> 

<head> 

<link rel="stylesheet" href="Bex/StyleSheets/BWReports.css"> 

<title>New Page 1</title> 

</head> 

<body> 

 

<!--Template properties --> 

<object> 
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 <param name=’OWNER’ value=’SAP_BW’> 
 <param name='CMD' value='SET_PROPERTIES'> 
 <param name='VARIABLE_SCREEN' value='X'> 
 <param name='USE_PERSONALIZATION' value='X'> 

</object> 

 

<!--Create the data provider --> 

<object> 

 <param name=’OWNER’ value=’SAP_BW’> 
 <param name=’CMD’ value=’SET_DATA_PROVIDER’> 
 <param name='DATA_PROVIDER' value='View1 > 
 <param name='DATA_PROVIDER_ID' value='VIEW1'> 
 DATA_PROVIDER :View1 

</object> 

 

<!--Create and get the navigational block --> 

<object WIDTH=”350”> 

 <param name=’OWNER’ value=’SAP_BW’> 
 <param name=’CMD’ value=’GET_ITEM’> 
 <param name=’ITEM’ value=’Nav Block’> 
 <param name='ITEM_ID' value='NAVBLOCK'> 
 <param name='DATA_PROVIDER' value='View1 > 
 ITEM :Nav Block 

</object> 

<br> 

 

<!--Create and get the table --> 

<object WIDTH=”600”> 

 <param name=’OWNER’ value=’SAP_BW’> 
 <param name=’CMD’ value=’GET_ITEM’> 
 <param name='ITEM' value='Table'> 
 <param name='ITEM_ID' value='TABLE'> 
 <param name='DATA_PROVIDER' value='View1 > 
 ITEM :Table 

</object> 

 

</body> 
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 Object Tags 
Definition 
By using object tags, you can determine properties of Web templates, create data provider and Web 
items in a Web template, and supply them with parameters. The parameters that you set for Web items 
are used to control the settings you have made in the Web Application Designer (width and height, for 
example). It is possible, right at the start of the Web application, to send a generic command (filter, 
change attribute) or a command sequence [Seite 261] to the data provider. The parameters needed to 
send the command are attached to the object tag (see example). 

Structure 
An object tag starts with “<object...>” and ends with “</object>”. The SAP_BW object tags are identified by 
the parameter “owner”, and the value “SAP_BW”. Only this type of object is replaced in the Web template. 
All other types of object are transferred unchanged into the Web application. 

It is possible to set parameters at the start of an object tag 
<object WIDTH=’350’ HEIGHT=’234’ owner=’SAP_BW’ ...></object> 

or within the object tag, as a parameter tag. 
<object> 

  <param name=’owner’ value=’SAP_BW’> 
  ... 

</object> 

Object tags are also displayed in non-HTML code mode in many HTML editors. Some HTML editors also 
give you the option of changing the size, and maintaining the parameters of the object tag. It is usually 
possible to use the drag and drop function to move the object tags around a page. 

The following object tags play an important role in BEx Web Applications: 

Object Tag for Properties of Web Templates [Seite 22 ]8  

Object Tag for Data Provider [Seite 229] 

Object Tag for Web Items [Seite 230] 
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 Object Tag for the Properties of Web Templates 
Definition 
Object Tag for defining the properties of Web templates. 

Use 
The properties of a Web template can be defined in an object tag. The properties include all the 
parameters that can be passed by URL when a Web template is called. This includes all the properties of 
the context menu. 

 
Parameter 'CMD' must be set to 'SET_PROPERTIES' to indicate that these are the properties 
of the Web template. 

Examples 
Display template with variable input 
<object> 

 <param name=’OWNER’ value=’SAP_BW’> 
 <param name='CMD' value='SET_PROPERTIES'> 
 <param name='VARIABLE_SCREEN' value='X'> 
</object>  

Context menu should not contain an enhanced menu 
<object> 

 <param name=’OWNER’ value=’SAP_BW’> 
 <param name='CMD' value='SET_PROPERTIES'> 
 <param name='MENU_ENHANCED' value=' '> 

</object> 
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 Object Tag for Data Provider 
Definition 
Object tag for creating Data Providers. 

Use 
The parameters that you need for creating a data provider are available in the Web Application Designer. 
You add other parameters, for example, to set up the value help (F4), or to send a command to the data 
provider before you call a page. 

 
The ‘CMD’ parameter has to be filled with the ‘SET_DATA_PROVIDER’ to indicate that you 
are creating a data provider 

Examples 
Create Query View 
<object> 

 <param name=’OWNER’ value=’SAP_BW’> 
 <param name=’CMD’ value=’SET_DATA_PROVIDER’> 
 <param name='DATA_PROVIDER' value='View1 > 
 <param name='DATA_PROVIDER_ID' value='VIEWABC'> 
 DATA_PROVIDER :View1 

</object> 

 

Query view filtered by country (USA) 
<object> 

 <param name=’OWNER’ value=’SAP_BW’> 
 <param name=’CMD’ value=’SET_DATA_PROVIDER’> 
 <param name='DATA_PROVIDER' value='View1 > 
 <param name='DATA_PROVIDER_ID' value='VIEWABC'> 
 <param name=’FILTER_IOBJNM’ value=’0COUNTRY’> 
 <param name=’FILTER_VALUE’ value=’US’> 
 DATA_PROVIDER :View1 

</object> 
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 Object Tag for Web Items 
Definition 
Object tag for creating a Web item. 

Use 
The parameters that you need for creating a Web item are available in the Web Application Designer. You 
add further parameters, for example, to adjust the size at a later point, or to set a title. 

 
The parameter ‘CMD’ has to be filled with ‘GET_ITEM’ to indicate that you are creating a Web 
item. 

Example 
Creating a Web Item 
<object> 

 <param name=’OWNER’ value=’SAP_BW’> 
 <param name=’CMD’ value=’GET_ITEM’> 
 <param name='ITEM' value='NavBlock'> 
 <param name='ITEM_ID' value='NAVBLOCK'> 
 <param name='DATA_PROVIDER' value='View1 > 

 ITEM :Nav Block 

</object> 

Creating a Web item with height 400 pixels, width 500 pixels, and the title “Business Graphic” 

<object WIDTH=’400’ HEIGHT=’500’> 

 <param name=’OWNER’ value=’SAP_BW’> 
 <param name=’CMD’ value=’GET_ITEM’> 
 <param name='ITEM' value='Chart1'> 
 <param name='ITEM_ID' value='PIECHART'> 
 <param name='DATA_PROVIDER' value='View1 > 
 <param name=’GENERATE_CAPTION’ value=’X’> 
 <param name='CAPTION' value='Business Grafik'> 
 ITEM :Chart 1 

</object> 
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 Command URLs 
Definition 
You can set command URLs in a Web template [Seite 225], as well as an object tag [Seite 227]. These 
are then used as bookmarks for URLs or the starting place for a URL. 

Structure 
Command URLs have the following structure: 
<SAP_BW_URL Parameter1=’Value1’ Parameter2=’Value2’ ...> 

When you generate the HTML page with one of the following URLs, command URLs are replaced by a 
similar URL: 

http://myAppServer:myPort/SAP/BW/BEx?pageno=1&request_No=8&Parameter1=Value1&Parameter2=
Value2&... 
This URL requests a new page from the ITS. The parameters are removed. If you navigate in the Web 
application, then a new page is requested. The status of the previous page is changed due to the transfer 
of the parameters (for example, filters are set). 

See also: 
Command Sequences [Seite 261] 
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 Calling up Web Templates 
Use 
The URL for calling a Web template is generated by the Web Application Designer. You can extend the 
URL by various parameters when you call up a Web template. These parameters can: 

• Influence the data contents or display of the results (see Calling Parameterized Web Templates [Seite 
]) 237

• Activate or deactivate different functions on the server. 

Function 
Choose from the following options to call up the template: 

Standard call up and properties of Web templates 

 
You can determine the properties of the Web template both in an object tag (see Object Tag 
for the Properties of Web Templates [Seite 228]) and or with command Call Web Template. 

CMD LDOC 

Parameter Description 

TEMPLATE_ID Name of the Web template 
Name under which you stored the Web 
template in the Web Application Designer. 

STATELESS (optional) 
‘X’ = Yes, ‘  ’ = No 

End the connection to the server as soon as 
possible 
For Web templates that are used almost 
exclusively for display without further 
navigation, it is more useful to set the attribute 
STATELESS. The session on the application 
server is terminated when the Web template is 
created. This saves resources on the 
application server. 

 
If this attribute is not specified, it is 
assumed that the page is still 
needed for navigating. 

‘X’ = Yes, ‘  ’ = No 
Use personalized Web template 
If the parameter is set to ‘X’, the personalized 
Web template for the current user is used. If 
personalization does not exist for the Web 
template or the parameter is not set, the Web 
template is executed without personalization. 

USE_PERSONALIZATION (optional) 
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STYLE_SHEET (optional) Path for a stylesheet that you want to use to 
display the Web template. 
This overwrites any stylesheet that you may 
have already assigned. 

TRACE (optional) 
’X’ = switch on, ‘  ’  = do not switch on 

Switch on OLAP trace 
To analyze problems with SAP, you usually 
need a trace. You can activate the trace with 
the help of note 112458 or by using the TRACE 
parameter. 

JAVASCRIPT (optional) 
’X’ = switch on, ‘  ’  = do not switch on 

Use of JavaScript 
Using this parameter, you ensure that Web 
applications are created using JavaScript 
(extensive interaction options) or suppress the 
use of JavaScript (restricted interaction). 

 
If this parameter is not transferred, 
JavaScript is activated 
automatically in Web browsers of 
version >=4.0. 

SNIPPET_OPERATIONS (optional) 
’X’ = switch on, ‘  ’  = do not switch on 

Reload changed components of the page 
You use this parameter to control whether only 
changed objects are loaded in navigation. This 
function has higher Web browser requirements. 
For this reason, this function is only supported 
by MS Internet Explorer version >=. 

 
If this parameter is not transferred, 
loading is activated automatically 
for the suitable Web browsers. 

ENABLE_OPEN_WINDOW (optional) 
’X’ = switch on, ‘  ’  = do not switch on 

Open new window 
Using this parameter, you can control whether 
a new browser window is opened, for example, 
for the properties dialog box or for filtering. If 
this parameter is not specified, new windows 
are opened (if supported by the Web browser). 

VARIABLE_SCREEN (optional) 
‘X’ = display variable screen, ‘  ’ = do not 
display, if possible 

Display variable screen 
If you call up a Web template that has query 
views containing variables that are ready for 
input, you can use these parameters to display 
the variable screen. Is you do not set this 
parameter, or set it to ‘  ’, the variable screen is 
hidden, whenever possible. However, it will still 
be shown if, for example, the required variables 
that are ready for input have not yet been filled. 
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MELT_VARIABLES (optional) 
‘X’ = merge, ‘  ’ = display each query 
individually 

Merge variables 
If you call up a Web template containing 
several query views that have variables that 
are ready for input and you go to the variable 
screen display, you can determine, through 
these parameters, whether variables, which are 
used in all query views and in the same context 
(same InfoProvider, same compounding), are 
to be provided for input only once. 

‘X’ = reset variable, ‘  ’ = do not reset 
Reset default variables 
If you call up a Web template that contains one 
or several query views that have variables that 
are ready for input, you can specify this 
parameter to reset the default variables 
through the query view. The variables then 
contain the defaults from the variable definition. 

SUPPRESS_WARNINGS (optional) 
‘X’ = do not display warnings, ‘  ’ = display 
warnings 

Suppress warnings 
With this parameter, warnings are not 
displayed. With this parameter, warnings are 
not displayed. 

SUPPRESS_SYSTEM_MESSAGES 
(optional) 
'X' = Do not display system messages 

'  '  = Display system messages 

Suppress system messages 
With this parameter, system messages are not 
displayed. 

DATA_MODE (optional) 
‘NEW’ = use current data 

‘STORED’ = Use precalculated data 

‘HYBRID’ = use precalculated data, request 
current data if this is missing.  

‘STATIC’ = use precalculated HTML pages 

‘STATIC_HYBRID’ = use precalculated HTML 
pages, if there are none, search by 
precalculated data and when there is none, 
request current data 

Data mode 
This parameter is optional. If you do not specify 
one of the options for this parameter, a request 
is always sent to the OLAP processor and 
current data is read. 

For the modi ‘STORED’ and ‘HYBRID’, data 
has to be precalculated using the Reporting 
Agent [Extern]. 

See Defining the Web Templates Setting 
[Extern] 

VARIABLES_CLEAR (optional) 

 
The parameters PAGEID and WBID that are used in BW 2.x are supported for the Web 
templates created under BW 2.x. We recommend, however, that you no longer use these. 

 
Calling up the Web template without navigating 
http://yourAppServer:yourPort/SAP/BW/BEx?CMD=LDOC&TEMPLATE_ID=yourTemplate&S
TATELESS=X  

Calling up the Web template with trace switched on 
http://yourAppServer:yourPort/SAP/BW/BEx?CMD=LDOC&TEMPLATE_ID=yourTemplate&T
RACE=X 
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Calling up the Web template with reset variables and active variable screen 
http://yourAppServer:yourPort/SAP/BW/BEx?CMD=LDOC&TEMPLATE_ID=yourTemplate&V
ARIABLE_SCREEN=X&VARIABLES_CLEAR=X 

Calling up the Web template with a different data provider 
This call-up replaces all data providers [Seite 268] of the type 'query view' with the data provider specified. 
This means you can make a query or a query view available for use without having to do anything else on 
the Web, and you can use a predefined Web template for displaying the query. 

As well as the parameters used in the default call up, this call up also has the following: 

Call up for displaying a query: 

Parameter Description 

INFOCUBE Technical name of the InfoProvider 

QUERY Technical name of the query 

 

VARIANT (optional) Variant, if you are not required to enter a 
variable 

Call up for displaying another query view: 

Parameter Description 

DATA_PROVIDER_ID Technical name of the saved query view 

VARIANT (optional) Variant, if you are not required to enter a 
variable 

 
The parameters PAGEID and WBID that are used in BW 2.x are supported for the Web 
templates created under BW 2.x. We recommend, however, that you no longer use these. 

 
Displaying a query by using a Web template of your choice 
http://yourAppServer:yourPort/SAP/BW/BEx?CMD=LDOC&TEMPLATE_ID=yourTemplate&in
focube=myCube&query=myQuery 

Setting your own Web template objects 
As well as being able to define a new initialization for all data providers of a template, you can also convert 
each data provider specifically and each Web item, using parameterization. By doing this, you allow even 
your more complicated Web templates to be reused. 

The index in the parameter is indicated in the following by '_I'. 

The parameters for overwriting the data provider initialization are: 

Parameter Description 

SET_DATA_PROVIDER_I Logical name of the data provider 
Name of the data provider for which you want 
to set a new initialization 

INFOCUBE_I (Option 1) Technical name of the InfoProvider 
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QUERY_I (Option 1) Technical name of the query 

 

DATA_PROVIDER_ID_I (Option 2) Technical name of the saved query view 

VARIANT (optional) Variant, if you are not required to enter a 
variable 

The parameters for overwriting the Web item initialization are: 

Parameter Description 

SET_ITEM_I Logical name of the Web item 
Name of the Web item for which you want to 
set a new initialization 

ITEM_ID_I (Option 1) Web item key 
You create a Web item for a Web template 
based on a Web item setting that you have 
made in the Web Application Designer.  

ITEM_CLASS_I (Option 2) Class name of the Web item class 
Name of the ABAP object class that output 
generation transfers. This corresponds to the 
use of non-reusable Web items (standard Web 
items) in the Web Application Designer. Web 
items are created with the default values for the 
attribute. 

The class name for the table is, for example, 
CL_RSR_WWW_ITEM_GRID 

 
Swapping 2 data providers and a Web item when calling up a Web template 

http://yourAppServer:yourPort/SAP/BW/BEx?CMD=LDOC&TEMPLATE_ID=yourTemplate&S
ET_DATA_PROVIDER_1=myDataProvider1&infocube_1=myCube&query_1=myQuery&
SET_DATA_PROVIDER_2=myDataProvider2&data_provider_id_2=mySpecialView&SET
_ITEM_3=myItem&ITEM_ID_3=myPieChart 

Using a standard Web template for a data provider 
If you call up the previous variant without specifying a TEMPLATE_ID, a standard Web template is used 
automatically. To make a Web template the standard Web template, go to BW Customizing 
Implementation Guide → Business Information Warehouse → Settings Relevant for Reporting → Web-
Based Settings → Determine a Standard Web Template. 

If there is no setting made here, the system uses a Web template generated by SAP. 

 
Calling up a query without making any preparations in the Web 
http://yourAppServer:yourPort/SAP/BW/BEx?CMD=LDOC&infocube=myCube&query=myQ
uery 
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 Calling Parameterized Web Templates 
Use 
The URL for calling a Web template is generated by the Web Application Designer. It is possible to copy 
the URL, and use it again as many times as you like. 

A typical URL looks like this: 

http://myAppServer:myPort/SAP/BW/BEx?CMD=LDOC&template_id=yourTemplate 

The first part of the URL ((http://myAppServer:myPort/SAP/BW/BEx?) calls the BEx service in the SAP 
Web Application Server in the BW system. The next step is to call the Web template. The command 
‘LDOC’ with the parameters 'TEMPLATE_ID' calls the Web template.  

The command LDOC requests a new HTML page. The Web template is used to construct this HTML 
page. The Web application corresponding to the Web template is displayed in the Web Browser. 

You parameterize the Web template by adding further parameters to the URL. These parameters are 
passed on to all data providers and Web items. Parameterizing the URL allows you to filter all the query 
views according to a particular country or cost center. 

Examples 
Filtering all query views according to Germany 
http://myAppServer:myPort/SAP/BW/BEx?CMD=LDOC&template_id=yourTemplate&FILTER_IOBJNM=0
COUNTRY&FILTER_VALUE=DE 
Filtering all query views according to Germany, 2000 

http://myAppServer:myPort/SAP/BW/BEx?CMD=LDOC&template_id=yourTemplate&FILTER_IOBJNM_1
=0COUNTRY&FILTER_VALUE_1=DE&FILTER_IOBJNM_2=0CALYEAR&FILTER_VALUE_2=2000 
Displaying all Web items with title 
http://myAppServer:myPort/SAP/BW/BEx?CMD=LDOC&template_id=yourTemplate&GENERATE_CAPTI
ON=X 
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 Switching Web Templates 
Use 
You have the option to calling up Web reports [Seite 23 ]2  or to switch between different Web reports. 
When you switch Web reports, all the Web items and data providers in the Web template in which you 
started are retained. The Web items and data providers that appear in the new Web template, and for 
which there is no object with the same name, are generated from scratch. The system identifies the 
objects by their logical names. 

The main difference between calling a Web template and switching to a different Web template is that 
objects from the initial Web template are transferred without being modified into the new Web report. This 
means, for example, that the query view of the navigation status stays the same. 

This function is particularly useful for switching from overview pages (often containing only diagrams) to 
detailed pages (with tables and navigation blocks). 

Functions 
CMD CHANGE_TEMPLATE 

Parameter Description 

TEMPLATE_ID Name of the Web template 
Name under which you stored the Web 
template in the Web Application Designer. 

 
The parameters PAGEID and WBID that are used in BW 2.x are supported for the Web 
templates created under BW 2.x. We recommend, however, that you no longer use these. 

 
<SAP_BW_URL CMD='CHANGE_TEMPLATE' TEMPLATE_ID=’DETAILS'> 
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 Personalizing the Web Template 
Use 
With this command you can personalize a Web template for the user who is logged on. The next time this 
user calls the Web template with parameter USE_PERSONALIZATION=X, the same navigation status as 
was valid during personalization is displayed. This mechanism is useful especially for portal pages. 

CMD PERSONALIZE 

Example 
<SAP_BW_URL CMD='PERSONALIZE'> 
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 Removing Personalization 
Use 
You use this command to remove the current user’s Web template personalization. 

CMD RESET_PERS 

Example 
<SAP_BW_URL CMD='RESET_PERS'> 
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 Creating Bookmarks 
Use 
Command that allows you to mark a Web application as a bookmark. The result of this instruction is to 
display a Web application with a bookmark-enabled URL. You can call this URL at any time, which results 
in a Web application that displays the same navigation status (including whether the hierarchy is 
expanded) as the Web application from which the instruction was called. 

CMD BOOKMARK 

Parameter Description 

BOOKMARK_DATA 
(optional) 
‘X’ = Yes, ‘  ’ = No 

Store historical data about the bookmark 
The Web application with the historical data is 
displayed when you call the bookmark. 
Bookmarks are normally used without data. 

Example 
<SAP_BW_URL CMD='BOOKMARK'> 
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 Changing Icon Directory 
Use 
You use this command if you are working on a special Web application, and you want to use icons other 
than the icons that are generally used as the symbols for expanding and collapsing hierarchies, for 
example. The command assigns a different icon directory to the Web template. 

 
The names of the icons remain unaffected. In the new directory the icons have to appear with 
their original names, but you are able to alter them in other ways. 

Functions 
CMD SET_URLS 

Description 

ICON_PREFIX Relative path to an directory in the MIME 
repository or on the ITS 

Parameter 

Example 
Displaying a Web report using icons from a different directory 
http://yourAppServer:yourPort/SAP/BW/BEx?CMD=LDOC&template_id=yourTemplate&cmd_1=cmd%3D
SET_URLS%26ICON_PREFIX%3DmyPath 

 
A command sequence is used in this example. 

See also: 

Command Sequences [Seite 261] 
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 Releasing a Web Template 
Use 
You can use this command to remove the current Web template with all its objects from the memory of the 
application server. The Web template cannot be accessed once this is done. You can only use the 
command Calling up a Web Template [Seite 232] to do this. 

 
You can call up other Web templates by using commands in a command sequence. 

Functions 
CMD PAGE_FREE 

 
<SAP_BW_URL CMD='PAGE_FREE'> 
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 Calling up the Variables Screen 
Use 
This command allows you to call up the variables screen again for the current page. You can then change 
the variable values that have been used until now in the variables screen. 

You can also transfer new values over, as described in Default Variables for Web Applications [Seite 245]. 
Along with the values already set, these serve as the default variables screen. 

If the variables screen appears when you call up a Web application, you have to adjust the Web template 
call (see Calling up a Web Template [Seite 232]→ Standard Call). 

Functions 
CMD PROCESS_VARIABLES 

SUBCMD VARIABLE_SCREEN 

 
<SAP_BW_URL CMD='PROCESS_VARIABLES' SUBCMD='VARIABLE_SCREEN'> 
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 Default Variables for Web Applications 
Use 
Variables [Extern] play a central role in BW queries. For example, the entire query or only individual parts 
of the query can be filtered before reading data according to values. There are variables with automatic 
substitution, substitution from authorizations, or variables that are ready for input. 

The variables for Web applications can be processed in the background (without a variable screen) or in 
the foreground (with a variable screen). In both cases it is desirable to predefine variables through 
parameterization. Therefore, all types of variables that are ready for input are supported 

In contrast to filtering, the external value for predefining has to be specified for the variables. The date, for 
example, is transferred as it has been entered. 

Features 
You set default variables by parameterizing the URL. The variable values are separated from each other 
by different indexes.  

The index in the parameter is indicated in the following by '_I'. 

Characteristic Value Variables 
Parameter variables or variables for several single values are predefined as follows:  

Parameter Description 

VAR_NAME_I Technical name of the variables 

VAR_VALUE_EXT_I Attribute value in external display 
Key for characteristic value in external display 

Interval variables are predefined as follows: 

Parameter Description 

VAR_NAME_I Technical name of the variables 

VAR_VALUE_LOW_EXT_I “From” characteristic value in external 
display 
Key for characteristic value in external display 

VAR_VALUE_HIGH_EXT_I “To” characteristic value in external display 
Key for characteristic value in external display 

Selection option variables are predefined as in the following: 

Parameter Description 

VAR_NAME_I Technical name of the variables 
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VAR_OPERATOR_I Operator 
'EQ' = Individual value 

'BT' = Interval 

'LT' = Less than 

'LE' = Less than or equal to 

'GT' = Greater than 

'GE' = Greater than or equal to 

VAR_VALUE_LOW_EXT_I “From” characteristic value in external 
display 
Key for characteristic value in external display 

VAR_VALUE_HIGH_EXT_I “To” characteristic value in external display 
Key for characteristic value in external display 

 
This value must only be specified 
with VAR_OPERATOR='BT'. 

VAR_SIGN_I Row effect 
'I' found values are added, 

'E' found values are removed. 

Variables for precalculated value sets are preassigned as follows: 

Parameter Description 

VAR_NAME_I Technical name of the variables 

VAR_VALUE_EXT_I Name of value set 

Variables for Single Hierarchy Nodes or Variables for Several Hierarchy Nodes 

Parameter 

Technical name of the variables 

VAR_VALUE_EXT_I Node key in external display 
Key for hierarchy node 

VAR_NODE_IOBJNM_I Name of the node characteristic 

With characteristic nodes and text nodes, you 
have to specify the characteristic name 
(0HIER_NODE). 

Description 

VAR_NAME_I 

Hierarchy, Formula, and Text Variables 

Parameter Description 

VAR_NAME_I Technical name of the variables 

VAR_VALUE_EXT_I Hierarchy name, formula value, text 

Examples 

Predefining the parameter variable 
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http://yourAppServer:yourPort/SAP/BW/BEx?CMD=LDOC&template_id=yourTemplate&var_name_1=my
ParameterVariable&var_value_ext_1=4711 

Predefining the parameter variable (4711) and select options variable (1, 7 to 12) 
http://yourAppServer:yourPort/SAP/BW/BEx?CMD=LDOC&template_id=yourTemplate&var_name_1=my
ParameterVariable&var_value_ext_1=4711&var_name_2=mySelOptVar&var_operator_2=EQ&var_si
gn_2=I&var_value_low_ext_2=1&var_name_3=mySelOptVar&var_operator_3=BT&var_sign_3=I&va
r_value_low_ext_3=7&var_value_high_ext_3=12 

Predefining hierarchy nodes variable (DE, 0HIER NODE) 
http://yourAppServer:yourPort/SAP/BW/BEx?CMD=LDOC&template_id=yourTemplate&var_name_1=my
HryNodeVariable&var_value_ext_1=DE&var_node_iobjnm_1=0HIER_NODE 
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 Changing the Values of Variables 
Use 
Using this command, you can change the values of variables on the current page.  

Enter the variable values as described in Default Variables for Web Applications [Seite 245]. Variables 
that you do not specify maintain their previous value. 

Functions 
CMD PROCESS_VARIABLES 

SUBCMD VAR_SUBMIT 

Example 
<SAP_BW_URL CMD='PROCESS_VARIABLES' SUBCMD='VAR_SUBMIT' 
VAR_NAME_1=’myParameterVariable’ VAR_VALUE_EXT_1=’4711’> 
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 Adjusting and Enhancing the Context Menu 
Use 
You can adjust the context menu that is created automatically for table cells to your company-specific 
needs and scenarios. 

You can copy functions of the enhanced context menu to the context menu that is not enhanced or you 
can hide functions. 

You can also integrate your own context-specific entries in the context menu. 

Functions 
The following options are available: 

Adjusting the Context Menu [Seite 251] 

Enhancing the Context Menu [Seite 258] 
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 Adjusting the Context Menu 
Use 
Along with properties such as VARIABLE_SCREEN, you can also modify the context menu for a Web 
template. You can turn every entry in the menu on or off or place it in the Enhanced Menu. 

Features 
All entries in the context menu are listed in the following list of properties: 

 
Menu entries that are not specified retain their default value. The default values are 
underlined in the list 

Properties Description 

Back 
(MENU_BACK) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Back” 

Undo one navigation step on a data provider 

Forward 
(MENU_FORWARD) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry. “Forward” 

Repeat a navigation step on a data provider. 

Back to Start 
(MENU_BACK_TO_START) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Back to Start” 

Undo all navigation steps on a data provider 

Keep Filter Value 
(MENU_FILTER) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Keep Filter Value” 

 

Keep Filter Value on Axis 
(MENU_FILTER_ON_AXIS) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Keep Filter Value on Axis” 

Web Application Design: BEx Web Application Designer 30B
 251 



SAP Online Help  13.05.2002 

Choose Filter Value 
(MENU_SELECT_FILTER) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Select Filter Value” 

Keep Filter Value on Axis for Diagram 
(MENU_FILTER_ON_AXIS_CHART) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 
‘E’= Displayed in the “enhanced menu” 

Menu entry: “Keep Filter Value on Axis for 
Diagram” 

When considering diagrams, it is often more 
useful to use the command “Keep Filter Value 
on Axis” than it is to keep the filter, which is 
removed when you drilldown. The geometry of 
the list remains the same and the chart/or map 
can still be interpreted. Therefore, there are 
separate settings for these Web items. 

Keep Filter Value for Diagrams 
(MENU_FILTER_CHART) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Keep Filter Value” for Diagrams 

When considering diagrams, it is often more 
useful to use the command “Keep Filter Value 
on Axis” than it is to keep the filter, which is 
removed when you drilldown. The geometry of 
the list remains the same and the chart/or map 
can still be interpreted. Therefore, there are 
separate settings for these Web items. 

Filter and drilldown according to 
(MENU_FILTER_DrILL_DOWN) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Filter and Drilldown According to” 

Drilldown According to 
(MENU_DRILL_UP) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 
‘E’= Displayed in the “enhanced menu” 

Menu entry: “Drilldown According to” 

 
“Drilldown” with the exception of 
navigation in maps. 

 

Drilldown According to in Context of Map 
(MENU_DRILL_UP_GIS) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Drilldown According to” in Context 
of Map 

 
“Drilldown” in the context of 
navigation in maps. 
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Insert drilldown according to 
(MENU_DRILL_DOWN) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 
‘E’= Displayed in the “enhanced menu” 

Menu entry: “Insert Drilldown According to” 

Swap ... with ... 
(MENU_EXCHANGE_OBJECTS) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Swap ... with ...” 

Swap characteristics or structures. 

Remove Drilldown 
(MENU_REMOVE_DRILL_DOWN) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Remove Drilldown” 

Swap Axes 
(MENU_SWITCH_AXIS) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Swap Axes” 

Expand/Collapse Hierarchy Nodes 
(MENU_HIERARCHY_NODE_DRILL) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: Expand/Collapse Hierarchy Nodes 

Expand Hierarchy 
(MENU_HIERARCHY_DRILL) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Expand Hierarchy” 

(De)activate Hierarchy 
(MENU_HIERARCHY_STATE) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “(De)activate Hierarchy” 

Web Application Design: BEx Web Application Designer 30B
 253 



SAP Online Help  13.05.2002 

Sorting 
(MENU_SORT) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Sort” 

Sort by characteristic cells and data cells. 

(MENU_CALCULATE_RESULT) 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Calculate Result as” 

Calculations for value cells. 

Calculate Single Values As... 
(MENU_CALCULATE_VALUE) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 
‘E’= Displayed in the “enhanced menu” 

Menu entry: “Calculate Single Values As...” 

Calculations for value cells. 

Cumulated 
(MENU_CUMULATE_VALUE) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Cumulated” 

Calculations for value cells. 

Displaying Documents 
(MENU_DISPLAY_DOCUMENTS) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Display Documents” 

Create Document 
(MENU_DOCUMENT_CREATE) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 
‘E’= Displayed in the “enhanced menu” 

Menu entry: “Create New Document” 

Show/Hide Document Properties 
(MENU_DISPLAY_DOCUMENT_PROP) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Show/Hide Document Properties” 

In the context of the Web item List of 
Documents. 

Calculate Result As... 

‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 
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Show/Hide Document Selection Criteria 
(MENU_DISPLAY_DOCUMENT_SELEC) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Show/Hide Document Selection 
Criteria” 

In the context of the Web item List of 
Documents. 

Report/Report Jump Targets 
(MENU_RRI) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: For report/report jump targets 

Export as …CSV File 
(MENU_EXPORT_TO_CSV) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Export as... CSV File” 

Export as ... MS Excel 2000 File 
(MENU_EXPORT_TO_XLS) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Export as ... MS Excel 2000 File” 

Bookmark 
(MENU_BOOKMARK) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 
‘E’= Displayed in the “enhanced menu” 

Menu entry: “Bookmark” 

Create bookmarks. 

Bookmark with Displayed Data 
(MENU_BOOKMARK_WITH_DATA) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Bookmark with Displayed Data” 

Create bookmark with the current data. When 
you call up the bookmark later, the “historical” 
data is displayed. 

Personalize Web Page 
(MENU_PERSONALIZE) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Personalize Web Page” 
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Display Charactieristic Properties 
(MENU_CHARACTERISTIC_PROPERTIES) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Display Characteristic Properties” 

Properties for characteristic cells. 

Value Cell Properties 
(MENU_VALUE_PROPERTIES) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: For value cell properties 

Properties for value cells. 

 

Query Properties 
(MENU_QUERY_PROPERTIES) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Query properties” 

Display variable screen 
(MENU_VARIABLE_SCREEN) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: For calling up variables screen 

Calls the screen for entering variables if the 
Web application contains queries with 
variables. 

 

Currency translation 
(MENU_CURRENCY_CONVERSION) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Currency Translation” 

Calls up the currency translation dialog box. 

Enhanced Menu 
(MENU_ENHANCED) 
‘ ’= Not displayed 

‘X’= “Always Display” in the basic menu 

‘E’= Displayed in the “enhanced menu” 

Menu entry: “Enhanced Menu” 

Display option for entries in the enhanced 
context menu. 

ENHANCED_MENU 
‘ ‘ = Start with basic menu 

‘X’ = Start with enhanced menu 

Start with Enhanced Menu 

You decide here whether the page opens with 
the basic menu (standard setting) or the 
enhanced menu. 

Examples 
For this example, Swap Axes appears in the basic context menu and the currency translation is 
completely hidden. 
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<object> 

<param name='OWNER' value='SAP_BW'> 
<param name='CMD' value='SET_PROPERTIES'> 
<param name='MENU_SWITCH_AXIS' value='X'> 
<param name='MENU_CURRENCY_CONVERSION' value=' '> 

</object> 
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 Enhancing the Context Menu 
Use 
As well as being able to make entries in the context menu visible, entries in the enhanced menu visible or 
entries in the enhanced menu invisible, you can also hang scenario-specific entries in the menu. You have 
two options: 

• You define the new entries using the Web Template Properties object tag.  

• You add the new entries to the menu using the JavaScript function. 

The former option is described in this section. 

In both cases, you have to write a JavaScript function that transfers the processing when you select the 
menu entry.  

For more detailed information, see Adding a Menu Entry using JavaScript [Seite 327]. 

  

Functions 
New entries are defined using different series of parameters in the Web template properties as follows: 

Parameter Description 

CMENU_LABEL_I Labeling text in the menu 

CMENU_FUNCTION_I JavaScript function for processing the 
command 
This function is implemented in JavaScript and 
is used to execute commands after selection of 
the menu entry. 

CMENU_PARAMETER_I Free parameter 
This parameter is passed to the JavaScript 
function 'CMENU_FUNCTION' and can be 
evaluated there as required. The parameter 
makes it possible to use a function for more 
than one menu entry. 
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CMENU_CELL_TYPE_I 
' ' = No restriction 

'CHARACTERISTIC' = Characteristic 

'CHARACTERISTIC_VALUE' = Characteristic 
value 

'STRUCTURE' = Structure 

'STRUCTURE_VALUE' = Structure component 
value 

'DATA' = Data cell 

'EXCEPTIONS' = Item exceptions 

'CONDITIONS' = Item conditions 

'DOCUMENT_LIST' = Item document list 

Context of the entry 
If you want the menu entry to appear only in 
certain contexts and not in all context menus, 
you can define this with 'cell_type' and 'filter'. 

CMENU_FILTER_I 
 

Context of the entry 

'CHARACTERISTIC', 
'CHARACTERISTIC_VALUE', 'STRUCTURE', 
'STRUCTURE_VALUE': Iobjnm 

According to the value of ‘cmenu_cell_type’, 
different values are useful here: 

'EXCEPTIONS': Exception ID 

'CONDITIONS': Condition ID 

'DOCUMENT_LIST': Document ID 

See Examples. 

CMENU_VISIBILITY_I 
‘ ‘= Not displayed 

‘X’= Displayed in the “basic menu” 

‘E’= Displayed in the “enhanced menu” 

Visibility of the entry 
You specify whether the entry is to appear in 
the basic menu or also in the enhanced menu. 

CMENU_POSITION_I 
'TOP' = Before the "normal" entries 

'BOTTOM' = After the "normal" entries 

Position of the entry 
The entries are inserted in the order in which 
they were called. You can choose if the entry 
should appear before the "normal" entries or 
after them in the menu. They may not occur 
between the "normal" entries. 

Examples 
. 
<object> 

// Menu entry at the beginning and only on customer cells 

 <param name=’OWNER’ value=’SAP_BW’> 
 <param name='CMD' value='SET_PROPERTIES'> 
 <param name='CMENU_LABEL_1' value='Customer details'> 
 <param name='CMENU_FUNCTION_1' value='myMenuProcessor'> 
 <param name='CMENU_PARAMETER_1' value='1'> 
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 <param name='CMENU_CELL_TYPE_1' value='CHARACTERISTIC_VALUE'> 
 <param name='CMENU_FILTER_1' value='0CUSTOMER'> 
 <param name='CMENU_VISIBILITY_1' value='X'> 
 <param name='CMENU_POSITION_1' value='TOP'> 

// Menu entry at the end for IT homepage 

 <param name='CMENU_LABEL_2' value='Customer details'> 
 <param name='CMENU_FUNCTION_2' value='myMenuProcessor'> 
 <param name='CMENU_PARAMETER_2' value='2'> 
 <param name='CMENU_VISIBILITY_2' value='X'> 
 <param name='CMENU_POSITION_2' value='BOTTOM'> 

// Menu entry at the beginning and only on material groups 

 <param name='CMENU_LABEL_3' value='Materials'> 
 <param name='CMENU_FUNCTION_3' value='myMenuProcessor'> 
 <param name='CMENU_PARAMETER_3' value='3'> 
 <param name='CMENU_CELL_TYPE_3' value='CHARACTERISTIC_VALUE'> 
 <param name='CMENU_FILTER_3' value='0MATGROUP'> 
 <param name='CMENU_VISIBILITY_3' value='X'> 
 <param name='CMENU_POSITION_3' value='TOP'> 

</object> 

You can find an example implementation for the JavaScript function “myMenuProcessor” under JavaScript 
[Seite 318]. 
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 Command Sequences 
Use 
There are some problems that require you to be able to change several objects differently with one 
command [Seite 231]. For example, with previous methods, you could not filter one data provider [Seite 

]  for the fiscal year 1999 and another data provider for 2000 with the same request (command). 268

A command sequence allows you to add new commands onto an original command. Data is only 
requested from the OLAP processor and the HTML page is only sent back to the Web Browser when all 
the commands have been processed.  

The commands in the sequence are added to the original command as the parameter CMD_N. Note that 
you have to replace the characters ‘=’ and ‘&’ with their hexadecimal display in the command sequence for 
commands in the sequence that are transported using a URL. 

• replace ‘=’ with ‘%3D’ 

• replace ‘&’ with ‘%26’ 

Each command in the sequence can have a maximum of 250 characters. If it contains more characters, 
these extra characters are cut off. 

 
If the command sequence takes up too much space to fit into a URL, add the attribute 
‘NO_OUTPUT’ to a command instead. As a result, the command is executed and an empty 
page is sent back. However, no data is read. This is therefore useful when you access a main 
frame from a control frame, for example. Using JavaScript, you can then carry out a sequence 
of single commands in the main frame and only leave out the attribute ‘NO_OUTPUT’ in the 
last command. 

Examples 
Start Web application and filter Data Provider 1 according to DE filters and Data Provider 2 
according to US filters 

http://myAppServer:myPort/SAP/BW/BEx?CMD=LDOC&template_id=yourTemplate&CMD_1=DATA_PR
OVIDER%3DDP1%26FILTER_IOBJNM%3D0COUNTRY%26FILTER_VALUE%3DDE&CMD_2=DATA_
PROVIDER%3DDP2%26FILTER_IOBJNM%3D0COUNTRY%26FILTER_VALUE%3DUS 

Filter command URL to Data Provider 1 according to calendar year 2000, change title of graphic 
(Chart) GRAPHIC to ‘2000’, and change title of table TABLE to ‘Details2000’ 
<SAP_BW_URL DATA_PROVIDER='DP1' FILTER_IOBJNM='0CALYEAR' FILTER_VALUE='2000' 
CMD_1='ITEM=GRAPHIC&CAPTION=2000' CMD_2='ITEM=TABLE&CAPTION=Details2000'> 
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 Using Forms 
Use 
With HTML forms you can integrate input fields easily into an HTML page. You can also use this HTML 
technology to create BEx Web applications. 

Functions 
Web Template Parameterization 
By using forms, you can set customized parameters when calling up Web applications. To do this you 
need an HTML document with a form, from which the URL for the Web application is called up with the 
relevant parameters. 

 
After calling up the following HTML document, the user is offered a form in which he or she 
can choose a calendar year and a country from dropdown boxes. After executing the submit 
command, the Web application appears with preset filters in the query views. 

<html> 
<body> 
<table> 
<form method="POST" 
http://myAppServer:myPort/SAP/BW/BEx?CMD=LDOC&template_id=yourTemplate&FILTER_IOBJNM_1=0
CALYEAR&FILTER_IOBJNM_2=0COUNTRY "> 

<tr> 
  <td>calendar year</td> 
  <td><select size="1" name="FILTER_VALUE_1"> 

<Option value="1997">1997</Option> 
<Option value="1998">1998</Option> 
<Option value="1999">1999</Option> 
<Option value="2000">2000</Option> 
</select></td> 
</tr> 
<tr> 
<td>Land</td> 
    <td><select name="FILTER_VALUE_2"> 

<Option value="BR">Brazil</Option> 
      <Option value="DE">Germany</Option> 
      <Option value="FR">France</Option> 
      <Option value="GB">Great Britain</Option> 
      <Option value="JP">Japan</Option> 
      <Option value="RU">Russia</Option> 
      <Option value="ES">Spain</Option> 
      <Option value="US">USA</Option> 

</table> 
<input type="submit" value="Submit" name="Submit"> 
</form> 
</body> 

</html> 
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Buttons and Forms in Web Templates 
You use the anchors (<a href=” ... ”></a>) and HTML forms to integrate commands into a Web template. 
This command can effect one or several Web items or Data Providers. 

At the point where URLs usually appear in HTML, you can use placeholders, that are described under 
command URLs [Seite 231] . These are automatically replaced during processing, so that only valid URLs 
appear in the HTML pages that you have created. 

 
Drilldown query view 1 by country and filter the calendar year to 2000 
<a href= <SAP_BW_URL DATA_PROVIDER=’View 1’ CMD=’Expand’ IOBJNM=’0COUNTRY’ 
FILTER_IOBJNM=’0CALYEAR’ FILTER_VALUE=’2000’>”>Year 2000 + Drilldown by 
country</a> 

Form, in which the user can choose a calendar year and a country from dropdown 
boxes. 

<form method="POST" action="<SAP_BW_URL DATA_PROVIDER=’*’ MULTI=’X’ 
FILTER_IOBJNM_1=’0CALYEAR’ FILTER_IOBJNM_2=’0COUNTRY’>"> 

<table> 

<tr> 
  <td>calendar year</td> 
  <td><select size="1" name="FILTER_VALUE_1"> 

<Option value="1997">1997</Option> 
<Option value="1998">1998</Option> 
<Option value="1999">1999</Option> 
<Option value="2000">2000</Option> 
</select></td> 
</tr> 
<tr> 
<td>Land</td> 
    <td><select name="FILTER_VALUE_2"> 

<Option value="BR">Brazil</Option> 
<Option value="DE">Germany</Option> 
<Option value="FR">France</Option> 
<Option value="GB">Great Britain</Option> 
<Option value="JP">Japan</Option> 
<Option value="RU">Russia</Option> 
<Option value="ES">Spain</Option> 
 <Option value="US">USA</Option></select></td> 
</tr> 

</table> 
<input type="submit" value="Submit" name="Submit"> 
</form> 

Buttons that filter view 1 according to calendar years 
<form method="POST" action="<SAP_BW_URL DATA_PROVIDER=’View 1’ 
FILTER_IOBJNM=’0CALYEAR’>"> 
<input type="submit" value="1998" name="FILTER_VALUE"> 
<input type="submit" value="1999" name="FILTER_VALUE"> 
<input type="submit" value="2000" name="FILTER_VALUE"> 
</form> 
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 Language-Dependent Texts 
Definition 
By using this BW-specific tag, you can install language-dependent texts in a Web application. 

Use 
You create text elements for an ABAP report that can then be translated. 

With the help of the SAP_BW_TEXT tag that you insert into a Web template, you can access the texts as 
follows: 

<SAP_BW_TEXT PROGRAM=’MYREPORT’ KEY=’001’> 

You can also use language-dependent headings for Web items. You can specify the headings as 
parameters either in the object tag of the Web item 

<param name=’CAPTION’ value=’SAP_BW_TEXT?PROGRAM=MYREPORT&KEY=001’> 

or fill the heading in the Web Application Designer as follows: 

SAP_BW_TEXT?PROGRAM=MYREPORT&KEY=001 

You can find additional information about language-dependent texts under Creating ABAP Programs for 
Maintaining Language-Dependent Texts [Seite 266]. 
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 Creating ABAP Programs for Maintaining Language-
Dependent Texts 
Use 
To make Web applications independent from static texts, you can maintain and translate the text in an 
ABAP table. The Web application is then filled with the corresponding texts according to the logon 
language.  

Prerequisites 
You are in the ABAP Editor (transaction SE38)  

Procedure 
1. In the Program field enter the name of the program, for example ZHTML_TEXTS and in the subobject 

screen, select Source Code. 

2. Choose  (Create). You reach the ABAP: Program Properties <Name of Program> Change screen.     

3. Enter the title of the program, for example Web Application Texts. 

4. Under Type in the Attributes field, choose Executable Program and then Save. You reach the Create 
Object Catalog Entry dialog box.    

5. In the Attributes field under Package enter $TMP and save the program as a Local Object.  

You have created an ABAP report called ZHTML_TEXTS 

6. In the menu bar choose Goto → Text Elements → Text Symbols. You reach the ABAP Text Elements: 
Display Text Symbols Language English screen. Choose  (Create <-> Change). 

Enter your texts in the empty table.  

a. In the Sym field enter the numerical key of the new text element (0-999), for example, 001. 

b. In the Text field, enter the name of the text element, for example, Credit Memos. 

The dLen field is filled automatically with the actual length of the text you entered, for 
example, 12 in the case of Credit Memos.  

c. In the mLen field, enter the maximum length of the text field.  

 
If the maximum length of the text field (mLen) is smaller than the actual length of the text field 
(dLen), the system asks you whether you want the text to be shortened to the maximum 
length. 

d. When you have entered all your texts, choose  (Activate). You reach the ABAP Text Elements: 
Change Text Symbols Language English screen.  

7. In the menu bar of the ABAP Text Elements: Change Text Symbols Language English, choose Goto 
→ Translation.  You reach the Target Language for Translation screen. 

a. Select the target language, into which you want to translate the texts, for example, DE and choose 
 (Continue). You reach the Translation: ABAP Text Pool: <Name of Program> ($) from 

Language <X> to <Y>, on which your texts and translation proposals from the ABAP text pool are 
displayed. For example, “Credit Memos” is translated as “Gutschriften”. You can transfer the 
proposals or edit them as you wish.  
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The program generated the text translations from the ABAP text pool if corresponding entries 
are available there. For texts without proposals you have to enter the translation yourself. 

b. Choose Save.  

Result 
In the Web template, you can now insert the following tag for the example text used here ZHTML_TEXTS: 
<SAP_BW_TEXT PROGRAM=’ZHTML_TEXTE’ KEY=‘001’>.   

The command inserts the text that you maintained with the key 001 in the table, in accordance with the 
logon language in the Web template, for example as the table title. 

<th><SAP_BW_TEXT PROGRAM=‘ZHTML_TEXTE’ KEY=‘001‘></th> 
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 Data Provider 
Definition 
Data Providers are objects that deliver data. When you navigate through the data, or parameterize the 
call-up, it may change the status of the data provider. A data provider can supply any number of Web 
items [Seite 36] with data. 

Structure 
Generic Attributes 
Generic attributes are attributes that are valid for every data provider. You need these attributes as soon 
as you begin to create a data provider. 

Attributes Description 

DATA_PROVIDER ( or name ) 
 

Logical name of the data provider 
This name is used to attach Web items to a 
particular data provider and to send commands 
to the data provider. The name must be unique 
within the Web template [Seite 225]  

WBID ( or DATA_PROVIDER_WBID ) 
(optional) 
 

Key assigned to the Excel workbook, under 
which you stored the data provider in the 
Business Explorer. 
You have to have saved the workbook in BW 
(favorites, roles). 

If you do not specify this parameter, the 
workbook ID (WBID) of the Web template is 
used instead. 

 
You cannot change these attributes with a command URL [Seite 23 ]1 . 

Commands 
It is possible to apply commands, such as filters, to data providers. In most cases, you must specify 
parameters for these commands. With some commands, it is possible to specify a whole list of parameter 
values. The parameter name is given an index “_1”, “_2”. In this rest of this document, this index is 
referred to as “parameter name_N” 

There is at least one example given for every command. This is displayed in the same syntax as 
described under Command URLs [Seite 231]. 

All commands have the following parameters in common: 

Parameter Description 
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CMD Name of the command 
Most commands are triggered by this 
parameter. As well as this type of command, 
there are also generic commands with 
parameters that you are able to assign to other 
commands. Generic commands are always 
applied after the named command. 

DATA_PROVIDER 
DATA_PROVIDER_N 

Name of the data provider 
You are able to apply a command to several 
data providers. You either specify a particular 
data provider, or display a list of possible data 
providers, or restrict the number of data 
providers by using wildcards (MULTI=‘X’). The 
command is applied to all these data providers, 
as long as they support this action. 

 
You must specify the data 
provider(s). 

MULTI 
 

Using the DATA_PROVIDER as a reference 
If MULTI is set to ‘X’, the command is applied 
to all the data providers that have 
‘DATA_PROVIDER’ in their name. ‘*’ means all 
data providers, for example. 

 
This parameter is optional. 

‘X’ = Yes, ‘  ’ = No 

 
Applying the command to the data provider ‘DP 1’ 
<SAP_BW_URL DATA_PROVIDER=’DP 1’ CMD=’...’ ...> 

 

Applying the command to the data providers ‘DP 1’ and ‘DP 1’ 
<SAP_BW_URL DATA_PROVIDER_1=’DP 1’ DATA_PROVIDER_1=’DP 2’ CMD=’...’ 
...> 

 

Applying the command to all the data providers that contain ‘USA’ in their name 
<SAP_BW_URL DATA_PROVIDER=’*USA*’ MULTI=’X’ CMD=’...’ ...> 
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 Stored Query Views 
Definition 
Stored query views are saved navigational states in a BW query. When you call up the Web template, a 
query view (not a database view) is created on the server with the saved navigational state. 

Structure 
Stored query views have the following attributes: 

Attributes Description 

DATA_PROVIDER_ID 

 
You cannot change this attribute 
with a command URL. 

Key for a query view 
The DATA_PROVIDER_ID that you specify, 
determines the initial status of the query view. 

VARIANT (optional) 

 
You cannot change this attribute 
with a command URL. 

Name of the variant used to fill the variables 
When you save a query view, the current 
variable values are saved with it. You can 
overwrite the values by specifying a variant 
(optional). You create variants from the 
variable screen. 

STYLE_SHEET (optional) Path to a stylesheet that you want to use to 
display F4-Help. 
If you do not specify anything here, the Web 
template stylesheet is used instead. 

HOME_FRAME (optional) Name of the main frame 
If you use HTML frame technology to display 
the data and you want to display the input Help 
in a separate frame to the Web template, you 
have to specify the name of the frame where 
the Web template is displayed for stored query 
views in the HOME_FRAME attribute . You 
also have to specify the attribute 
TARGET_HELP_FRAME for the navigation 
block Web item. 

BLOCK_SIZE (optional) Number of rows per block in the input help 
By entering this parameter, you can determine 
the number of rows displayed before an index 
to leaf through other blocks is started. If the 
value is set to 0, the complete table is 
displayed, regardless of the number of rows. 

 
The parameters VIEWID and WBID (DATA_PROVIDER_WBID) used in BW 2.x are still 
supported. We recommend, however, that you no longer use these. 

You can apply the following commands to a stored query view: 
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Properties of Stored Query Views [Seite 272] • 

Calling the Query Properties Dialog Box [Seite 276] • 

Back, Forwards and Back to Start [Seite 277] • 

Filters [Seite 278] • 

Removing Filters [Seite 28 ]1  • 

Calling Value Help [Seite 282] • 

Drilldowns [Seite 283] • 

Removing Drilldowns [Seite 284] • 

Switching Characteristics/Structures [Seite 285] • 

Swapping Axes [Seite 286] • 

Setting the Navigational Status [Seite 28 ]7  • 

Sorting [Seite 289] • 

Setting Properties of Display Attributes [Seite 291] • 

Positioning the Results Row [Seite 292] • 

Hiding the Results Row [Seite 293] • 

Setting the Display [Seite 294] • 

Calling the Characteristic Properties Dialog Box [Seite 295] • 

Translating Currencies [Seite 296] • 

Calling the Currency Translation Dialog Box [Seite 29 ]7  • 

Defining and Changing Exceptions [Seite 298] • 

Calling the Dialog Box for Defining Exceptions [Seite 300] • 

Setting the Status of an Exception [Seite 301] • 

Creating and Changing Conditions [Seite 302]  • 

Calling the Dialog Box for Defining Conditions [Seite 304] • 

Setting the Status of a Condition [Seite 305] • 

Displaying Documents [Seite 306] • 

Saving Query Views [Seite 307] • 
Properties of Value Cells [Seite 308] • 

Calling a Dialog for Cell Properties [Seite 309]  • 

Calculating Lists [Seite 310] • 

Operations for Display Hierarchies [Seite 312] • 

Jumping using the Report/Report Interface [Seite 316] • 

• Exporting Data [Seite 317] 
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 Properties of Query Views 
Definition 
Instruction for a query view. 

Use 
The query view has the most varied properties. You can change the properties by specifying the attribute 
and its value. You therefore do not have to specify parameter 'CMD'. 

The query view properties are evaluated at the end of command processing. 

Property 

Structure 
Description 

SUPPRESS_ZEROS 
‘X’ = Yes, ‘  ’ = No 

Hide rows/columns only containing null values 
(for all value cells for this combination of 
characteristics).  

ZERO_PRESENTATION 
'0' = display 

'1' = display without currency/unit 

'2' = do not display 

'3' = display zero text 

Zero value display 

ZERO_TEXT Text for zero value display '3' 

SHOW_SCALING_FACTORS 
‘X’ = Yes, ‘  ’ = No 

Display scaling factors and exclude currency / 
unit 

SIGN_PRESENTATION 
'1' = sign before number 

'2' = sign after number 

'3' = concatenated display 

Sign display 

‘X’ = Yes, ‘  ’ = No 
Display of characteristic and attribute keys fully 
concatenated. 

SHOW_DOCUMENTS 
‘X’ = Yes, ‘  ’ = No 

Show document links for each characteristic 
variant. 

SHOW_BOR_OBJECTS 
‘X’ = Yes, ‘  ’ = No 

Show Drag&Relate links (BOR links) for each 
characteristic variant of a BOR InfoObject. 

UHRY_ACTIVE_ROWS 
‘X’ = Yes, ‘  ’ = No 

Display rows as hierarchy 

UHRY_CAPTION_ROWS Labeling for rows for hierarchical display 

FULL_CONCAT_KEYS 
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UHRY_LEVEL_ROWS Number of objects (characteristics, hierarchies, 
structures) on the rows that are initially visible 
as hierarchy when display is switched on. 

UHRY_ACTIVE_COLUMNS 
‘X’ = Yes, ‘  ’ = No 

Display columns as hierarchy 

UHRY_CAPTION_COLUMNS Labeling for columns for hierarchical display 

UHRY_LEVEL_COLUMNS Number of objects (characteristics, hierarchies, 
structures) on the columns that are initially 
visible as hierarchy when display is switched 
on. 

Integration 
You can add the query view properties to any other command ! 
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 Resetting and Reinitializing Query Views 
Use 
You use this command to reinitialize data providers [Seite 268] of the type Query View. The query view is 
recreated according to the parameters and the Web items display the data for the new stored query view 
[Seite 270]. 

 
If you are using a Web item that requires, for example, a specific characteristic (such as the 
dropdown box [Seite 143] filter), the new data provider supports this characteristic. 

Functions 
CMD RESET_DATA_PROVIDER 

Parameter Description 

INFOCUBE 

Technical name of the query 

VARIANT (optional) Variant, if you are not required to enter a 
variable 

Technical name of the InfoCube 

QUERY 

or 

CMD RESET_DATA_PROVIDER 

Parameter Description 

DATA_PROVIDER_ID Technical name of the view 

VARIANT (optional) Variant, if you are not required to enter a 
variable 

 

 
Converting the data provider “View1” to another query: 
<SAP_BW_URL DATA_PROVIDER='View1' CMD='RESET_DATA_PROVIDER' 
INFOCUBE='myCube' QUERY='myQuery'> 

Converting the data provider “View1” to a saved view: 
<SAP_BW_URL DATA_PROVIDER='View1' CMD='RESET_DATA_PROVIDER' 
DATA_PROVIDER_ID='myViewID'> 
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 Displaying a Copy of a Data Provider on a New Page 
Use 
This command enables you to display a copy of the current navigation status of a data provider [Seite 268] 
on a new page. This command is suitable for detailed windows, in which you navigate independently of 
the overview window (see example). 

Functions 
CMD RELEASE_DATA_PROVIDER 

Parameter Description 

TEMPLATE_ID (optional) Name of the Web template 
Name under which you stored the Web 
template in the Web Application Designer. If 
this parameter is not specified, the standard 
template is used. 

Any other parameters for parameterizing 
your Web template 

See Calling Up Web Templates [Seite 23 ]2  

 
Displaying a copy of the status of the data provider “View 1” on a new page: 
<SAP_BW_URL DATA_PROVIDER='View1' CMD='RELEASE_DATA_PROVIDER'> 

Displaying a copy of the status of the data provider “View 1” in a new window with 
template 1: 
JavaScript call: SAPBWOpenWindow("<SAP_BW_URL DATA_PROVIDER='View1' 
CMD='RELEASE_DATA_PROVIDER'>","Details",600,400); 
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 Calling Dialog Query Properties 
Definition 
Instruction for a query view. 

Use 
You can call the Query Properties dialog with this instruction. 

Structure 
CMD Process_help_window 

HELP_SERVICE QUERY_PROPERTIES 
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 Back, Forwards, and Back to Start 
Definition 
Back, forwards, and back to start is a command for a query view in the Web template. 

Use 
By using this command, you can do the following for a query view: 

• undo the last action 

• undo all actions 

• or, in the event that you undo one or more actions, execute them again.  

 
In contrast to using the set function Back and Forwards available in the Web browser, these 
commands only affect the specified data provider and not the entire page. 

Structure 
CMD Description 

BACK Undoes the last action executed for this query 
view 

RESET Goes back to the navigation status that was 
visible when the Web application was called 

FORWARD Executes a previously undone action again 

 
The last action for query view1 is now undone 
<SAP_BW_URL DATA_PROVIDER='View1' CMD='BACK'> 

All query views are now reset to the status that was set when they were called  
<SAP_BW_URL DATA_PROVIDER='*' MULTI='X' CMD='RESET'> 
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 Filtering 
Definition 
Filter is a command for a query view in the Web template. 

Use 
You set filter values for characteristics and structures within a query view. It is possible to set several 
filters for the same characteristic / structure, or the same filter for several different characteristics / 
structures. Filter is a generic command, which means you do not have to set the ‘CMD’ parameter. 

 
You are able to add the filter parameters to any other command ! 

The actual filtering process is carried out at the end of the operation. 

Structure 
Parameter Description 

FILTER_IOBJNM 
FILTER_IOBJNM_N (optional) 
 

Name of the charcateristic / structure that 
you want to filter by 
Specify the technical name of the characteristic 
(0COUNTRY, for example) or the structure (25 
characters) here. 

FILTER_COLLAPS (optional) 
 
 

‘X’ = Yes, ‘  ’ = No 

Removing filter characteristics from the 
drilldown 
The characteristics that are specified under 
FILTER_IOBJNM, are removed from the axes 
after the filter has been applied. If you do not 
specify the parameters, the system assumes 
you want to use the value ‘X’ = Yes. 

VAR_SIGN_N (optional) Row effect 
'I' found values are added, 

'E' found values are removed. 

 
If the parameter is not specified, 
then 'I' is accepted. 

 
If the FILTER_IOBJNM_N entry is missing from an index n, the value from FILTER_IOBJNM 
is used, if available. 

For filtering individual values, the following parameters are also specified: 

Parameter Description 
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FILTER_VALUE 
FILTER_VALUE_N 
FILTER_VALUE_EXT 
FILTER_VALUE_EXT_N 
 

Filter Value 
Value that is filtered next. 

 
If the variant with the ending 'EXT' 
is chosen, the entire value in 
brackets has to be specified in the 
external dislay, for example, 
12.24.2000.  

If the ending 'EXT' is not used, the 
entire value in brackets has to be 
specified in the internal display, for 
example, 20001224 for 
12.24.2000.  

FILTER_VALUE_TYPE (optional) 
FILTER_VALUE_TYPE_N (optional) 

Type of value specified under 
FILTER_VALUE 
‘VALUE’ : Key for a characteristic value 

Operator 
'EQ' = Individual value 

'LT' = Less than 

'LE' = Less than or equal to 

'GT' = Greater than 

'GE' = Greater than or equal to 

 
If no operator is specified, then 
'EQ' is accepted. 

‘VARIABLE_EXIT’ : Name of an exit variable 
The filter is set using the values returned by the 
variable exit. Parameter, interval, and selection 
option variables are permitted for customer and 
SAP exit variables as well as for default values. 

OPERATOR (optional) 
OPERATOR_N (optional) 

For filtering intervals, the following parameters are also accepted: 

Parameter Description 

FILTER_VALUE_LOW 
FILTER_VALUE_LOW_N 
FILTER_VALUE_LOW_EXT 
FILTER_VALUE_LOW_EXT_N 
 

Filter value – lower limit (no brackets) 
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FILTER_VALUE_HIGH 
FILTER_VALUE_HIGH_N 
FILTER_VALUE_HIGH_EXT 
FILTER_VALUE_HIGH_EXT_N 
 

Filter value – upper limit (no brackets) 
 

For filtering hierarchy nodes, the following parameters are also accepted: 

Parameter Description 

FILTER_NODE_IOBJNM (optional) 
FILTER_NODE_IOBJNM_N (optional) 

Name of the Node Characteristic 

You have to specify the name of the node 
characteristic if you want to filter according to 
hierarchy nodes. With characteristic nodes and 
text nodes, you have to specify the 
characteristic name (0HIER_NODE). 

FILTER_VALUE 
FILTER_VALUE_N 
 

Hierarchy Node Name 

Examples 
Filter query view1 according to the country Germany 
<SAP_BW_URL DATA_PROVIDER=’View1’ FILTER_IOBJNM=’0COUNTRY’ FILTER_VALUE=’DE’> 

Filter query view1 according to the first three months 
<SAP_BW_URL DATA_PROVIDER=’View1’ FILTER_IOBJNM=’0CALMONTH’ 
FILTER_VALUE_LOW_EXT=’1’ FILTER_VALUE_HIGH_EXT='3'> 

Filter all query views according to costs, and the countries Germany and the USA 
<SAP_BW_URL DATA_PROVIDER=’*’ MULTI=’X’ 
FILTER_IOBJNM_1=’DRB9ZVVMBCHVX4F04Z1JGKYVC’ 
FILTER_VALUE_1=’DTG057U7OQ8K2ALKCMR2AWM14’ FILTER_IOBJNM_2=’0COUNTRY’ 
FILTER_VALUE_2=’DE’ FILTER_IOBJNM_3=’0COUNTRY’ FILTER_VALUE_3=’US’> 

Filter all query views according to the current month 
<SAP_BW_URL DATA_PROVIDER=’*’ MULTI=’X’ FILTER_IOBJNM=’0CALMONTH’ 
FILTER_VALUE=’0CMONTH’ FILTER_VALUE_TYPE=’VARIABLE_EXIT’> 
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 Removing Filters 
Definition 
Remove filter is a command for a query view in the Web template. 

Use 
You use this command to remove the filter from a characteristic or a structure for one or more query 
views. 

Structure 
CMD Remove_Filter 

Parameter Description 

IOBJNM 
IOBJNM_N 

Name of the characteristic/structure 

 

Specify here the technical name of the 
characteristic (0COUNTRY, for example) or 
structure (25 characters) from which you want 
to delete the filter. It is also possible to specify 
a list of characteristics/structures. 

ALL 
‘X’ = Yes, ‘  ’ = No 

Remove all filters 
Alternatively to listing characteristics and 
structures, you can remove all filters. 

Examples 
Remove the filter by country from query view1 
<SAP_BW_URL DATA_PROVIDER=’View1’ CMD=’Remove_Filter’ IOBJNM=’0COUNTRY’ > 

Remove the filter by country from all query views and filter according to calendar year 2000 
<SAP_BW_URL DATA_PROVIDER=’*’ MULTI=’X’ CMD=’Remove_Filter’ IOBJNM=’0COUNTRY’ 
FILTER_IOBJNM=’0CALYEAR’ FILTER_VALUE=’2000’> 

Remove all filters by country from query views and filter according to calendar year 2000 
<SAP_BW_URL DATA_PROVIDER='*' MULTI='X' CMD='Remove_Filter' ALL='X' 
FILTER_IOBJNM='0CALYEAR' FILTER_VALUE='2000'> 
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 Calling Value Help 
Definition 
Calling value help is a command for a query view in the Web template. 

Use 
By using this command you can call the filter value help for a characteristic or a structure for a query view. 

Structure 
CMD Process_help_window 

HELP_SERVICE DP_VIEW_FILTER 

Parameter Description 

IOBJNM 
 

Name of the characteristic/structure 
Specify the technical name of the characteristic 
here (for example, 0COUNTRY) or the 
structure (25-place character sequence) for 
which you want to call value help. 

BOOKED_VALUES Using posted values for value help 
If this parameter is not specified or is not set to 
‘X’, only values are displayed in the input help 
that are also booked in the InfoProvider within 
the scope of the currently valid filter conditions. 
This can take a long time under certain 
conditions.  

If the parameter is set to ' ', all dimension table 
values are displayed. This can be quicker, but 
can also display values that do not appear in 
the InfoProvider under the current filter 
conditions and when filtering can give the result 
No corresponding data found. 
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 Drilldown 
Definition 
Drilldown is a command for a query view in the Web template. 

Use 
Use this command to change the position of a characteristic or a structure for one or more query views. 

Structure 
CMD Expand 

Parameter Description 

IOBJNM 
 

Name of the characteristic/structure 
Specify the technical name of the characteristic 
here (for example, 0COUNTRY) or the 
structure (25-place character sequence that 
you want to bring into the drilldown. 

AXIS (optional) 
‘X’ = columns 

‘Y’ = rows 

’ ’ = Free characteristics (=remove drilldown) 

Axis on which the characteristic/structure is 
to be based 
If PARENT_IOBJNM is not specified, the 
characteristic/structure is brought onto the axis 
behind the other characteristics/structures. If 
you do not specify the parameter ‘AXIS’, the 
value ‘Y’ is used for characteristics, and ‘X’ for 
structures. 

PARENT_IOBJNM (optional) Name of a characteristic/structure on the 
axis 
When you specify this parameter, you can drag 
a characteristic/structure behind a different one 
on an axis. 

Examples 
Drilldown query view1 by country 
<SAP_BW_URL DATA_PROVIDER=’View 1’ CMD=’Expand’ IOBJNM=’0COUNTRY’ > 

Drilldown query view 1 by country and filter the calendar year to 2000 
<SAP_BW_URL DATA_PROVIDER=’View1’ CMD=’Expand’ IOBJNM=’0COUNTRY’ 
FILTER_IOBJNM=’0CALYEAR’ FILTER_VALUE=’2000’> 

Drag periods 1, 2, and 3 (2000) from query view1 to the columns 
<SAP_BW_URL DATA_PROVIDER=’View1’ CMD=’Expand’ IOBJNM=’0FISCPER’ AXIS=’X’ 
FILTER_IOBJNM=’0FISCPER’ FILTER_VALUE_1=’2000001’ FILTER_VALUE_2=’2000002’ 
FILTER_VALUE_3=’2000003’> 
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 Remove Drilldown 
Definition 
Remove drilldown is a command for a query view in the Web template. 

Use 
Use this command to remove a characteristic or a structure from the drilldown for one or more query 
views. This command is the same as the command Drilldown [Seite 283] if the parameter AXIS=’ ‘ is set. 

Structure 
CMD Collapse 

Parameter Description 

IOBJNM 
 

Name of the characteristic/structure 
Specify the technical name of the characteristic 
here (for example, 0COUNTRY) or the 
structure (25-place character sequence) that 
you want to remove from the drilldown. 

Example 
Remove drilldown by country from query view1 
<SAP_BW_URL DATA_PROVIDER=’View1’ CMD=’Collapse’ IOBJNM=’0COUNTRY’ > 
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 Switching Characteristics/Structures 
Definition 
Switch Characteristic/Structures is a command for a query view in the Web template. 

Use 
Use this command to remove a characteristic or a structure from a characteristic or a structure, for one or 
more query views. 

Structure 
CMD Exchange 

Parameter Description 

IOBJNM_1 
 

Name of characteristic/structure 
Specify the technical name of the 1st 
characteristic (0COUNTRY, for example) or the 
1st structure (25 characters) here. 

IOBJNM_2 
 

Name of characteristic/structure 
Specify the technical name of the 2nd 
characteristic (0COUNTRY, for example) or the 
2nd structure (25 characters) here. 

Example 
Replace drilldown by country with drilldown by calendar year in query view 1 
<SAP_BW_URL DATA_PROVIDER=’View 1’ CMD=’Exchange’ IOBJNM_1=’0COUNTRY’ 
IOBJNM_2=’0CALYEAR’> 

or 
<SAP_BW_URL DATA_PROVIDER=’View 1’ CMD=’Exchange’ IOBJNM_1=’0CALYEAR’ 
IOBJNM_2=’0COUNTRY’> 

 

Web Application Design: BEx Web Application Designer 30B
 285 



SAP Online Help  13.05.2002 

 Swapping Axes 
Definition 
Swap Axes is a command for a query view in the Web template. 

Use 
This command swaps the roles of the axes (the list is reversed). All the characteristics and structures in 
the rows are moved into the columns, and all the characteristics and structures in the columns are moved 
into the rows. 

Structure 
CMD Switch_Axes 

 
Swap axes for the query view1 
<SAP_BW_URL DATA_PROVIDER='View 1' CMD='SWITCH_AXIS'> 
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 Setting the Navigational State 
Definition 
Setting the navigational state is a command for a query view in the Web template. 

Use 
By calling this command, you can restructure or redistribute characteristics and structures on the axes. 

Structure 
CMD SET_NAV_STATE 

Parameter Description 

ALL 
‘X’ = Yes, ‘  ’ = No 

Redistribute all characteristics and 
structures 
If this parameter is set to ‘X’, then all 
characteristics and structures are taken from 
the axes and redistributed according to the 
other parameters. 

If the parameter is not set or is set to ‘ ‘, then 
the listed characteristics are assigned 
according to the parameters on the axes. 

IOBJNM 
IOBJNM_N 
 

Name of the characteristic/structure 
Specify the technical name of the characteristic 
here (for example, 0COUNTRY) or the 
structure (25-place character sequence) that 
you would like to place on an axis. 

AXIS 
AXIS_N 
‘X’ = columns 

‘Y’ = rows 

' ' = free characteristics 

Axis on which the characteristic/structure is 
to be based 
The characteristic or structure is based on the 
axis. The position on the axis is specified by 
the parameter ‘Position’. 

POSITION 
POSITION_N 

Position on an axis 
By specifying the position, the characteristic or 
structure is set for this position on the axis. 

 
If the position is not specified or is 
set to ‘0’, then the characteristic or 
structure is set at the end of the 
drilldown sequence. 

 
Moving the key figure structure to the rows and removing the calendar year and 
planned/actual structure from the columns 
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<SAP_BW_URL DATA_PROVIDER='View1' CMD='SET_NAV_STATE' ALL='X' 
IOBJNM_1='DTG057U7OQ8K2ALKCMR2AWM14' AXIS_1='Y' IOBJNM_2='0CALYEAR' 
POSITION_2='1' AXIS_2='X' IOBJNM_3='EFG057U7OQ8K2JKKCMR2AWM67' 
POSITION_3='2' AXIS_3='X'> 

Ensuring that the cost centers (and not the materials) are in the drilldown for all query 
views 
<SAP_BW_URL DATA_PROVIDER='*' MULTI='X' CMD='SET_NAV_STATE' 
IOBJNM_1='0COSTCENTER' AXIS_1='Y' IOBJNM_2='0MATERIAL' AXIS_2=' '> 
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 Sort 
Definition 
Sort is a command for a query view in the Web template. 

Use 
Depending on the parameterization, you use this command to sort characteristics or according to values. 

Structure 
CMD Sort 

Parameter Description 

SORT_TYPE 
'K' = Key 

'T' = Text 

'H' = Hierarchy 

'S' = Selection 

'V' = Value 

Type of sort 
Characteristics can be sorted according to key, 
name, hierarchy (if there is an active display 
hierarchy for the characteristic) or selection (if, 
in the query definition, there is more than one 
restricted single value or a query view is 
restricted dynamically). You can also sort 
according to values. 

SORT_DIRECTION 
'A' = Ascending 

'D' = Descending 

Required sort direction 

 
The sort direction for sort_type=H 
is always 'A'. 

IOBJNM 

 
Only for sorting characteristics. 

Characteristic that you want to sort 

 
This parameter is omitted when 
you are sorting according to 
values. 

STRUCTURE_MEMBER_1 

 
Only for sorting according to value. 

Component of the first structure 
If you sort according to value, you have to 
specify the value cell exactly. To do this, you 
have to specify the components of the structure 
(25-character string) for all the occurring 
structures (maximum 2). 

STRUCTURE_MEMBER_2 

 
Only for sorting according to value. 

Component of the second structure 
If two structures are defined in the query, you 
have to also determine the structural 
components of the second structure. 

 
Sorting Customers in Query View1 According to Text, in Ascending Order 
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<SAP_BW_URL DATA_PROVIDER='View1' CMD='SORT' IOBJNM='0CUSTOMER' 
SORT_TYPE='T' SORT_DIRECTION='A'> 

Sorting List According to Actual Sales, in Descending Order 
<SAP_BW_URL DATA_PROVIDER='View1' CMD='SORT' SORT_TYPE='V' 
SORT_DIRECTION='D' STRUCTURE_MEMBER_1='DTG057U7OQ8K2ALKCMR2AWM14' 
STRUCTURE_MEMBER_2='EFG057U7OQ8K2JKKCMR2AWM67'> 
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 Setting Properties of Display Attributes 
Definition 
Instruction for a query view. 

Use 
You can change the properties of display attributes with this command. 

Structure 
CMD SET_ATTRIBUTE 

Parameter Description 

IOBJNM 
 

Name of characteristic 
Specify the technical name of the characteristic 
(0COUNTRY, for example) to which the 
attribute belongs here. 

ATTRINM 
 

Name of the attribute 
Define the technical name of the display 
attribute here. 

ACTIVE 
‘X’ = Yes, ‘  ’ = No 

Display attribute 

POSITION Position of the attribute within the attribute 

PRESENTATION 
'KEY' = key 

'TEXT' = shortest text 

'TEXT_MD' = middle-length text 

'TEXT_LG' = long text 

'KEY_TEXT' = key and text 

'TEXT_KEY' = text and key 

Layout 
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 Results Row Position 
Definition 
Instruction for a query view. 

Use 
You can define the position of the results row with this command. Hierarchy nodes are also based on this 
setting if there are other objects with competing settings on the hierarchy axis. 

Structure 
Result position 

CMD SET_RESULT_POSITION 

Parameter Description 

AXIS 
‘X’ = columns 

‘Y’ = rows 

Axis on which the result position should be 
set 

RESULT_POSITION 
'TOP' = Top/left 

'BOTTOM' = Bottom/right 

Result position 
 

Hierarchy Node Position 

CMD SET_RESULT_POSITION 

Parameter Description 

IOBJNM 
 

Name of characteristic 
Enter the technical name of the characteristic 
on which the hierarchy node position should be 
defined here. 

RESULT_POSITION 
'TOP' = Top (left) 

'BOTTOM' = Bottom (right) 

Node position 
The information in brackets represent what 
happens if the characteristic is on the columns. 
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 Suppression of Result Rows 
Definition 
Instruction for a query view. 

Use 
You can suppress results row with this command. 

Structure 
CMD SET_SUPPRESSION 

Parameter Description 

IOBJNM 
 

Name of characteristic 
Define the technical name of the characteristic 
(e.g. 0COUNTRY) here. 

RESULT_SUPPRESSION 
'NEVER' = No suppression 

'CONDITIONAL' = Conditional suppression 

'ALWAYS' = Always suppress 

Suppression method 
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 Define Display 
Definition 
Instruction for a query view. 

Use 
You can change the display of characteristics, hierarchy node types and attributes with this command. 

Structure 
CMD SET_PRESENTATION 

Parameter Description 

IOBJNM 
 

Name of characteristic 
Define the technical name of the characteristic 
(e.g. 0COUNTRY) here. 

NODE_IOBJNM (Option 1) Name of the node characteristic 

With characteristic nodes and text nodes, you 
have to specify the characteristic name 
(0HIER_NODE). 

ATTRINM (Option 2) 
 

Name of the attribute 
Define the technical name of the display 
attribute here. 

PRESENTATION 
'NONE' = No display (only for characteristics) 

'KEY' = key 

'TEXT' = shortest text 

'TEXT_MD' = middle-length text 

'TEXT_LG' = long text 

'KEY_TEXT' = key and text 

'TEXT_KEY' = text and key 

Layout 
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 Calling Dialog Characteristic Properties 
Definition 
Instruction for a query view. 

Use 
You can call the Characteristic Properties dialog with this command. 

Structure 
CMD Process_help_window 

HELP_SERVICE CHAR_PROPERTIES 

Parameter Description 

IOBJNM 
 

Name of characteristic 
Define the technical name of the characteristic 
(e.g. 0COUNTRY) here. 
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 Currency Translation 
Definition 
Instruction for a query view. 

Use 
You can define a new currency translation for the query view with this command. 

Structure 
CMD CURRENCY_CONVERSION 

Parameter Description 

CUR_CONV_METHOD Currency translation type 

CUR_CONV_TYPE 
‘0’ = database currency 

'1' = as in the query definition 

'2' = into target currency 

'3' = into target currency via definition currency 

Translation type 

TARGET_CURRENCY Target currency 
Only need be specified for CUR_CONV_TYPE 
2 and 3 
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 Calling a Dialog for Currency Translation 
Definition 
Instruction for a query view. 

Use 
You can call the dialog for currency translation with this command. 

Structure 
CMD Process_help_window 

HELP_SERVICE CURRENCY_CONVERSION 
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 Defining and Changing Exceptions 
Definition 
Instruction for a query view. 

Use 
You can change existing (local) exceptions and define new (local) ones with this command. 

 
Exceptions that were defined in the Query Designer cannot be changed. 

Structure 
CMD SET_EXCEPTION 

Parameter Description 

EXCEPTION_ID 
(optional) 

ID of the condition to be changed 
If there is no exception with this ID, a new one 
is created. A new exception is also created if 
this parameter is not filled. 

ACTIVE 
‘X’ = Yes, ‘  ’ = No 

Exception active 

DESCRIPTION Description 
This text is displayed in the list of exceptions. 

IOBJNM_I Context in which a characteristic must be 
The exception is only evaluated if the data cell 
for the given characteristic is in the context 
described by parameters OPERATOR and 
VALUE. 

OPERATOR_I Context in which a characteristic must be 
Valid operators are: 

'AL' = No restrictions 

'AG' = Aggregated (no filtering) 

'EQ' = A certain value 

'NA' = Restricted to a value 

'HL' = Hierarchy level 

VALUE_I Context in which a characteristic must be 
Key of the characteristic value if operator 'EQ' 
and hierarchy level if operator 'HL'. 
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ALERT_LEVEL_J Alert Level 
The alert level can have the values 1, 2 and 3 
for good numbers, 4, 5 and 6 for critical 
numbers and 7, 8, and 9 for bad numbers. 

OPERATOR_J Operator for the data values 
'EQ' = Equal to 

'NE' = Not equal to 

'BT' = Interval 

'LE' : Less than or equal to 

'LT' = Less than 

'GE' : Greater than or equal to 

'GT' = Greater than 

VALUE_LOW_J Data cell value 

VALUE_HIGH_J Data cell value to 
This parameter is only needed for interval 
operators. 
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 Calling a Dialog for Defining Exceptions 
Definition 
Instruction for a query view. 

Use 
You can call the dialog for defining exceptions with this command. 

Structure 
CMD Process_help_window 

HELP_SERVICE EXCEPTION_DEFINITION 

Parameter Description 

EXCEPTION_ID Name of exception 
Enter the technical name of the exception here 
if you want to change an existing exception. If 
no value is defined for this parameter, a new 
exception will be created. 
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 Setting the Status of an Exception 
Definition 
Set the status of an exception is a command for a query view in the Web template. 

Use 
You call this command when you want to change the status of an exception in a query view. 

Structure 
CMD Set_Exception_State 

Parameter Description 

EXCEPTION_ID 
 

Technical name of the exception 
Give the technical name of the exception here 
(25-place character sequence). 

ACTIVE (Option 1) 
‘X’ = activate, ‘  ’  = deactivate 

Required exception status 
 

TOGGLE_STATE (Option 2) 
‘X’ = switch, ‘  ’  = do not switch 

Change the exception status 
If this attribute is set to ‘X’, the exception is 
activated, if it is not active already, and 
deactivated, if it is active. 

Examples 
Set the exception “Problems in Sales” in Query View1 to active 
<SAP_BW_URL DATA_PROVIDER=’View1’ CMD=’Set_Exception_State’  

EXCEPTION_ID=’DTG057U7OQ8K2ALKCMR2AWM14’ ACTIVE=’X’> 

Change the exception “Problems in Sales” in Query View1 
<SAP_BW_URL DATA_PROVIDER=’View1’ CMD=’Set_Exception_State’  

EXCEPTION_ID=’DTG057U7OQ8K2ALKCMR2AWM14’ TOGGLE_STATE=’X’> 
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 Creating and Changing Conditions 
Definition 
Instruction for a query view. 

Use 
'You can change existing (local) conditions and define new (local) ones with this command. 

 
Conditions that were defined in the Query Designer cannot be changed. 

Structure 
CMD SET_CONDITION 

Parameter Description 

CONDITION_ID 
(optional) 

ID of the condition to be changed 
If there is no condition with this ID, a new 
condition is created. A new exception is also 
created if this parameter is not filled. 

ACTIVE 
‘X’ = Yes, ‘  ’ = No 

Condition active 

DESCRIPTION Description 
This text is displayed in the list of conditions. 

IOBJNM_I List of characteristics 
List of the characteristics for which the 
condition should be applied in combination. If 
no characteristic is specified, the condition is 
applied to all characteristics. 

STRUCTURE_MEMBER_1_I Component of the first structure 
A condition always refers to exactly one value 
cell. To do this, you have to specify the 
components of the structure (25-character 
string) for all the occurring structures 
(maximum 2). 

STRUCTURE_MEMBER_2_I Component of the second structure (if it 
exists) 
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OPERATOR_I An operator 
'EQ' = Equal to 

'NE' = Not equal to 

'BT' = Interval 

'LE' : Less than or equal to 

'LT' = Less than 

'GE' : Greater than or equal to 

'GT' = Greater than 

'TC' = Top n 

'TP' = Top percent 

'TS' = Top sum 

'BC' = Bottom n 

'BP' = Bottom percent 

'BS' = Bottom sum 

VALUE_LOW_I Numerical value for operator 

VALUE_HIGH_I Numerical value for operator 
Only the interval operator needs this value. 
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Calling a Dialog for Defining Conditions 
Definition 
Instruction for a query view. 

Use 
You can call the dialog for defining conditions with this command. 

Structure 
CMD Process_help_window 

HELP_SERVICE CONDITION_DEFINITION 

Parameter Description 

CONDITION_ID Name of the condition 
Enter the technical name of the condition here 
if you want to change an existing condition. If 
no value is defined for this parameter, a new 
condition will be created. 
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 Setting the Status of a Condition 
Definition 
Set the status of an condition is a command for a query view in the Web template. 

Use 
You call this command when you want to change the status of a condition in a query view. 

Structure 
CMD Set_Condition_State 

Parameter Description 

CONDITION_ID Technical name of the condition 
Give the technical name of the condition here 
(25-place character sequence). 

ACTIVE (Option 1) 
‘X’ = activate, ‘  ’  = deactivate 

Required status for the condition 
 

TOGGLE_STATE (Option 2) 
‘X’ = switch, ‘  ’  = do not switch 

Change the status of the condition 
If this attribute is set to ‘X’, the condition is 
activated, if it is not active already, and 
deactivated, if it is active. 

Examples 
Set the condition “Top 10 Customers” in query view1 to active 
<SAP_BW_URL DATA_PROVIDER='View1' CMD='Set_Condition_State'  

CONDITION_ID='DTG057U7OQ8K2ALKCMR2AWM14' ACTIVE='X'> 

Change the “Top 10 Customers” condition in query view1 
<SAP_BW_URL DATA_PROVIDER='View1' CMD='Set_Condition_State'  

CONDITION_ID='DTG057U7OQ8K2ALKCMR2AWM14' TOGGLE_STATE='X'> 

 

Web Application Design: BEx Web Application Designer 30B
 305 



SAP Online Help  13.05.2002 

 Displaying Documents 
Definition 
Instruction for a query view. 

Use 
You can call the document display for the selected context with this command. 

Structure 
You can access four different contexts: 

CMD DOCUMENTS 

Parameter Description 

NAVIGATIONAL_STATE (Option 1) 
‘X’ = Yes, ‘  ’ = No 

Documents for the current navigation status

DATA_ROW (Option 2) Documents for a data cell: Y coordinate 
Coordinates in the data block 

DATA_COLUMN (Option 2) Documents for a data cell: X coordinate 
Coordinates in the data block 

IOBJNM (Option 3) Documents for a characteristic 

IOBJNM (Option 4) Documents for a characteristic value: 
characteristic 

VALUE (Option 4) Documents for a characteristic value: key 
Characteristic value in internal representation 
(without conversion exit) 
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 Saving the Query View 
Definition 
Command for a query view. 

Use 
You use this command to save a query view as a reusable object. 

Structure 
CMD SAVE_VIEW 

Parameter Description 

TECH_NAME Technical name of the view 

DESCRIPTION Description 

OVERWRITE 
‘X’ = Yes, ‘  ’ = No 

Overwrite existing view 

 

 

 

Web Application Design: BEx Web Application Designer 30B
 307 



SAP Online Help  13.05.2002 

 Properties of Value Cells 
Definition 
Instruction for a query view. 

Use 
You can change the properties of value cells with this command. 

Structure 
CMD SET_VALUE_PROPERTIES 

Parameter Description 

STRUCTURE_MEMBER_1 
 

Component of the first structure 
The properties are defined for a value cell. To 
do this, you have to specify the components of 
the structure (25-character string) for all the 
occurring structures (maximum 2). 

STRUCTURE_MEMBER_2 Component of the second structure (if it 
exists) 

SCALING_FACTOR Scaling factors 
0=No scaling, 1=Factor 10, 2=Factor 100, ... 

DECIMAL_PLACES Number of displayed decimal places 

EMPHASIS 
‘X’ = Yes, ‘  ’ = No 

Display with highlighting 
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 Calling a Dialog for Cell Properties 
Definition 
Instruction for a query view. 

Use 
You can call the dialog for cell properties with this command. 

Structure 
CMD Process_help_window 

HELP_SERVICE STRUC_MEMBER_PROPERTIES 

Parameter Description 

STRUCTURE_MEMBER_1 
 

Component of the first structure 
Enter the value  of the first structure 
component here. The combination of structure 
components defines the coordinates for a cell.  

STRUCTURE_MEMBER_2 Component of the second structure (if it 
exists) 
Enter the value of the second structure 
component here. The combination of structure 
components defines the coordinates for a cell. 

 

 

 

Web Application Design: BEx Web Application Designer 30B
 309 



SAP Online Help  13.05.2002 

List Calculation 
Definition 
List calculation is a command for a query view in the Web template. 

Use 
With this command you can change the settings for calculating lists for a value cell. 

Structure 
CMD SET_LIST_CALCULATION 

Parameter Description 

STRUCTURE_MEMBER_1 Component of the first structure 
The value cell must be determined exactly for 
calculating lists. To do this, you have to specify 
the components of the structure (25-character 
string) for all the occurring structures 
(maximum 2). 

STRUCTURE_MEMBER_2 Component of the second structure (if it 
exists) 

APPLY_TO_RESULTS (optional) 
‘X’ = Yes, ‘  ’ = No 

Use calculation guidelines also for event 
cells 

CUMULATION (optional) 
‘X’ = Yes, ‘  ’ = No 

Cumulated output 

VALUE_CALCULATION (optional) Calculations 
' ' = No list calculation 

'R' = Norming for query result 

'G’ = Norming for overall result 

'C' = Norming for result 

'S' = Ranking list 

'O' = Ranking list (olympic) 
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RESULT_CALCULATION (optional) Calculations for result cells 
'00' = No list calculation 

'01' = Summation 

'02' = Maximum 

'03' = Minimum 

'04' = Count of all values 

'04' = Count of all values 

'06' = Average using all values 

'06' = Average using all values <> 0 

'08' = Standard deviation 

'09' = Variance 

'10' = Hide results 

'11' = First value 

'12' = Last value 

Example 
Display maximum plan sales 
<SAP_BW_URL DATA_PROVIDER='View1' CMD='SET_LIST_CALCULATION' 
STRUCTURE_MEMBER_1='DTG057U7OQ8K2ALKCMR2AWM14' 
STRUCTURE_MEMBER_2='EFG057U7OQ8K2JKKCMR2AWM67' VALUE_CALCULATION='02'> 

See also: 
OLAP Functions for Active Cells [Extern] 
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 Operations for Display Hierarchies 
Definition 
Operations on Display Hierarchies contains commands for a query view in a Web template. 

Use 
There are four operations that you apply to display hierarchies: 

1. With the SET_HIERARCHY_STATE command, you activate or deactivate a display hierarchy that 
has been assigned to a characteristic (for example, in the query definition or in a query view). 

CMD SET_HIERARCHY_STATE 

Parameter Description 

IOBJNM Name of characteristic 
Characteristic with a display hierarchy 
assigned to it already. 

ACTIVE (Option 1) 
‘X’ = activate, ‘  ’  = deactivate 

Required status of the display hierarchy. 
 

TOGGLE_STATE (Option 2) 
‘X’ = switch, ‘  ’  = do not switch 

Switch the status of a hierarchy 
If this attribute is set to ‘X’, the display 
hierarchy is activated, if it is not active already, 
and deactivated, if it is currently active. 

 
Activating a Hierarchy for the Cost Center Characteristic for Query View1 
<SAP_BW_URL DATA_PROVIDER='View1' CMD='Set_Hierarchy_State' 
IOBJNM='0COSTCENTER' ACTIVE='X'> 

2. You use the SET_HIERARCHY command to assign a display hierarchy to a characteristic. 

CMD SET_HIERARCHY 

Parameter Description 

IOBJNM Name of characteristic 
Characteristic that you want to assign a display 
hierarchy to. 

HIERARCHY_NAME Technical name of the hierarchy 

HIERARCHY_VERSION Hierarchy version 
If the hierarchy has a particular version, you 
must specify the version. Otherwise you can 
leave out this parameter. 
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HIERARCHY_DATE Key date for the hierarchy 
You specify the key date for time-dependent 
hierarchies here. The date must be formatted 
as YearMonthDay (for example, 20002412). 

 
If the parameter is not transferred, 
the key date in the query is copied. 

ACTIVE 
‘X’ = activate, ‘  ’  = deactivate 

Required status of the display hierarchy. 
 

 
Assigning ‘MyHierarchy’ to the Cost Center Characteristic for Query View1 
<SAP_BW_URL DATA_PROVIDER='View1' CMD='Set_Hierarchy' 
IOBJNM='0COSTCENTER' Hierarchie_Name='MyHierarchy' ACTIVE='X'> 

3. You use the DRILL_TO_LEVEL command to expand the display hierarchy up to a specified hierarchy 
level. 

CMD DRILL_TO_LEVEL 

Parameter Description 

IOBJNM Name of characteristic 
Characteristic, to which an active display 
hierarchy is assigned. 

LEVEL Hierarchy level 
Level to which you want to expand the 
hierarchy. Level 1 is the root level. 

 
If a hierarchy node is filtered at the 
same time, make sure that the 
level is higher than the level of the 
filtered node. 

 
Drilldown Cost Center Characteristic for Query View1 up to Level 3 
<SAP_BW_URL DATA_PROVIDER='View1' CMD='Drill_To_Level' 
Iobjnm='0COSTCENTER' Level='3'> 

4. You use the SET_DRILL_STATE command you can expand and collapse a node from a display 
hierarchy. 

 
Note that the node must be visible in the list in the current navigation status. 

The command is a useful way of influencing the extent to which the hierarchy is expanded when 
you are calling a Web application, activating a hierarchy, or determining and activating a 
hierarchy. Command sequences are used to execute both commands at the same time. 

CMD SET_DRILL_STATE 
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Parameter Description 

IOBJNM Name of characteristic 
Characteristic, to which an active display 
hierarchy is assigned. 

POSITION Data position in the drilldown 
Since several objects can be drilled down on 
an axis, the node specifications are no longer 
unique. Therefore, the axis position is used 
instead. For example, the fifth data line. 

DRILL_STATE Level to which you want the hierarchy to be 
expanded 
'E' = hierarchy nodes expanded 

'C' = collapse 

'U' = by activating “Display as Hierarchy” on the 
axis: drilldown according to the next object on 
the axis 

 
Specifying the Hierarchy for the Cost Center Characteristic for Query View1 and 
Simultaneously Expanding the Fifth Node on the Axis 
<SAP_BW_URL DATA_PROVIDER='View1' CMD='Set_Hierarchy' 
IOBJNM='0COSTCENTER' Hierarchie_Name='MyHierarchy' ACTIVE='X' 
CMD_1='CMD=set_Drill_State&Data_Provider=View1&iobjnm=0COSTCENTER&POSITION=
5&Drill_State=E'> 

A command sequence is used in this example. 

See also: 

Command Sequences [Seite 261] 
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 Calling Up Dialog Box for Formula Definition 
Definition 
Command for a query view. 

Use 
You can use this command to call up a dialog box for defining a new or an existing formula. 

Structure 
CMD Process_help_window 

HELP_SERVICE DP_VIEW_SET_CALC_MEMBER 

SUBCMD NEW 

Parameter Description 

FORMULA_STRUCTURE Technical name of structure 

 

CMD Process_help_window 

HELP_SERVICE DP_VIEW_SET_CALC_MEMBER 

SUBCMD CHANGE 

Parameter Description 

FORMULA_ID Technical name of formula 
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 Goto using Report/Report Interface. 
Definition 
Command for a query view. 

Use 
You can use this command to execute a report to report jump. You can jump from one Web template to 
another Web template, to another query, or to a transaction in a R/3 system and much more. 

Structure 
CMD RRI 

Parameter Description 

RRI_RECEIVER RRI Recipient ID 
 

DATA_ROW 
(optional) 

Data row 
Context from which jump is made 

(optional) 
Data column 
Context from which jump is made 

IOBJNM 
(optional) 

a characteristic 
Context from which jump is made 

DATA_COLUMN 

Example 
Jump to XYZ 
<SAP_BW_URL DATA_PROVIDER='View1' CMD='RRI' RRI_RECEIVER='XYZ'> 

See also: 
Overview: Report-Report-Interface [Extern] 

Defining Sender/Receiver Assignment to the R/RI in BW [Extern] 
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 Exporting Data 
Definition 
Instruction for a query view. 

Use 
You can export the data of a query view to a CSV or MS Excel 2000 file with this instruction. 

Structure 
CMD EXPORT 

Parameter Description 

FORMAT Format 
'CSV' = CSV file 

'XLS'  = MS Excel 2000 file 

Example 
Exporting data to MS Excel 2000 
<SAP_BW_URL DATA_PROVIDER='View1' CMD='EXPORT' FORMAT='XLS'> 
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 Use of JavaScript Functions 
Use 
You can execute commands or command sequences with JavaScript as well as by using 
<SAP_BW_URL> tags.  

Another JavaScript application is the enhancement of the context menu to include customer-specific 
entries. 

All subsequent examples refer to JavaScript excerpts. 

Functions 
You can choose from the following functions: 

Sending Instructions [Seite 319] 

Enhancing the Context Menu with JavaScript [Seite 326] 

Logon Language [Seite 33 ]7  
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 Sending Instructions 
Use 
You must create an URL before you can send it. The following options are available: 

• Use of the <SAP_BW_URL> tag 

• Use of BW JavaScript function SAP_BW_URL_GET(). This returns the same as the 
<SAP_BW_URL>tag, but can be called from outside its own frame. 

Functions 
JavaScript Function SAP_BW_URL_GET 

Return value Start of an URL for calling an instruction 
that should be executed in the same page 
context. 

 
Prepare Bookmark URL 
var = "<SAP_BW_URL CMD='BOOKMARK'>"; 

gives you the same as 

var = "<SAP_BW_URL>" + "&CMD=BOOKMARK"; 

or 

var =  SAP_BW_URL_GET() + "&CMD=BOOKMARK"; 

There are a number of JavaScript functions for sending instructions. Functions that simplify the 
management of windows and that permit you to call for example property dialogs in separate windows are 
provided. These functions take into consideration whether or not the Web browser should use JavaScript. 
No new windows are created for example for a pocket IE device. 

You can choose from the following JavaScript functions: 

Execute URL in the Same Window [Seite 320] 

Execute URL in a New Window [Seite 321] 

URL from a New Window in the Opening Window [Seite 322] 

Close Window [Seite 323] 

Execute Form in a New Window [Seite 324] 

Execute Form in the Opening Window [Seite 325] 
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 Execute URL in the Same Window 
Use 
JavaScript function for sending commands. 

Functions 
JavaScript Function SAPBWOpenURL 

Parameter Description 

url URL to be started. 

Example 
Send Bookmark URL 
SAPBWOpenURL(SAP_BW_URL_GET() + "&CMD=BOOKMARK"); 

or in HTML: 

<a href="JavaScript:SAPBWOpenURL(SAP_BW_URL_GET() + '&CMD=BOOKMARK');">Create 
bookmark</a> 

Open SAP Portals Homepage 
SAPBWOpenURL("http://www.sapportals.com"); 
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 Executing an URL in a New Window 
Use 
JavaScript function for sending commands. 

Functions 
The URL is executed in a new window (if the output device permits this). This is advantageous for 
example for selecting filter values and for the properties dialogs. 

JavaScript Function SAPBWOpenWindow 

Parameter Description 

url URL to be started. 

Name Window name 

Width Width of the window 

Height Height of the window 

Example 
Call Select filter value dialog for characteristic 0Costcenter of Data Provider ABC 
SAPBWOpenWindow(SAP_BW_URL_GET() + 
"&CMD=PROCESS_HELP_WINDOW&HELP_SERVICE=DP_VIEW_FILTER&DATA_PROVIDER=ABC&I
OBJNM=0COSTCENTER","FILTER",800,600); 

or in HTML: 

<a href="JavaScript:SAPBWOpenWindow(SAP_BW_URL_GET() + 
'&CMD=PROCESS_HELP_WINDOW&HELP_SERVICE=DP_VIEW_FILTER&DATA_PROVIDER=ABC&I
OBJNM=0COSTCENTER','FILTER',800,600);">Define filter value for cost center</a> 

Display self-made form in a new window 
SAPBWOpenWindow("http://.../CustomerForm.htm","CONFIG",300,200); 

Open SAP Portals homepage in a new window 
SAPBWOpenWindow("http://www.sapportals.com","SAPPORTALS",800,600); 
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 URL from a New Window in the Opening Window 
Use 
JavaScript function for sending commands. 

Functions 
You can send an URL on the opening window from a new window with this function. The properties of the 
output device are taken into consideration. 

JavaScript Function SAPBWSetOpenerUrl 

Parameter Description 

url URL to be started in the opener window. 

close 
true = close, false = leave open 

Then close window 

Example 
Start a new Web application in the main window 
SAPBWSetOpenerUrl(SAP_BW_URL_GET() + "&CMD=LDOC&TEMPLATE_ID=NewTemplate"); 

or in HTML: 

<a href="JavaScript:SAPBWSetOpenerUrl(SAP_BW_URL_GET() + 
"&CMD=LDOC&TEMPLATE_ID=NewTemplate");">New Web report</a> 
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 Closing Windows 
Use 
JavaScript function for sending commands. 

Functions 
With this function you can close a window without having to execute a command. 

 
The properties of the output device are taken into consideration. If the output device does not 
accept JavaScript, the function pages back by one page. 

JavaScript Function SAPBWCloseWindow 

Example 
Close window 
SAPBWCloseWindow(); 

or in HTML: 

<a href="JavaScript:SAPBWCloseWindow();">Close window</a> 
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 Executing a Form in a New Window 
Use 
JavaScript function for sending commands. 

Functions 
The form is executed in a new window (if the output device permits this). You can use this function to 
create your own forms for control in a Web template. 

JavaScript Function SAPBWWForm 

Parameter Description 

name Window name 

formname Name of form 

width Width of the window 

height Height of the window 

Example 
Execute a Form in a New Window 
SAPBWWForm("WindowName","FormName",800,600); 

or in HTML: 

<a href="JavaScript:SAPBWWForm("WindowName","FormName",800,600);">Evaluate form in a new 
window</a> 
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 Executing a Form in the Opening Window 
Use 
JavaScript function for sending commands. 

Functions 
You can execute a form on the opening window from a new window with this function. 

 
The properties of the output device are taken into consideration. 

JavaScript Function SAPBWOpenerSubmitForm 

Parameter Description 

formname Name of form 

close 
true = close, false = leave open 

Then close window 

Example 
Execute form in the opening window and close window 
SAPBWOpenerSubmitForm("FormName",true); 

or in HTML: 

<a href="JavaScript:SAPBWOpenerSubmitForm('FormName',true);">Execute form and close window</a> 

 

 

Web Application Design: BEx Web Application Designer 30B
 325 



SAP Online Help  13.05.2002 

 Enhancing the Context Menu with JavaScript 
Use 
As well as being able to make entries in the context menu visible, entries in the enhanced menu visible or 
entries in the enhanced menu invisible, you can also hang scenario-specific entries in the menu. There 
are several options: 

• You define the new entries for the Web template properties with the object tag. For more information 
see Object Tag for the Properties of Web Templates [Seite 228] 

You hang the new entries in the context menu with a JavaScript function. You can find more detailed 
information under: 

• 

Adding a Menu Entry with JavaScript [Seite 327] 

Command Processing [Seite 329] 

 
In both cases you must write a JavaScript function that processes the menu entry selection. 
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 Adding a Menu Entry using JavaScript 
Use 
You can add new entries to the context menu either using the Web template property or with a JavaScript 
call.  

Functions 
JavaScript Function SAPBWAddToMenu 

Parameter Description 

label Labeling text in the menu 

func JavaScript function for processing the 
command 
You implement this function in JavaScript and 
use it to execute commands after you have 
selected the menu entry. 

parameter 
This parameter is passed to the JavaScript 
function ‘func’ and you can evaluate it there as 
required. The parameter allows you to use a 
function ‘func’ for more than one menu entry. 

cell_type 
‘ ’ = No restriction 

‘CHARACTERISTIC’ = Characteristic 

‘CHARACTERISTIC_VALUE’ = Characteristic 
value 

‘STRUCTURE’ = Structure 

‘STRUCTURE_MEMBER = Structural 
component 

‘DATA’ = Data cell 

‘EXCEPTIONS’ = Exceptions item 

‘CONDITIONS’ = Conditions item 

‘DOCUMENT_LIST’ = Document list item 

Context of the entry 
If you want the menu entry to appear only in 
certain contexts and not in all context menus, 
you can define this with ‘cell_type’ and ‘filter’. 

parameter Free 
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filter 
 

Context of the entry 
Different values are relevant here, depending 
on the value of ‘cell_type’: 

‘CHARACTERISTIC’, 
‘CHARACTERISTIC_VALUE’, ‘STRUCTURE’, 
‘STRUCTURE_VALUE’: Iobjnm 

‘EXCEPTIONS’: Exception ID 

‘CONDITIONS’: Condition ID 

‘DOCUMENT_LIST’: Document ID 

‘ ’= Not displayed 

‘X’= Displayed in the “basic menu” 

‘E’= Displayed in the “enhanced menu” 

Visibility of the entry 
Here you define if the entry is to appear in the 
basic menu or in the enhanced menu. 

position 
‘TOP’ = Before the “normal” entries 

‘BOTTOM’ = After the “normal” entries 

Position of the entry 
The entries are inserted in the order in which 
they were called. You can choose if the entry is 
to appear before the “normal” entries or after 
them in the menu. You cannot position the 
entries in between the “normal” entries. 

Data_provider Name of the data provider 
Name of the data provider (if the entry is to be 
made only for a specific data provider). 

Item Name of the Web item 
Name of the Web item (if the entry is to be 
made only for a specific Web item). 

See Examples. 

visibility 

Example 
See the examples under Command Processing [Seite 329] 
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 Command Processing 
Use 
When you enhance the context menu with customer-specific entries (with Web template properties or 
JavaScript function 'SAPBWAddToMenu'), you must define a JavaScript function that is executed when a 
customer-specific entry is selected. This function is responsible for processing the command. 

Functions 
The function must support the following interface: 

JavaScript Function JavaScript function for processing the 
command 

Parameter Description 

parameter Free parameter 
The parameter makes it possible to process 
more than one menu entry with one function. 
See Examples. 

cell_type 
' ' = No special 

‘CHARACTERISTIC’ = Characteristic 

‘CHARACTERISTIC_VALUE’ = Characteristic 
value 

‘STRUCTURE’ = Structure 

‘STRUCTURE_VALUE’ = Structure component 
value 

‘DATA’ = Data cell 

'EXCEPTIONS' = Web Item List of Exceptions 

'CONDITIONS' = Web Item List of Conditions 

'DOCUMENT_LIST' = Web Item List of 
Documents 

Context of cell 

Filters Context of cell 
Different values makes sense here, depending 
on the value of ‘cell_type’: 

‘CHARACTERISTIC’, 
‘CHARACTERISTIC_VALUE’, ‘STRUCTURE’, 
‘STRUCTURE_VALUE’: Iobjnm 

‘EXCEPTIONS’: Exception ID 

‘CONDITIONS’: Condition ID 

‘DOCUMENT_LIST’: Document ID 

See Examples. 
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parameter1 Exact definition of the context of the cell 
cell_type = 'CHARACTERISTIC_VALUE': Key 
of characteristic value 

cell_type = 'STRUCTURE_VALUE': 
STRUCTURE_MEMBER_ID_1 

parameter2 Exact definition of the context of the cell 
cell_type = 'CHARACTERISTIC_VALUE': Node 
type for a hierarchy node 

cell_type = 'STRUCTURE_VALUE': 
STRUCTURE_MEMBER_ID_2 

item Name of the Web item on which the menu is 
called 

dataprovider Name of the Data Provider on which the 
menu is called 

x Cell is on data column x 
This parameter is needed especially for the 
report/report interface. 

Y Cell is on data row y 
This parameter is needed especially for the 
report/report interface. 

You can use all the JavaScript functions that were listed for processing. 

Example 
<SCRIPT language="JavaScript"> 
<!--  

// menu entry at start and only for customer cells, only for data provider DP1 

SAPBWAddToMenu("Customer 
details","myMenuProcessor","1","CHARACTERISTIC_VALUE","0CUSTOMER","X","TOP","DP1",""); 

// Menu entry at the end to the IT Home Page 

// Menu entry at the end to the IT Home Page 

// Menu entry at the beginning and only on material groups 

SAPBWAddToMenu("Materials","myMenuProcessor","3","CHARACTERISTIC_VALUE","0MATERIAL","X"
,"TOP","","",""); 

// Command Processing 

function myMenuProcessor(parameter,cell_type,filter,parameter1,parameter2,item,dataprovider,x,y){ 
  switch (parameter){ 
    case "1": 

//    Report-report-interface jump to customer details Web application in a new window 

      SAPBWOpenWindow(SAP_BW_URL_Get() + "&CMD=RRI&DATA_ROW=" + y + 
"&DATA_COLUMN="  
      + y + "&IOBJNM=0CUSTOMER&RRI_RECEIVER=ABC","CustDetails",600,400); 
      break; 
    case "2": 
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//  Call IT help page 

      SAPBWOpenWindow("http://…/it/olap/help.htm","Help",600,400); 
      break; 
    case "3": 

//  Filter material group and expand by material 

      SAPBWOpenUrl(SAP_BW_URL_Get() + "&CMD=EXPAND&" + 
      "DATA_PROVIDER=" + escape(dataprovider) +  
      "&IOBJNM=0MATERIAL&IOBJNM_PARENT=0MATGROUP&FILTER_IOBJNM=0MATGROUP" + 
      "&FILTER_VALUE=" + escape(parameter1) + "&FILTER_NODE_IOBJNM=" + escape(parameter2)); 
      break; 
  } 
} 
---> 
</SCRIPT> 
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 Properties of Page Objects 
Use 
This section lists the JavaScript functions for the properties of Web items and query views:  

You can access the current attribute value of a Web item. See Web Item Attributes [Seite 333] • 

• You can determine which characteristics a data provider has. See Information on the Navigation 
Status [Seite 367] 
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 Web Item Attributes 
Use 
You can access the current attribute values of a Web item using this JavaScript function. For example, 
you can specify whether a Web item is visible. This will help you to create a Web application in which you 
can switch between two views, for example between a chart and a table, using a link. 

Features 
JavaScript Function SAPBWGetItemProp 

Parameter Description 

Name Logical name of the Web item 

Return value Array with Web item properties 
The information is stored as follows: 

new Array(itemName, new 
Array(attributeName1,attributeValue1), new 
Array(attributeName2,attributeValue2), ...) 

 
Specifying whether a Web item is visible: 

<SCRIPT language="JavaScript"> 

<!--  

var prop = SAPBWGetItemProp("myItem"); 

var hidden = true; 

if (prop != null){ 

  for(i=1;i<prop.length;i++){ 

    if (prop[i][0] == "HIDDEN")  hidden = (prop[i][1] == "X"); 

  } 

} 

---> 

</SCRIPT> 
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 Characteristics of a Saved Query View 
Use 
You can use this JavaScript function to determine which characteristics belong to a data provider. By 
doing this you can then, for example, fill a dropdown box for changing drilldowns with the relevant 
characteristics and do not have to create a dropdown box manually for each query view.  

Moreover, this function is language-independent which means the selections are adjusted automatically 
for each language. The texts are shown according to the logon language. 

Functions 
JavaScript Function SAPBWGetDataProviderDimensions 

Parameter Description 

Name Logical name of the saved query view 

Return value Array of characteristics and structures of 
the data provider 
The individual characteristics and structures 
are stored as arrays, as in the example: 

new Array(dimArray1, dimArray2, ...) 

The individual characteristics and structures 
have the following structure: 

new Array(iobjnm,is_structure ( 
,X),hierarchyAssigned( ,X), activeHierarchy( 
,X), axis (X,Y, ), filtered ( ,1 (single value), 
X(multiple filter values)), caption, unsupported 
properties) 

There are other properties in addition to those 
listed, but these have not yet been officially 
released. 

 
Listing characteristics and structures: 

<SCRIPT language="JavaScript"> 

<!--  

var dim = SAPBWGetDataProviderDimensions("myDataProvider"); 

var text = ""; 

if (dim != null){ 

  for(i=0;i<dim.length;i++){ 

    text = text + dim[i][6] + ", "; 

  } 

  alert(text); 

} 

Web Application Design: BEx Web Application Designer 30B
 334 



SAP Online Help  13.05.2002 

---> 

</SCRIPT> 
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 Calendar for Date Filter 
Use 
You can use this JavaScript function to call up a calendar. When you select a value, the system filters the 
data characteristic for the specified DataProvider.  

Funktionsumfang 
JavaScript Function SAPBWSetFilterByCalendar 

Parameter Description 

dataProvider Logical name of the DataProvider 
When the filter operation is only to be applied 
to a DataProvider, specify its logical name 
here. 

dataProviderArray Logical name of DataProvider 
When the filter operation is to be applied to 
several DataProviders, specify their logical 
names here, for example, new Array 
(“DP1“,“DP2“,“DP3“) 

iobjnm Date characteristic 
The system is to filter according to this 
characteristic. 

displayDate (optional) Start date 
Date the calendar displays when it appears. 
This parameter is optional. The date format 
has 4 characters for the year, 2 for the 
month and 2 characters for the day: 
YYYYMMDD 

 
Filter DP1 according to 0CALDAY 
<a href=”Javascript:SAPBWSetFilterByCalendar(‘DP1’,null,’0CALDAY’,’20020213’);”>Filter 
Calday</a> 
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 Logon Language 
Use 
With this function you can define the logon language and thereby take the different input formats of the 
various languages into consideration in JavaScript. 

Functions 
JavaScript Function SAP_BW_Get_Language 

Return value Logon Language 
e.g. EN for English and DE for German. 
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 Web Design API for Tables 
Purpose 
The Web Design Application Programming Interface (Web Design API) is aimed at Web designers and 
ABAP programmers that want to create Web applications for highly individual scenarios, such as BI 
cockpits, based on BEx Web application design and want to change the display of tables or navigation 
blocks to meet their own requirements. 

The Web Design API enables you to modify individual cell data (characteristic values, column headers, 
value cells, and so on) with relation to content, display and navigation options. 

Process 
1. Using the Class Builder (transaction SE24) or the Object Navigator (transaction SE80), create a class 

with a class name in the customer name space. 

2. Give the class the same properties as class CL_RSR_WWW_MODIFY_TABLE. 

3. Implement only the methods that fill cell contents that you want to change. For further information 
about the different methods, see Table Interfaces [Seite 339]. 

4. Create the your Web template from the table provided by SAP. 

5. Extend the object tag of the table and/or the navigation block in the Web template with the parameter 
<param name='MODIFY_CLASS' value='YourClassName'>. 

6. Check in the modified Web template. 

Result 
The next time you call up the Web template, your class for adjusting the table contents is called up. 

 
We recommend that you test this in transaction RSRT2. Select the HTML checkbox and enter 
the contents of the start URL from CMD=LDOC as the URL. 

You can now test the HTML generation in the Debugger. Simply set suitable breakpoints and 
restart the transaction. 
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 Table Interface 
Definition 
This enables you to display tables or navigation blocks in BEx Web applications as you choose. 

Use 
The range of options reaches from simply changing the display to enhancing the navigation options and 
display specifically for data. 

You use ABAP-OO to execute the technical implementation.  

• You create an ABAP-OO class. 

• This class must succeed from the class CL_RSR_WWW_MODIFY_TABLE. 

• The class name of the appropriate class is specified in the object tag of the Web item Table or the 
Web item Generic Navigation Block in the Web template in the following form: 

<object> 
… 
<param name="MODIFY_CLASS" value="YourClassName"> 
… 
</object> 

Structure 
In the following, different methods are executed with which you can modify cell contents. All methods 
receive the contents which are suggested as standard in BEx Web Applications as “CHANGING” 
parameters.  These can be redefined in the implementation of the table interface methods. If individual cell 
types remain unchanged, leave the implementation empty. 

The table interface has the following functions: 

Attributes [Seite 340] • 

Events [Seite 350] • 

Methods for Manipulating Cell Contents [Seite 351] • 

• Service Methods [Seite 365] 
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 Attributes 
Definition 
Functional components of the table interface. 

Structure 
The following instance attributes of the class are filled automatically. They get their values from the Web 
application framework. 

 
The attributes are read-only. 

Attribute Description 

N_ITEM_NAME Logical name of the table 
This attribute is needed for command URLs. 
You can use this attribute, for example, to 
change attributes in the table. 

N_GENERATE_LINKS Generate navigation links 
If the value = “X”, URLs can be generated. 

If the value is blank, the item is for display only. 
It is not possible to interact with the item. 

N_ALT_STYLES Display zebra list 
If the value = “X”, the formatting is the same in 
every other row. 

Calling the Web application without 
interaction 
If the value = “X”, the Web application is called 
and the session is dismantled on the 
application server. SAP BW 2.0 supports no 
further interaction. 

N_STATELESS 
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N_R_CREATION_PARAMETERS Creation parameters for the table 
Using the reference for an instance of the class 
CL_RSR_PARAMETER, the system is able to 
read the value-name pairs that have been used 
in the generation of the table. Methods such as 
GET are used to read the values.  

The parameters of the start URL and the 
name-value pairs specified in the object tag of 
the item in the Web template belong to these 
name-value pairs. 

This means that the start URL or object tag (in 
the Web template) can transfer parameters to 
the class. This increases the number of times a 
class can be reused and the different areas 
where the class can be used, for example, by 
using customer-specific parameters that 
configure the class individually. 

N_JAVASCRIPT Using Java Script 
If the value = “X”, Java Script functions are 
supported. Otherwise, you must not use Java 
Script functions, since you cannot be sure that 
the requesting Web browser supports Java 
Script. 

N_DATA_PROVIDER_NAME Logical name of the data provider 
Needed in the generation of navigation URLs. 

N_NO_DATA No relevant data found 

N_NO_AUTHORIZATION No authorization for displaying data 

N_R_DATA_SET Data in the data provider 

 
This attribute is needed only for 
special applications. 

As a rule, the information that is 
transferred by the method 
interfaces is enough to determine 
the cell contents. 

For more information see Datasets [Seite 342]. 
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 Datasets 
Definition 
The dataset contains the data for the query view. 

Use 
Special applications require information that cannot be obtained using the method interfaces. For some 
applications you need more information than is contained in the cell contents. For example, you need the 
list of available characteristics or the contents of the dynamic filter before you are able to jump from one 
report into another. 

 
An understanding of the enhancement described below is not necessary for the use of the 
table interface. 

You have made sure that the data from the dataset (N_R_DATA_SET) is always up to date. The 
N_SX_VERSION_20A_1 attribute, type RSRDS_SX_DATA_SET_20A_1, is filled automatically. The data 
consists of both the metadata (a catalog of characteristics (AXIS_INFO) and so on) and the displayed 
values (AXIS_DATA and CELL_DATA). 

Structure 
The instance attribute N_R_DATA_SET → N_SX_VERSION_20A_1 has the following components: 

Component Description 

AXIS_INFO [Seite 343] Metadata description of the characteristics, 
attributes, and structures on the axes. 

AXIS_DATA [Seite 345] Characteristic values, attribute values, and 
structural components according to the 
sequence they appear in on the axes. 

CELL_DATA [Seite 347] Value cells: The cells are arranged by row first, 
and then by column. 

TXT_SYMBOLS [Seite 349] Text elements for the query 
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 AXIS_INFO 
Definition 
This component describes the properties of the structures, characteristics, and attributes, and how they 
are distributed between the axes. 

Structure 
The AXIS_INFO is a table of axes (rows, columns, and filters) with the appropriate axes components. 

AXIS_INFO Description 

AXIS Axis ID 

0 : Columns 

1 : Rows 

255 : Filters 

NCHARS Value cells 

The cells are arranged by row first, and then by 
column. 

NCOORDS Number of objects on the axis (number of 
rows / columns / filter values) 

CHARS Characteristics with their attributes and 
structures on the axis. 

The complex table CHARS has the following structure: 

CHARS Description 

CHANM Name of the characteristic or of the structure 

HIENM Hierarchy name, if the hierarchy is active 

VERSION Hierarchy version 

DATETO Key date for the hierarchy 

CAPTION Name of the characteristic or of the 
structure 

CHAPRSNT Characteristic display 

0 : key and  text 

1 : Text 

2 : Key 

3 : Text and key 

4 : Long text 

5 : Medium text 

6 : No display 

ATTRINM Attributes for this characteristic 

ATTRINM is a table of the attributes for the characteristic. It has the following structure: 
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ATTRINM Description 

ATTRINM Name of the attribute 

CAPTION Name of the attribute 

CHAPRSNT Attribute display 

0 : key and  text 

1 : Text 

2 : Key 

3 : Text and key 

4 : Long text 

5 : Medium text 
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 AXIS_DATA 
Definition 
The component AXIS_DATA describes the contents of the axis.  

Structure 
AXIS_DATA is a table with the following structure: 

AXIS_DATA Description 

AXIS Axis ID 

0 : Columns 

1 : Rows 

255 : Filters 

SET Axis contents 

The complex table SET has the following structure: 

SET Description 

TUPLE_ORDINAL Number of the entry beginning with 0 on the 
axis 

CHANM Name of the characteristic or of the 
structure 

CAPTION Text for the characteristic value 

CHAVL Internal key value for the characteristic 
value 

This is needed, for example, for the filter 
operations. 

CHAVL_EXT External key value for the characteristic 
value 

This corresponds with CHAVL after the 
application of the conversion exit. 

NIOBJNM With hierarchy nodes, this is the name of the 
node characteristic (0HIERNODE for text 
nodes). 

TLEVEL Hierarchy level of the entry 

DRILLSTATE Extent to which the entry is expanded (for 
an active hierarchy). 
L : Hierarchy leaf 

- : Expanded node 

+ : Collapsed node 
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OPT Only with filters: 

EQ : Single value 

LT : Less than 

LE : Less than or equal to 

GT : Greater than 

GE : Greater than or equal to 

BL : From-value with intervals (two rows) 

BH : To-value with intervals 

SIGN I : Include 

E : Exclude 

ATTRIBUTES Attribute values 

ATTRIBUTES is a table with the following structure: 

ATTRIBUTES Description 

ATTRINM Name of the attribute 

CAPTION Text for an attribute value 

ATTRIVL Key for the attribute value 

This describes the contents of an axis. 
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 CELL_DATA 
Definition 
The CELL_DATA component describes the value cells. 

The number cells of the query view are given as the assigned table of rows for BAPI type BAPI6111CD. If 
you display the query view data as a table, the assignment of cells corresponds to that of the data block, 
in which the assignment is run first using the rows and then using the columns. 

The index of a specific value is therefore calculated as follows: 

Index = Column position + (row position – 1)* number of columns 

Structure 
The data structure is as follows: 

Component Description 

CELL_ORDINAL Numbering of the values begins with 0 

 
CELL_ORDINAL is always smaller 
by 1 than the index of the rows 

VALUE Value 

FORMATTED_VALUE Formatted value 

Unit and currency are used already in this field 

VALUE_TYPE 

 

Value type 
The value type accepts the following values: 

‘ ’ normal, valid value 

‘0’ division by 0 

‘1’ value cannot be determined 

‘3’ value constructed from different currencies 

‘5’ zero value 

‘9’ surplus 

‘D’ date 

‘T’ time 

‘A’ no authorization for this value 

CURRENCY Currency identifier 

UNIT Unit identifier 
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MWKZ Amount/value key figure 
The amount/value key figure accepts the 
following values: 

'W' value 

‘M’ amount 

‘P’ price 

‘Q’ ratio 

‘%’ percentage value 

‘C’ counter 

‘F’ real number 

‘D’ date 

‘T’ time 

NUM_SCALE Scaling factors 

0 for 1, 1 for 10, 2 for 100, 3 for 1000, ... 

NUM_PREC Precision of the number in decimal places 

CELL_STATUS Not used 

BACK_COLOR Not used 
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 TXT_SYMBOLS 
Definition 
The component TXT_SYMBOLS describes the text elements of the query. The text elements are available 
as a table made up of RRX_TXT_SYMBOLS rows.  

Structure 
The text elements have the following structure (only the most important components): 

Component Description 

SYM_TYPE Type of text element 
‘V’ for variable 

‘F’ for filter value 

‘C’ for general text element 

SYM_NAME Name of the object 
With variables this is the variable name, with 
filters it is the filter characteristic, and with 
general text elements it is the name of the 
element. 

A list of the names of the general text elements 
is stored under Text Elements [Seite 16 ]1 . 

SYM_FS Follow-on record number 

A text element can be distributed over several 
rows, for example, in intervals. This field gives 
you the row number of a component within a 
text element. If SYM_FS=0, the text element is 
a new text element. 

SYM_BEGIN_GROUP New group within a text element 

 
Groups are usually separated by 
semicolons (;) 

SYM_CAPTION Name of the text element 

SYM_VALUE Value of the component of the text element 
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 Events 
Definition 
Functional components of the table interface. 

Use 
Events allow you to initialize tables. 

Structure 
Initialization 
Initializing a table: You call this method is before processing. Using the reference from the dataset, you 
can analyze metadata for the navigational state as well as the data itself. All attributes of the class that 
were listed beforehand are filled at this point. 

Method Start 

New Rows 
You call the following method before starting a new row. You can execute a suitable initialization for the 
rows.  

Method New_Row 

Importing Parameter Description 

I_Y New row numbers 

Header Completed 
The following method is called after you have processed the table header. You can execute a suitable 
initialization for the rows.  

Method Header_Finished 

Importing Parameter Description 

I_Y New row numbers 

Completion 
This method gives you the option of carrying out further operations after you have finished the table. For 
example, setting Java Script functions using the method “Set_Javascript_Function” (see Service Methods 
[Seite 365]) or cleaning up the table. 

Method Finished 
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 Manipulating Cell Contents 
Definition 
Functional components of the table interface. 

Use 
You can use a set of methods to manipulate cell contents. 

 
Only implement the methods for the cell types that you want to manipulate. 
Standard contents will be used for all other cell types. 

 
Standard contents may change between releases/support packages. If you want to change 
the contents of a cell, we recommend that you overwrite the contents of, for example, 
C_CELL_CONTENT completely and do not process the field with REPLACE or a similar 
operation. 

Functions 
You can use the following methods to manipulate cell contents: 

Caption_Cell: Headers [Seite 353] • 

Scaling_Factor_Cell: Scaling Factors [Seite 354] • 

Characteristic_Cell: Characteristic Values [Seite 35 ]5  • 

Attribute_Cell: Attribute Values [Seite 357] • 

Structure_Cell: Structural Components [Seite 358] • 

Data_Cell: Data Cells [Seite 359] • 

Error_Cell: Error Cells [Seite 360] • 

NAV_BLOCK_LABEL: Label Area of Navigation Block [Seite 361] • 

• NAV_BLOCK_VALUE: Filter of Navigation Block [Seite 363] 

All methods have importing parameters that describe the context of the cell. 

All methods have the same changing parameters. These parameters provide the default values and can 
be changed in the method. As these parameters are method-independent, they are listed only once here. 

Changing Parameter Description 

C_CELL_ID Cell ID 
If you leave this parameter empty, the cell has 
no ID. The ID is used to process the cell 
contents with JavaScript.  
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C_CELL_CONTENT Cell Contents 
The cell contents themselves can be very 
simple (for example, a number) or very 
complex (for example, for hierarchy nodes: 
icons with expanded/collapsed URL and text). 

C_CELL_STYLE Style of Cell 
The style defines the color, font, font size, 
spacing, etc. of the cell. The styles are defined 
in the Cascading Style Sheet. The Cascading 
Style Sheet is assigned to the Web template. 

Extension of TD tag 
Here you can set the properties such as the 
width, height, alignment or color of the cell. 
This parameter is not normally set because 
many of the properties are already defined 
when the style is defined. 

C_CELL_TD_EXTEND 
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 Headers 
Definition 
You use the Caption_Cell method to adjust the contents of header cells. 

Structure 
Method Caption_Cell 

Importing Parameter Description 

X coordinate of the cell in the table 

I_Y Y coordinate of the cell in the table 

I_IS_EMPTY Cell is empty 
'X' = empty 

I_IOBJNM_ROW Characteristic in the rows 
In the rows axis, the characteristic, whose 
header you want to display in the cell. 

I_ATTRINM_ROW Attribute for characteristic in the rows 
In the rows axis, the attribute for the 
characteristic, whose header you want to 
display in the cell. 

I_TEXT_ROW Text for characteristic / attribute 

I_IOBJNM_COLUMN Characteristic in the columns 
In the columns axis, the characteristic, whose 
header you want to display in the cell. 

I_ATTRINM_COLUMN Attribute for characteristic in the columns 
In the columns axis, the attribute for the 
characteristic, whose header you want to 
display in the cell. 

I_TEXT_COLUMN Text for characteristic / attribute 

I_ROWSPAN Number of cells that you want to merge 
along the rows axis 

I_COLSPAN Number of cells that you want to merge 
along the columns axis 

I_IS_REPETITION Repetition 
'X' = cell contents is a repetition 

I_X 
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 Scaling Factors 
Definition 
You use the Scaling_Factor_Cell method to adjust the contents of cells that display the scaling factors. 

Structure 
Method Scaling_Factor_Cell 

Importing Parameter Description 

I_X X coordinate of the cell in the table 

I_Y Y coordinate of the cell in the table 

I_TEXT Scaling text 

I_IS_SUM Sum total cell 
‘X’ = sum total cell 

I_NUM_SCALE Scaling factor 

I_CURRENCY Currency 

I_UNIT Unit 
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 Characteristic Values 
Definition 
You use the Characteristic_Cell method to adjust the contents of cells containing values for 
characteristics. 

Structure 
Method Characteristic_Cell 

Importing Parameter Description 

I_X X coordinate of the cell in the table 

I_Y Y coordinate of the cell in the table 

I_IOBJNM Name of characteristic 

I_CHAVL_EXT Characteristic value in external display 
Key value of the characteristic value according 
to its application in the conversion exit. 

I_CHAVL 

 
Characteristic value in internal display 
Key value of the characteristic value. This is 
needed for the filter operations. 

I_NODE_IOBJNM  Name of the node characteristic 

With characteristic nodes and text nodes, you 
have to specify the characteristic name 
(0HIER_NODE). 

I_TEXT Text for characteristic value 

I_HRY_ACTIVE Status of the display hierarchy 
‘X’ = active 

I_DRILLSTATE Extent to which the node is expanded 
'E' = expanded, 'C' = collapsed 

I_DISPLAY_LEVEL Display hierarchy level of the node / leaf 

I_USE_TEXT Cell contents 
'X' = text, ' ' = key 

I_IS_SUM Sum total cell 
‘X’ = sum total cell 

I_IS_REPETITION Repetition 
'X' = cell contents is a repetition 

I_FIRST_CELL First data cell of the characteristic value 

I_AXIS Axis on which the characteristics are 
arranged in the drilldown 
'X' = columns, 'Y' = rows 
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I_LAST_CELL Last data cell of the characteristic value 

I_CELLSPAN Number of cells that you want to merge 
along the drilldown axis 

I_CELLSPAN_ORT Number of cells that you want to merge 
vertically along the drilldown axis 
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 Attribute Values 
Definition 
You use the Attribute_Cell method to adjust the contents of the cells containing attribute values. 

Structure 
Method Attribute_Cell 

Importing Parameter Description 

I_X X coordinate of the cell in the table 

I_Y Y coordinate of the cell in the table 

I_IS_EMPTY Cell is empty 
'X' = empty 

I_IOBJNM Name of characteristic 

I_ATTRINM Name of attribute 

I_AXIS Axis on which the characteristics are 
arranged in the drilldown 
'X' = columns, 'Y' = rows 

I_CHAVL_EXT Attribute value in external display 
Key value of the attribute value according to its 
application in the conversion exit. 

I_CHAVL 

 
Attribute value in internal display 
Key value of the attribute value. 

I_TEXT Text for attribute value 

I_USE_TEXT Cell contents 
'X' = text, ' ' = key 

I_IS_SUM Sum total cell 
‘X’ = sum total cell 

I_CELLSPAN Number of cells that you want to merge 
along the drilldown axis 

I_IS_REPETITION Repetition 
'X' = cell contents is a repetition 
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 Structural Components 
Definition 
You use the Structure_Cell method to adjust the contents of structural components. 

Structure 
Method Structure_Cell 

Importing Parameter Description 

I_X X coordinate of the cell in the table 

I_IOBJNM Name of the structure 

I_AXIS Axis on which the characteristics are 
arranged in the drilldown 
'X' = columns, 'Y' = rows 

I_STRUCTUR_MEMBER Name of the structural component 
Key value of the structural component. 

I_STRUCTUR_MEMBER_2 

Name of the structural component 

I_IS_SUM Sum total cell 
‘X’ = sum total cell 

I_IS_REPETITION Repetition 
'X' = cell contents is a repetition 

I_CELLSPAN Number of cells that you want to merge 
along the drilldown axis 

I_CELLSPAN_ORT 

I_Y Y coordinate of the cell in the table 

Name of the structural component of the 
other structure 
Key value of the structural component of a 
second structure (if a second structure is 
available). This is needed, for example, for sort 
operations. 

I_TEXT 

Number of cells that you want to merge 
vertically along the drilldown axis 
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 Data Cells 
Definition 
You use the Data_Cell method to adjust the contents of data cells. 

Structure 
Method Data_Cell 

Importing Parameter Description 

I_X X coordinate of the cell in the table 

I_VALUE Values of the cell without scaling 

I_DISPLAY_VALUE Values of the cell after scaling 

I_NUMERICAL_SCALE Scaling factors 

I_NUMERICAL_PRECISION Number of places after the decimal point 

I_CURRENCY Currency 

Unit according to the application of the three-
character conversion exit. 

I_ ALERTLEVEL 

I_Y Y coordinate of the cell in the table 

Three-character currency ID, for example, 
USD, ATS, or DEM. 

I_UNIT Unit 

Alert level 
1, 2, 3 = green; 4, 5, 6 = yellow; 7, 8, 9 = red 

I_IS_SUM Sum total cell 
‘X’ = sum total cell 

You can make many changes, for example, choose to display the alerts as icons, or change the way 
currencies and units are displayed (units as text, for example). 
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 Error Cells 
Definition 
You use the Error_Cell method to adjust the contents of error cells. 

Structure 
Method Error_Cell 

Importing Parameter Description 

I_X X coordinate of the cell in the table 

I_Y Y coordinate of the cell in the table 

I_TEXT Error text 

I_TYPE Error type (S, E, A, I, W) 
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 Labeling Area of the Navigation Block 
Definition 
You can adjust the contents of the labeling cells of the navigation block with method 
NAV_BLOCK_LABEL. 

Structure 
The area for labeling can be divided in up to 4 columns. 

Method NAV_BLOCK_LABEL 

Importing Parameter Description 

I_IOBJNM Technical name of the characteristic or 
structure 

I_IS_STRUCTURE Object is a structure 
‘X’ = Yes, ‘  ’ = No 

I_AXIS Axis on which the characteristics / structure 
are arranged in the drilldown 
'X' = columns, 'Y' = rows 

I_CAPTION Label text 

I_HRY_ACTIVE Status of the display hierarchy 
'X' = Active 

Changing Parameter Description 

C_CELL1_ID ID of cell 1 
If you leave this parameter empty, the cell has 
no ID. The ID can be used to process the cell 
contents with JavaScript.  

C_CELL2_ID ID of cell 2 

C_CELL3_ID ID of cell 3 

C_CELL4_ID ID of cell 4 

C_CELL1_CONTENT Cell contents 1 
The cell contents themselves can be very 
simple (for example only a number) or very 
complex (for example for hierarchy nodes: 
icons with expanded/collapsed URL and text). 

C_CELL2_CONTENT Cell contents 2 

C_CELL3_CONTENT Cell contents 3 

C_CELL4_CONTENT Cell contents 4 
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C_CELL1_STYLE Style of cell 1 
The style defines the color, font, font size, 
distances, etc. of the cell. The styles are 
defined in the Cascading Style Sheet. The 
Cascading Style Sheet is assigned to the 
template. 

C_CELL2_STYLE Style of cell 2 

C_CELL3_STYLE Style of cell 3 

C_CELL4_STYLE Style of cell 4 

C_CELL1_TD_EXTEND Extension of TD tag 1 
Here you can set the properties such as the 
width, height, alignment or color of the cell. 
This parameter is not normally set because 
many of the properties are already defined 
when the style is defined. 

Extension of TD tag 2 

C_CELL3_TD_EXTEND Extension of TD tag 3 

C_CELL4_TD_EXTEND Extension of TD tag 4 

C_CELL1_WIDTH Width of column 1 

C_CELL2_WIDTH Width of column 2 

C_CELL3_WIDTH Width of column 3 

C_CELL4_WIDTH Width of column 4 

C_CELL2_TD_EXTEND 
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 Filter Area of the Navigation Block 
Definition 
You can adjust the contents of the filter cells of the navigation block with method NAV_BLOCK_VALUE. 

Structure 
The area for the filter can be divided in up to 4 columns. 

Method NAV_BLOCK_VALUE 

Importing Parameter Description 

I_IOBJNM Technical name of the characteristic or 
structure 

I_IS_STRUCTURE Object is a structure 
‘X’ = Yes, ‘  ’ = No 

I_AXIS Axis on which the characteristics / structure 
are arranged in the drilldown 
'X' = columns, 'Y' = rows 

I_CAPTION Label text 

I_HRY_ACTIVE Status of the display hierarchy 
'X' = Active 

Changing Parameter Description 

C_CELL1_ID ID of cell 1 
If you leave this parameter empty, the cell has 
no ID. The ID can be used to process the cell 
contents with JavaScript.  

C_CELL2_ID ID of cell 2 

C_CELL3_ID ID of cell 3 

C_CELL4_ID ID of cell 4 

C_CELL1_CONTENT Cell contents 1 
The cell contents themselves can be very 
simple (for example only a number) or very 
complex (for example for hierarchy nodes: 
icons with expanded/collapsed URL and text). 

C_CELL2_CONTENT Cell contents 2 

C_CELL3_CONTENT Cell contents 3 

C_CELL4_CONTENT Cell contents 4 
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C_CELL1_STYLE Style of cell 1 
The style defines the color, font, font size, 
distances, etc. of the cell. The styles are 
defined in the Cascading Style Sheet. The 
Cascading Style Sheet is assigned to the 
template. 

C_CELL2_STYLE Style of cell 2 

C_CELL3_STYLE Style of cell 3 

C_CELL4_STYLE Style of cell 4 

C_CELL1_TD_EXTEND Extension of TD tag 1 
Here you can set the properties such as the 
width, height, alignment or color of the cell. 
This parameter is not normally set because 
many of the properties are already defined 
when the style is defined. 

C_CELL2_TD_EXTEND Extension of TD tag 2 

C_CELL3_TD_EXTEND Extension of TD tag 3 

C_CELL4_TD_EXTEND Extension of TD tag 4 

C_CELL1_WIDTH Width of column 1 

C_CELL2_WIDTH Width of column 2 

C_CELL3_WIDTH Width of column 3 

C_CELL4_WIDTH Width of column 4 
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 Service Methods 
Definition 
Functional components of the table interface. 

Use 
Service methods are offered along with methods for manipulating cell contents [Seite 351]. You need 
these when creating new cell contents. 

Functions 
You can use the following service methods: 

Creating Navigation URLs [Seite 366] 

Information on the Navigation Status [Seite 367] 

Information on a Specific Cell [Seite 368] 

Icons [Seite 370] 

Sending Messages [Seite 371] 

JavaScript Functions [Seite 372] 

 

Web Application Design: BEx Web Application Designer 30B
 365 



SAP Online Help  13.05.2002 

 Creating Navigation URLs 
Use 
You generate command URLs using the following method. This ensures that the request is sent to the 
correct page instance of the current session. 

Functions 
Method GET_URL 

Importing parameter Description 

I_R_PARAMETER Command parameter 
The command parameter is transferred using 
instances of the class CL_RSR_PARAMETER. 
Use the methods in this class, for example, 
ADD, to fill the parameter. 

Returning parameter Description 

R_URL Command URL 

In addition, you can use the following service methods: 

Icons [Seite 370] 

Information on the Navigation Status [Seite 367] 

Information on a Specific Cell [Seite 368] 

Sending Messages [Seite 371] 

JavaScript Functions [Seite 372] 

 

 

Web Application Design: BEx Web Application Designer 30B
 366 



SAP Online Help  13.05.2002 

 Information on the Navigation Status 
Use 
This method returns information on the current navigation status. You can call it up at any time. 

Functions 
Method GET_STATE_INFOS 

Exporting parameter Description 

E_THX_AXIS_INFO Distribution of the structures, 
characteristics and attributes on the axes 
and their properties 
For details about structures, see Data Sets 
[Seite 342] and AXIS_INFO [Seite 343]  

E_T_SLICER Dynamic filter 
Filter that you can change in navigation and, 
for example, see in the navigation block. 

For details about tables, see Data Sets [Seite 
342] and AXIS_DATA [Seite 345]   

 
Unlike in the set, the ATTRIBUTES 
component is not offered. 

E_T_TXT_SYMBOLS Query text element 
The text element contains general information  
(for example, the query key date) about the 
variable values and information for fixing query 
filters. 

For details about tables, see Data Sets [Seite 
342] and TXT_SYMBOLS [Seite 349]   

In addition, you can use the following service methods: 

Creating Navigation URLs [Seite 366] 

Information on a Specific Cell [Seite 368] 

Icons [Seite 370] 

Sending Messages [Seite 371] 

JavaScript Functions [Seite 372] 
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 Information on a Specific Cell 
Use 
This method returns details for cells at a specific cell coordinate.  

Prerequisites 

 
You cannot call up this method in the START method. 

Functions 
Method GET_CELL_INFO 

Importing parameter Description 

I_ROW Row coordinate of cell in table 

I_COLUMN Column coordinate of cell in table 

Exporting parameter Description 

E_AXIS Axis of the cell 
0 = on the columns, 1 = on the rows, -1 
otherwise 

E_DATA_ROW Data row 
Row coordinate in data area This information is 
important, for example, when jumping from one 
report to another. 

E_DATA_COLUMN Data column 
Column coordinate in data area This 
information is important, for example, when 
jumping from one report to another. 

E_CELL_TYPE Type of cell 
0 = Empty cell 

1 = Data cell 

2 = Structure component 

3 = Characteristic value 
4 = Characteristic header 
5 = Display-attribute value 

6 = Display-attribute header 

7 = Scaling factor 

E_IOBJNM Characteristic/structure name 
This parameter is filled only for cells of type 2, 
3, 4, 5 and 6. 
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E_ATTRINM Display-attribute name 
This parameter is filled only for cells of type 5 
and 6. 

E_T_CELL_RESTRICTIONS 

 
Cell restrictions 
Restrictions arising from the position of the cell 
in the table. For example, there are restrictions 
on the display of data cells on the axes. 

For details about tables, see Data Sets [Seite 
342] and AXIS_DATA [Seite 345]  

 
Unlike in the set, the ATTRIBUTES 
component is not offered. 

E_S_CELL_DATA Information about data cells 
Information about data cells, for example, the 
value of the data cell, is available from here. 
For details about structures, see Data Sets 
[Seite 342] and CELL_DATA [Seite 347]  

In addition, you can use the following service methods: 

Creating Navigation URLs [Seite 366] 

Information on the Navigation Status [Seite 367] 

Icons [Seite 370] 

Sending Messages [Seite 371] 

JavaScript Functions [Seite 372] 
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 Icons 
Use 
You use IMG tags in HTML for icons. To fill the IMG tag attribute SRC, the path of the icon directory from 
the MIME Repository or on the ITS is required. The following method returns this path: 

Functions 
Method GET_ICON_PATH 

Returning parameter Description 

R_PATH Path for icon directory 
You use this path in the HTML IMG tag for 
SRC. You have to enter only the screen name. 

In addition, you can use the following service methods: 

Creating Navigation URLs [Seite 366] 

Information on the Navigation Status [Seite 367] 

Information on a Specific Cell [Seite 368] 

Sending Messages [Seite 371] 

JavaScript Functions [Seite 372] 
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 Sending Messages 
Use 
You use the following method to send messages. These appear at the start of the HTML page in a table. 
You use this function primarily to notify users of errors. 

Functions 
Method SEND_MESSAGE 

Importing parameter Description 

I_CLASS Message class 

I_TYPE Message type (I, W, E, A, X) 

I_NUMBER Message number 

I_MSGV1 Message variable value 1 

I_MSGV2 Message variable value 2 

I_MSGV3 Message variable value 3 

I_MSGV4 Message variable value 4 

In addition, you can use the following service methods: 

Creating Navigation URLs [Seite 366] 

Information on the Navigation Status [Seite 367] 

Information on a Specific Cell [Seite 36 ]8  

Icons [Seite 370] 

JavaScript Functions [Seite 372] 
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 JavaScript Functions 
Use 
The following method enables you to manage JavaScript source code centrally. The source code is set at 
the start of the HTML page. You can use this function to construct your own JavaScript source code and, 
for example, call up manipulated cells from there. 

Functions 
Method SET_JAVASCRIPT_FUNCTION 

Importing parameter Description 

I_NAME Name of the section of source code 
This name is unique. Any source code already 
stored that has the same name is overwritten. 

I_CODING JavaScript source code 

In addition, you can use the following service methods: 

Creating Navigation URLs [Seite 366] 

Information on the Navigation Status [Seite 367] 

Information on a Specific Cell [Seite 36 ]8  

Icons [Seite 370] 

Sending Messages [Seite 371] 

 

 


